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Introduction1

Welcome to your printer
Your printer is a color inkjet printer designed for printing high-quality images on paper up to 1625.6 mm (64 in) 
wide.

Some major features of the printer are shown below:

● Print resolution of up to 2400 ˟ 1200 optimized dpi, using the Best print-quality option, the Maximum Detail 
option and photo paper

● The printer can be controlled from its front panel or from a remote computer using the Embedded Web 
Server, HP Support Assistant, or HP Click Printing Software. For information go to the HP website at the 
following link: http://www.hp.com/go/designjetclick.

● Touch-sensitive front panel in color, with an intuitive graphical user interface

● Job previews in the front panel

● Job previews on remote computers

● Includes Web-connected features such as automatic firmware updates

● True smart printing experience through HP PrintOS software support:

– Status overview with HP Configuration Center

– Easy designing tools for professional looking LF prints with HP Application Center

● Paper flexibility and automatic easy load, see Paper handling on page 23, with information and presets 
accessible from the front panel and Embedded Web Server

● Roll paper

● Six-ink system (Z6 Pro) or nine-ink system (Z9 + Pro). The Z9+ Pro has the ink accessory available: Gloss 
Enhancer (GE) ink, which can support up to 10 inks.

● Smooth transitions and sharp details thanks to the High Definition Nozzle Architecture (HDNA) user-
replaceable printheads with Dual Drop technology

● Accurate and consistent color reproduction with automatic color calibration

● Spectrophotometer for Z9 + Pro, or Densitometer for Z6 Pro

● Economode for printing economically

● Optional HP DesignJet Multifunction Roll provides fast and easy switching between two rolls, or long runs of 
unattended printing when configured to the take-up reel

● Maximize unattended printing and be more productive with the optional HP DesignJet take-up reel

● High productivity features such as job previewing and nesting using HP Click Printing Software

● HP Pixel Control
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● Ink and paper usage information available from the Embedded Web Server, see Embedded Web Server on 
page 12

● Access to the online HP Support Center (see Contact HP Support on page 208)

Safety precautions
It is important you read the safety precautions before using your printer. Also read your local Environmental, 
Health, and Safety regulations.

This equipment is not suitable for use in locations where children are likely to be present.

For any maintenance or part replacement, follow the instructions provided in HP documentation to minimize 
safety risks and to avoid damaging the printer.

General safety guidelines
There are no operator-serviceable parts inside the printer except those covered by HP’s Customer Self Repair 
program.

For information go to the HP website at the following link: http://www.hp.com/go/selfrepair. Refer servicing of 
other parts to qualified service personnel.

Turn off the printer and call your service representative in any of the following cases:

● The power cord or plug is damaged.

● The printer has been damaged by an impact.

● There is any mechanical or enclosure damage.

● Liquid has entered the printer.

● There is smoke or an unusual smell coming from the printer.

● The printer has been dropped.

● The printer is not operating normally.

Turn off the printer and unplug the power cord in either of the following cases:

● During a thunderstorm

● During a power failure

Take special care with zones marked with warning labels.

Ventilation measures for your location, whether office, copy room, or printer room, should meet local 
environmental health and safety (EHS) guidelines and regulations.

Electrical shock hazard
The printer requires a building installation circuit breaker, which must meet the requirements of the printer and 
should be in accordance with the Electrical Code requirements of the local jurisdiction of the country in which the 
equipment is installed.

WARNING! The internal circuits of the built-in power supplies and power inlet operate at hazardous voltages 
capable of causing death or serious personal injury.
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IMPORTANT: Unplug the printer’s power cord before servicing the printer.

To avoid the risk of electric shock:

● The printer should be connected to earthed mains outlets only.

● Avoid overloading the printer's electrical outlet with multiple devices.

● Do not remove or open any closed system covers or plugs.

● Do not insert objects through slots in the printer.

● Take care not to trip over the cables when walking behind the printer.

● Insert the power cord securely and completely into the wall socket and printer inlet.

● Never handle the power cord with wet hands.

Fire hazard
The customer is responsible for meeting the printer’s requirements and the Electrical Code requirements 
according to the local jurisdiction of the country where the printer is installed.

To avoid the risk of fire, take the following precautions:

● Use the power supply voltage specified on the nameplate.

● Use only the power cord supplied by HP with the printer. Do not use a damaged power cord. Do not use the 
power cord with other products.

● Do not insert objects through slots in the printer.

● Take care not to spill liquid on the printer. After cleaning, make sure all components are dry before using the 
printer again.

● Do not use aerosol products that contain flammable gases inside or around the printer. Do not operate the 
printer in an explosive atmosphere.

● Do not block or cover the openings of the printer.

Mechanical hazard
The printer has moving parts that could cause injury. To avoid personal injury, follow all the recommended 
precautions when working close to the printer.

● Keep your clothing and all parts of your body away from moving parts.

● Avoid wearing necklaces, bracelets, and other hanging objects.

● If your hair is long, try to secure it so that it will not fall into the printer.

● Take care that sleeves or gloves do not get caught in moving parts.

● Do not operate the printer with covers bypassed.

● If you need to replace the cutter assembly, take care not to cut yourself on the sharp cutting edge.

● Internal fan blades are hazardous moving parts. Disconnect the printer before servicing.

● Never insert your hands into the printer while it is printing, due to the moving parts inside.
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● Beware that a paper roll does not drop onto your feet or trap your hand and fingers during the media roll 
load/unload process. It is recommended to wear safety shoes.

Heavy paper hazard
Special care must be taken to avoid personal injury when handling heavy papers.

● Handling heavy paper rolls may require more than one person. Care must be taken to avoid back strain 
and/or injury.

● When handling heavy paper rolls, wear personal protective equipment, including boots and gloves.

● Follow your local Environmental Health and Safety regulations for handling heavy paper rolls.

Ink handling
HP recommends that you wear gloves when handling ink supplies.

Warnings and cautions
Symbols are used in the user guide to ensure the proper use of the printer and to prevent the printer from being 
damaged. Follow the instructions marked with these symbols.

WARNING! Failure to follow the guidelines marked with this symbol could result in serious personal injury or 
death.

CAUTION: Failure to follow the guidelines marked with this symbol could result in minor personal injury or 
damage to the printer.

Warning labels
Safety labels are included on your printer. The final label position and its size on the printer may vary slightly, but 
labels should always be visible and close to the potential risk area.

Table 1-1 Warning labels

Label Explanation

Electric shock hazard. Hazardous voltages inside the electrical box. 
Disconnect the power cord before servicing. Before starting, read 
and follow the operating and safety instructions.

Moving part. Keep your fingers and hands away from the moving 
paper system and moving paper path areas. Do not put your hands 
or fingers into the print area.

Moving fan blade. While servicing, keep your fingers and hands 
away from the blades.
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Table 1-1 Warning labels (continued)

Label Explanation

Fingers and hands crush risk.

Handle roll paper with care. Be careful when managing the printer 
with the print area window open. There is a risk that the window 
could drop on your fingers or hands. Be careful when you manually 
load/unload media rolls on load table, there is a risk they could drop 
on your hands.

Feet crush risk.

Be careful when you manually load/unload media rolls on load 
table, there is a risk they could drop on your feet.

Main components
Identify the parts on the front and rear of the printer.

Front view
You have access to the front panel and perform media and ink pocedures at the front of the printer.

1. Window

2. HDNA universal printheads

3. Front panel

4. HP Eco-Carton ink cartridge

5. Loading station

6. Basket

Rear view
The communication ports and power socket are all located in the same area at the rear of the printer.
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1. Power socket

2. Gigabit Ethernet port, to connect to a network

3. Communication port

4. Diagnostic LEDs, to be used by service engineers

Turn the printer on and off
The power key is located close to the front panel.

TIP: The printer can be left powered on without wasting energy. Leaving it on improves response time and 
overall system reliability. When the printer has not been used for a certain period of time (the default time is 
determined by Energy Star), it saves power by going into sleep mode. However, any interaction with the printer's 
front-panel display, or sending a new job to print, returns it to active mode, and it can resume printing 
immediately. To change the sleep mode time, see Change system options on page 9.

NOTE: In sleep mode, the printer performs maintenance service to the printheads from time to time. This 
avoids long preparation times after long idle periods. Therefore, it is strongly recommended to leave the printer 
powered on or in sleep mode to avoid wasting ink and time.

If you want to turn the printer on or off or reset the printer, the normal and recommended method is to use the 
power key beside the front panel.

However, if you plan to store the printer for a long period or the power key does not seem to work, you are 
recommended to unplug the power cord at the rear.

To turn it back on, plug in the power cord.

When the printer is powered back on, it takes about three minutes to initialize and check and prepare the 
printheads. Preparing the printheads takes about 75 seconds. However, if the printer has been off for six weeks 
or more, preparing the printheads could take up to 35 minutes.
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Front panel
The front panel is a touch-sensitive screen with a graphical user interface, located on the front right of the 
printer.

It gives you complete control of your printer: from the front panel, you can view information about the printer, 
change printer settings, monitor printer status, and perform tasks such as supplies replacement and calibrations. 
The front panel displays alerts (warning and error messages) when necessary.

It includes the following components:

1. The front panel itself: a 4.3 inch, full-color, touch-sensitive screen with a graphical user interface.

2. The power key, with which you can turn the printer on or off, or wake up from sleep mode.

The front panel has a large central area to display dynamic information and icons.

Left fixed icons

● Tap the Home  icon  to return to the home page.

● Tap the Help  icon  to view help about the current page.

● Tap the Go back  icon  to go back to the previous page. This does not discard any changes made to the 
current page.

Home pages

There are two top-level pages that you can move between by sliding your finger across the screen:

● The all-apps page displays a list of all apps available in your printer.

● If you swipe left to the widget page, you can see at a glance the status of ink and paper supplies.
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● At the top of the page there is a dashboard that displays alerts related to the main functions of the printer. 
Swipe down the dashboard to access the Status Center.

Dim mode
After some time with no activity (5 minutes by default), the printer goes to dim mode, which reduces the 
brightness of the front panel by 25%.

Any activity, such as the use of the front panel or the arrival of a print job, ends dim mode and restores normal 
brightness. After some time in dim mode (default delay time to sleep determined by Energy Star), the printer 
changes to sleep mode. The time periods can be changed from the front panel.

Sleep mode
Sleep mode puts the printer into a reduced power state after a period of inactivity, turning off some elements 
to save energy. Printer features can be enabled from this mode, and the printer maintains network connectivity, 
waking up only as necessary.

The printer can be woken from sleep mode any of the following ways:

● By pressing the power button

● By opening a door

● By sending a print job

The printer wakes up in several seconds, more quickly than if it is completely turned off. While in sleep mode, the 
power button blinks.

To change the time that elapses before sleep mode, see Change system options on page 9.

Printer Monitoring (with the Print Spooler) and Remote Printer Management with Web JetAdmin continue to be 
available during sleep mode. Some remote management tasks offer the option of remotely waking up the printer 
if needed to perform the task.
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Change the language of the front-panel display

If you can understand the current front-panel display language, tap the Settings  icon , then System > 
Language.

If you cannot understand the current front-panel display language, follow these steps:

● Switch on the printer, and wait until you see this image in the front panel:

● When 3 circles appear below the HP logo, tap 3 times anywhere on the front panel screen within 5 seconds. 
This image appears:

● Imagine that the screen is divided in 4:

First touch the right upper side (zone B), and then the upper left side (A).

The language selection menu now appears on the front-panel display. Tap your preferred language.

The available languages are English, Portuguese, Spanish, Catalan, French, Dutch, Italian, German, Polish, 
Russian, Simplified Chinese, Traditional Chinese, Korean, and Japanese.

Change system options
You can change various printer system options from the front panel.

Change the language of the front-panel display 9



Tap the Settings  icon , then System.

● Date and time options to view or set the printer's date and time.

You can also change the date and time options in the Settings pane of the Embedded Web Server.

● Speaker volume to change the volume of the printer's loudspeaker. Select Off, Low, or High.

● Front panel brightness to change the brightness of the front-panel display. The default brightness is 50.

● Power options > Printer sleep to change the length of time the printer waits before going into sleep mode 
(see Sleep mode on page 8). You can set the time from 5 to 60 minutes. Default delay time according Energy 
Star.

You can also change the printer sleep option in the Settings pane of the Embedded Web Server.

● Power options > Auto-off due to inactivity to turn off the printer automatically after 120 minutes of inactivity.

● Unit selection to change the units of measurement in the front-panel display. Select English or Metric. By 
default, units are set to Metric.

● Restore factory settings to restore the printer settings to their original values as set in the factory. This 
option restores all of the printer settings except the paper presets.

● Language

● Firmware update to configure the automatic firmware update.

HP Support Assistant
Maintain your HP devices with automated support, updates, and fixes. HP Support Assistant helps you maintain 
your PC and printer.

It has the following features:

● Firmware upgrade

● Drivers upgrade

● Ink status and alerts

● Diagnostics

● Receive notifications and alerts

● Find the best way to contact HP

● Virtual Agent content for quick answers

● Warranty status

NOTE: Available options may vary depending on selected language and country.

HP Support Assistant is included on new HP desktop and notebook PCs (except customized deals).

Android and iOS versions are also available.

Product information is available on the HP website at the following link: 
http://www.hp.com/go/hpsupportassistant.
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Introduction | HP Support Assistant. For a video go to the following link: 
https://www.youtube.com/watch?v=2ugDlqn8IOM&t=4s.

1. Run HP Support Assistant. Tap Add an HP device.

2. Tap Detect my device.

3. Select the printer you want to add.

4. The printer is added.
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NOTE: Even if you don’t add the printer this way, HP Support Assistant automatically detects and shows 
the network printers within a week of the of the HP Support Assistant’s first run. When that happens, Just 
tap Add to my Devices.

HP Print Preview
The HP Print Preview application enables you to see a basic preliminary preview of how your job will be printed. 
This application is available only under Windows.

You can install the HP Print Preview by downloading it from the HP website at the following link: 
http://www.hp.com/go/DesignJetZ6Pro64in/drivers or http://www.hp.com/go/DesignJetZ9Pro64in/drivers.

Embedded Web Server
To use the Embedded Web Server on any computer, open your Web browser and enter the printer's IP address in 
the browser's address bar.

The following browsers are known to be compatible with the Embedded Web Server:

● Apple Safari 12 and later

● Mozilla Firefox 77 and later

● Google Chrome 83 and later

● Microsoft Edge 82 and later
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You can find your printer's IP address in the printer’s front panel: tap the Connectivity  icon , and then Network. 
See Configure your printer on page 14.

NOTE: Your browser may display a security warning when you enter the IP address. If you have entered the 
correct address, it is safe to ignore the warning and continue to access the Embedded Web Server.

The Embedded Web Server window displays a menu used to access all the supported functionality. It supports 
the following languages: English, Portuguese, Spanish, Catalan, French, Dutch, Italian, German, Polish, Russian, 
Simplified Chinese, Traditional Chinese, Korean, Japanese. It uses the language that you specified in your Web 
browser options. If you specify a language that it cannot support, it is displayed in the language selected in the 
printer, or else in English.

To change the language, change your Web browser's language setting. To complete the change, close and reopen 
your Web browser.

Demo prints
There are a variety of demo prints to show you what to expect from each application type. They can be requested 
from the front panel.

Before requesting a demo print, check that the printer and the paper are ready for printing.

The loaded paper should be at least 420 mm (16.5 in) wide—otherwise the print may be clipped.

The front panel should be displaying the Ready message.

To print a demo print, tap the Settings  icon , then scroll down and tap Internal prints, then Demo prints, and 
select a print. The following prints are available:

Demo prints:

Z6 Pro:

● GIS orthophoto

GIS map

POP fashion

Retail poster

Z9 Pro:

● POP fashion

Color photo

B&W photo

Fine arts

GIS map

Design
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Configure your printer
The printer is able to configure configure itself automatically for most networks, in a similar way to any computer 
in the same network.

Connect the printer to your network
The first time you connect the printer to a network the process may take a few minutes. Once the printer 
has a working network configuration, you can check its network address from the front panel: tap the 
Connectivity  icon .

TIP: Consider making a note of the printer’s IP address, because you may need it during the setup process of 
connecting your Windows or macOS computer clients.

Modify network configuration

To modify the current network configuration, go to the front panel and tap the Connectivity  icon , then the 
small Settings  icon , then Network > Gigabit Ethernet. From here it is possible, though not normally necessary, 
to change the settings manually; this can also be done remotely using the Embedded Web Server.

Tap the Connectivity  icon , then the small Settings  icon , then Network > Gigabit Ethernet. From here it is 
possible, though not normally necessary, to change the settings manually; this can also be done remotely using 
the Embedded Web Server.

For full details of the available connectivity settings, see Networking on page 57.

If you accidentally misconfigure the printer’s network settings, you can restore the network settings to their 
factory values from the front panel: tap the Connectivity  icon , then the small Settings  icon , then Network 
> Restore factory settings. Then you must restart the printer. This automatically provides a working network 
configuration for most networks. The printer’s other settings remain unchanged.

Install your printer under Windows
The instructions only apply if you intend to print from software applications using a printer driver.

See Printing on page 72 for alternative ways of printing.

Before you begin, check your equipment:

● The printer should be set up and on.

● The Ethernet switch or router should be on and functioning correctly.
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● The printer and the computer should be connected to the network (see Connect the printer to your network 
on page 14).

Now you can proceed to install the printer software and connect to your printer.

1. Make a note of the printer’s host name and IP address from the front panel (see Connect the printer to your 
network on page 14).

2. Install the printer software from the HP website at the following link: 
http://www.hp.com/go/DesignJetZ6Pro64in/software (if you have a Z6 Pro) or 
http://www.hp.com/go/DesignJetZ9Pro64in/software (if you have a Z9+ Pro), following the software 
installation instructions.

The best driver is suggested based on the operating system and whether or not the PostScript accessory is 
installed. The PDF driver is recommended when the PostScript option is available, otherwise the PCL driver 
is default.

3. Once downloaded, open it, and follow on-screen steps.

If your computer fails to find any printers on the network, the Printer Not Found window is displayed, which helps 
you to try to find your printer. If you have a firewall in operation; you may have to disable it temporarily in order 
to find the printer. You also have the options of searching for the printer by its hostname, IP address or MAC 
address.

Uninstall the printer software under Windows
Use the front panel to uninstall the software, in the same way as you can uninstall any other software.

Install your printer under macOS
There are two options to connect your printer to a network under macOS.

● Bonjour

● TCP/IP (important: select HP Jetdirect-Socket)

NOTE: The printer does not support AppleTalk.

The following instructions apply if you intend to print from software applications using a printer driver. See 
Printing on page 72 for alternative ways of printing.

Before you begin, check your equipment:

● The printer should be set up and on.

● The Ethernet switch or router should be on and functioning correctly.

● The printer and the computer should be connected to the network (see Connect the printer to your network 
on page 14).

Now you can proceed to install the printer software and connect to your printer.

1. Go to the front panel and tap the Connectivity  icon , then Network, and note the IP address of your 
printer. If you intend to connect with Bonjour, click the network card and note the Bonjour name.

2. Install the printer software from the HP website at the following link: 
http://www.hp.com/go/DesignJetZ6Pro64in/software (if you have a Z6 Pro) or 
http://www.hp.com/go/DesignJetZ9Pro64in/software (if you have a Z9+ Pro).
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3. Select Windows or macOS software, and choose which specific software for your model.

NOTE: You can download HP Click with the other software.

4. Double-click the HP DesignJet Installer icon. You will be guided through the steps to install the HP software 
for your printer.

5. In the Setup Assistant, look for your printer's Bonjour name or IP address (which you noted in step 1) in the 
table.

● If you find the right name, scroll sideways if necessary to see the Connection column, and check that it 
shows Bonjour. Then highlight that line. Otherwise, continue searching further down the list.

● If you cannot find your printer's name, just click Continue and do the setup manually. Access System 
Preferences, and in Printers and Scanners select the + sign at the bottom of the table. Then go to the IP 
tab, enter your IP address, and select the protocol HP Jetdirect-Socket.

Click Continue.

6. Continue following the instructions on the screen.

Uninstall the printer software under macOS
During the installation, you have the option to install the HP Uninstaller application in your system. This should be 
available under HP in the system Applications folder.

IMPORTANT: The HP Uninstaller application will uninstall all HP Software installed in your system.

To delete the print queue only, select the Printers & Scanners dialog from the system preferences. Click the name 
of the printer and then click the – button.

Set up printer services
You can set up your printer to automatically update firmware and enable additional services.

You can set up the following services:

● Receive automatic firmware updates

● Participate in the Product Data Sharing Agreement

● Enable additional printer services

A network connection is required, so the printer will test its own connectivity. Remember to connect the network 
cable to the printer.

Each printer service can be enabled or disabled individually as explained below.

During initial printer setup, you are asked whether you want to enable additional printer services. That decision 
can be changed later by tapping the Connectivity  icon , then tap the small Settings  icon , then Services > 
Printer Data Sharing Agreement.

If you are part of the HP Partner Link Pay-per-use service, you will have to participate in the Printer Data Sharing 
Agreement, if you have not done so already. Then tap the Connectivity  icon , then Services , then the 
Ellipsis  icon  > Register new service in order to register the printer service.

The PrintOS service allows you to monitor the printer activity remotely and receive alerts in your mobile device, 
among other services. If you want to register, you will have to participate in the Printer Data Sharing Agreement, 
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if you have not done so already. Then tap the Connectivity  icon , then Services > PrintOS, and follow the steps 
shown on the front panel.

Verify printer connection to HP

You can check that the printer is able to connect to HP services by tapping the Connectivity  icon  and viewing 
the status there. You can see detailed information by clicking the Network or Service card.

If there is any problem connecting to HP, you will be provided with a description of the problem and some 
possible solutions.

Configure firmware updates
You can choose from the Embedded Web Server or from the front panel whether and how to download firmware 
updates.

NOTE: The administrator password is required to change these settings.

● In the Embedded Web Server: Click About printer > Firmware update.

● Using the front panel: Tap the Settings  icon , then System > Firmware update.

The following settings are available:

● Download new firmware automatically: If you select Automatically (the default setting), the printer will 
automatically download new firmware whenever it becomes available. Deactivate this option to download 
new firmware manually.

NOTE: Downloading the firmware does not mean that you have installed it in your printer. To install the 
new firmware, you must confirm the installation manually.

Default administrator password
The printer comes with a default administrator password.

See Unique password on page 17.

Unique password
Your printer has a unique default password that all printer administration/configuration resources are protected 
with.

How to find the default administrator password
You have two options to find your default password in the front panel (if it has not been modified previously).
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1. Go to Settings > Security > Administrator password. A window appears with the password:

2. You can also find the password in the About Printer application. From the main screen, go to About Printer > 
Printer Information:

How to change the default administrator password
You can change the administrator password through a web browser. Go to: SettingsSecurity > Administrator 
password, then tap the Pencil  icon .

A new window appears and asks for both the old and new passwords.

NOTE: The new password one can be anything you like except a blank.

Drivers
There are various drivers for your printer; which is best for you depends on your circumstances.

● Your operating system

● The type of applications from which you print
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● The number of printers you have

● The output accessories you have

You can find the latest driver software on the HP website at the following 
link: http://www.hp.com/go/DesignJetZ6Pro64in/drivers (if you have a Z6 Pro) or 
http://www.hp.com/go/DesignJetZ9Pro64in/drivers (if you have a Z9+ Pro).

Specific Windows drivers
HP recommends the PCL driver, and the PDF driver for printing with Windows.

● The PCL driver, best for any application (except PDF)

● The PDF driver, best for printing PDF documents from Adobe applications

macOS drivers
Raster and PostScript drivers are available; choose the one that best suits your application.

Raster driver

● Specifically for macOS 10 or later

● Best for CAD, GIS, and office applications

PostScript 3 driver

● Specifically for macOS 10 or later

● Best for applications requiring accurate color

Set Windows driver preferences
You can change some default settings in your printer driver according to your own preferences, for instance to set 
color or paper-saving options.

To change default settings, click the Start or Search button on your computer's screen (depending on your 
version of Windows), then click Devices and Settings or Devices and Printers. In the next window, right-click your 
printer's icon, and click Printing Preferences. Any settings you change in the Printing Preferences window will be 
saved as default values for the current user.

To set the default values for all users of your system, right-click the printer’s icon, click Printer Properties, go to 
the Advanced tab, and click Printing Defaults. Any settings you change in the printing defaults will be saved for all 
users.

Change the graphic language setting
You can change the graphic language setting from the front panel. Tap the Settings  icon , then Default 
printing configuration > Graphics language.
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Then select one of the following options:

● Select Automatic to let the printer determine which type of file it is receiving. This is the default setting; it 
works for most software applications. You should not normally need to change it.

● Select HP-GL/2 only if you are sending a file of that type directly to the printer, without going through a 
printer driver.

● Select PDF only if you are sending a file of that type directly to the printer, without going through a printer 
driver.

● Select PostScript only if you are sending a file of that type directly to the printer, without going through a 
printer driver.

● Select TIFF only if you are sending a file of that type directly to the printer, without going through a printer 
driver.

● Select JPEG only if you are sending a file of that type directly to the printer, without going through a printer 
driver.

● Select CALS/G4 only if you are sending a file of that type directly to the printer, without going through a 
printer driver.

HP PrintOS
HP PrintOS is a Web-based operating system for your business—an open and secure cloud-based platform. It 
drives productivity and inspires innovation with a unique suite of apps that deliver greater control while also 
simplifying production processes.

Signing up is the first step to enjoy the benefits of the completely new HP PrintOS, your cloud-based print 
production operating system.

● Get control over your fleet production

Stay on top of production even when you’re away from your printer, and get data-driven insights for better 
decision-making and continuous improvements.

● Easily configure your substrates remotely

Put an end to repetitive and time-consuming processes. Backups are automatic, and you can easily restore 
substrate configurations.

● Catch new growth opportunities

Easily integrate Web-to-print decoration and signage design tools into your website and unleash your online 
print business potential.

PrintOS solutions

● PrintBeat: Remotely monitor your print production, access and download printer job information, and make 
effective data-driven decisions to keep improving your operations.

● PrintOS Mobile App: Control your print operations virtually anytime, anywhere by monitoring printer status, 
ink and substrate consumption, view completed jobs, and immediately identify printing issues even while on 
the go.
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● Configuration Center: Remotely configure your large-format printer from any location by managing, 
accessing, and deploying all your printer’s substrate configuration from a single place, to simplify and 
balance your print operations.

● To be confirm Service Center: Access all service activities directly from a single portal, providing you with 
quick, efficient, and reliable management of service cases.

● Learn App: Increase your productivity and business success with knowledgeable employees.

To sign up go to the HP website at the following link: http://www.printos.com.

Accessibility
HP stands for the equality and dignity of all persons so that business and society can thrive. HP is committed 
to fostering inclusion, a core value to delivering innovative technology that is beneficial to the widest range of 
people possible.

Front panel
If required, the front-panel display brightness and the loudspeaker volume can be changed.

See Change system options on page 9)

Embedded Web Server
From the Embedded Web Server, you can see the status of the printer, and perform other actions without using 
the front panel.

For information about the accessibility features of the Embedded Web Server, click Support > Accessibility.

If your mouse is connected by USB, you can use the mouse wheel to enlarge the elements of the user interface.

For information about the HP Accessibility Program, and HP's commitment to making its products 
and services accessible to people with disabilities, see the HP website at the following link: 
http://www.hp.com/hpinfo/abouthp/accessibility/.

Other sources of information
The user documentation for your printer is available for download in PDF format from www.hp.com.
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The documents listed below can be downloaded from the HP website at the 
following link: http://www.hp.com/go/DesignJetZ6Pro64in/manuals (if you have a Z6 Pro) or 
http://www.hp.com/go/DesignJetZ9Pro64in/manuals (if you have a Z9+ Pro):

● Introductory information

● User guide

● Legal information

● Limited warranty

● Site preparation guide
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Paper handling2

General advice
Before starting a paper loading process, it is important to ensure you have enough room at the front of the 
printer.

CAUTION: Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer 
from moving.

CAUTION: All paper must be 432 mm (17 in) or longer.

TIP: For photo paper wear cotton gloves to avoid transferring oils onto the paper.
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CAUTION: Keep the basket closed throughout the loading process.

Loading methods
There are two options available to load paper: auto-feed or assisted feed.

Auto-feed
The printer will prompt you to select paper type and length while the paper is being loaded.

NOTE: If the printer is idle, you can skip the steps 1 to 5 and go directly to step 6.

1. Go to the front panel and tap Paper.

2. Tap Load for the corresponding paper source, then Paper.
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3. Select your Paper type.

4. Select your Loading method.

5. Tap Autofeed & auto-deskew (Default).

6. Open the loading station.
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7. Pull the lever to unlock the left-hand hub.

8. Move the left-hand hub to the left, and place the paper roll onto the loading table.

IMPORTANT: Make sure paper is orientated as you see in the image.

9. Push the right-hand hub into the roll’s core until it makes contact with the blue disk.

10. Push the left-hand hub into the roll’s core until it makes contact with the blue disk.
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11. Pull the lever down to close the left-hand hub.

12. Check that the ends of the roll are compact and flat.

13. Close the loading station.

Assisted feed
Automatic paper loading may fail when thin paper like plain or coated jumbo rolls are used. When this happens 
the printer asks you to use assisted feed to load paper.

TIP: Bending the right-hand side of the paper's leading edge a little before you load helps the printer to detect, 
and automatically load it.
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1. Go to the front panel and tap Paper.

2. Tap Load for the corresponding paper source, then Paper.

3. Select your Paper type.

4. Select your Loading method.
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5. Tap Assisted feed.

6. Open the loading station.

7. Pull the lever to unlock the left-hand hub.

8. Move the left-hand hub to the left, and place the paper roll onto the loading table.

IMPORTANT: Make sure paper is orientated as you see in the image.
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9. Check that the ends of the roll are compact and flat.

10. Push the right-hand hub into the roll’s core until it makes contact with the blue disk.

11. Push the left-hand hub into the roll’s core until it makes contact with the blue disk.

12. Pull the lever down to close the left-hand hub.
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13. Close the loading station.

14. Turn the hub in the direction shown to insert the paper edge into the paper feed area.

15. Continue to turn the hub to feed the paper until you see it in the print zone.

Load a roll into the printer
There are two options available to load a roll: from the front panel, or directly in the printer.

From the front panel
When the user wants to load the paper starting from the front panel.

1. Go to the front panel and tap Paper, then tap the Settings  icon .
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2. In the Paper source tab, tap Paper type.

3. Tap Paper, then select Paper type.

4. Enter the length and choose the loading method.

5. Open the roll feeding bar, and load the paper.

Directly in the printer
When the user wants to load the paper first, and then define the settings in the front panel.

1. Open the roll feeding bar.

2. Close the roll feeding bar.

3. In the front panel, tap Paper, then select Paper type.
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4. Enter the length.

NOTE: If you have a take-up reel accessory or multifunction roll, then HP recommends you move the diverters 
to the upper position to prevent paper getting into the accessory. See Paper gets into the lower module on page 
167.

Unload a roll
To unload a roll, go to the front panel and follow instructions.

Use the take-up reel
When using the take-up reel, make sure you have the correct core installed; 2-inch or 3-inch.

Attach before printing
It is important to disable the cutter before you attach the paper to the take-up reel.

NOTE: Attaching the paper to the take-up reel before printing implies waste of material.

1. Go to the front panel and tap Paper, then tap the Settings  icon .

2. Tap on Output options.

3. Select Cutter.
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4. Disable the cutter.

5. Prepare at least three pieces of sticking tape to fix the paper to the core.

6. Go to the printer to proceed to advance the paper.

7. Tap on the Advance paper icon  and advance until the paper reaches the take-up reel.

8. Press and Rewind paper icon  to rewind and the Advance paper icon  to advance paper to get the 

paper end in line with the core.

NOTE: If you have a multi-roll accessory, the second roll has to be set in Take-up reel mode in the front 
panel. After selecting Take-up reel in the front panel you must lower the pinch arms. See Switch from paper 
source to take-up-reel on page 42.

9. Open the take-up reel.

10. Pull the lever to unlock the left-hand hub.
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11. Move the left-hand hub to the left, and place the empty core onto the loading table.

12. Push the empty core towards the right-hand hub until it makes contact with the blue disk.

13. Push the left-hand hub into the core until it makes contact with the blue disk.

14. Pull the lever down to close the left-hand hub.
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15. Wait until the paper reaches the core level. Attach the paper: it can be attached to the core inwards or 
outwards.

16. Roll the paper inwards or outwards in the desired direction and complete at least one complete turn before 
closing the loading station.

17. Close the take-up reel.

18. Roll the paper a little in the selected winding direction until the roll starts to collect the paper automatically 
and becomes taut.
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19. When the job has finished, engage the cutter; tap on Paper, then tap the Cut paper icon .

20. To enable the cutter; go back and follow steps 1, 2 , and 3 again.

Attach while printing
You can send a job to print, and then attach it to the take-up reel.

1. Prepare at least three pieces of sticking tape to fix the paper to the core.

2. Open the take-up reel.

3. Send a job to print, then wait until the job is about to reach the core in the take-up reel.

NOTE: If you have a multi-roll accessory, the second roll has to be set in Take-up reel mode in the front 
panel. After selecting Take-up reel in the front panel you must lower the pinch arms. See Switch from paper 
source to take-up-reel on page 42.

4. Pull the lever to unlock the left-hand hub.
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5. Move the left-hand hub to the left, and place the empty core onto the loading table.

6. Push the empty core towards the right-hand hub until it makes contact with the blue disk.

7. Push the left-hand hub into the core until it makes contact with the blue disk.

8. Pull the lever down to close the left-hand hub.
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9. Wait until the paper reaches the core level. Attach the paper: it can be attached to the core inwards or 
outwards.

10. Roll the paper inwards or outwards in the desired direction and complete at least one complete turn before 
closing the loading station.

11. Close the take-up reel.

12. Roll the paper a little in the selected winding direction until the roll starts to collect the paper automatically 
and becomes taut.
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Detach
It is important to hold the paper when cutting it to prevent it from falling brusquely.

1. If the cutter was disabled, go to the front panel and cut the paper to detach it from the core.

2. The paper rewinds automatically.

3. Open the take-up reel and keep rewinding the paper.
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4. Locate the left-hand hub and open the lever.

5. Move the hub to the left and pull the roll out.

Deactivate the take-up reel
You can deactivate the take-up reel anytime; while printing or when the printer is idle.
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1. Go to the front panel and tap Paper Source, then the Ellipsis icon  .

2. Tap Deactivate take-up reel.

3. This message will appear in the front panel:

NOTE: This can be done anytime, while printing or when idle.

NOTE: The take-up reel has to be attached again after.

Switch multi-function roll accessory functions between take-up reel 
and paper source

Simplify your operation, boost workflow productivity, and change between take-up reel and paper source with 
ease.

Switch from paper source to take-up-reel
Changing from paper source to take-up-reel has never been easier or quicker.

1. Go to the front panel and tap Paper.

2. Tap Output destination.
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3. Tap the Ellipsis  icon , then Switch source function, then select Take-up reel.

4. If Roll 2 is loaded, please Unload.

5. Slide the lever to the left.

6. Lower all the arms.

7. Ensure all the arms are down.

8. The take-up real is now ready as the Output destination.

Switch from take-up reel to paper source
Changing from take-up reel to paper source has never been easier or quicker.

1. Go to the front panel and tap Paper.

2. Tap the Ellipsis  icon , then Switch source function, then select Paper source.
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3. Slide the lever to the right to release the arms.

4. Roll 2 is now selected as paper source.

View information about the paper
To view the loaded paper information, tap the Paper  icon , then the Roll icon.

The following information is displayed on the front panel:

● Paper type you have selected

● Roll status

● Width of the paper in millimeters

● Length of the paper in millimeters

● Calibration status

If no paper is loaded, the message Out of paper is displayed.

The information is displayed in the Embedded Web Server (Paper tab > Paper Source, then click the card for the 
loaded paper to see the extra details of calibration and length).

Paper presets
Each supported paper type has its own characteristics. For optimum print quality, the printer changes the way it 
prints on each different paper type. For example, some may need more ink and some may require a longer drying 
time.

The printer must be given a description of the requirements of each paper type, this description is called the 
paper preset. The paper preset contains the ICC profile, which describes the color characteristics of the paper; 
it also contains information on other characteristics and requirements of the paper that are not directly related 
to color. Existing paper presets for your printer are already installed in the printer's software, these are called 
installed papers. You can find more paper presets with an online search or with the HP Media Locator.
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Online search in the paper library
You can search online for a paper preset by using the online search function within the Paper library front panel 
menu.

The printer connects to the HP Media Locator database on the Internet and allows you to search all available 
paper presets for your particular printer model, including HP and third-party paper brands. Hundreds of different 
paper presets may be available, and the database of paper presets is continuously updated and expanded. You 
will always get the most up-to-date content in this way.

When the printer is connected to the database (this may take a few seconds), a list of all available paper presets 
for your printer model is displayed. You can browse the list by scrolling it, and get details on any preset by 
tapping its name. Besides browsing, there are two additional ways to look for presets: free-text search and filters.

Free-text search allows you to type in any text using an on-screen virtual keyboard; all paper presets containing 
that text in any part of their name or description will be displayed.

Filters are available for brand, type, sub-type, and application. When a value is selected for a given filter, only 
the matching paper presets will be displayed. For example, if you select "HP" from the brand filter, only HP paper 
presets will be displayed. The effect of using more than one filter is to narrow the search to the combination of 
the filter settings. For example, if you choose "HP" from the brand filter and "Self-Adhesive Vinyl" from the type 
filter, only paper presets for HP Self-Adhesive Vinyl papers are displayed.
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Once you have located the paper preset of your choice, tapping its download icon will queue it for automatic 
download and installation in the background. You can select as many paper presets as you want for download 
and installation (they will be processed in the order that they were selected). You can return to another part of 
the Media Manager or another front-panel screen at any time after queuing presets for download, and this will 
not interrupt the download and installation process.

Once a paper preset has been downloaded in the background, it is checked and installed on the printer's 
hard disk. During checking and installation, a full-screen message is shown on the front panel. This message 
disappears when checking and installation is complete.

The new paper preset now appears in the paper library, together with all previously installed and factory-
provided presets, and is ready for use.

HP Media Locator
The HP Media Locator database of paper presets can also be accessed from a Web browser.

Visit https://www.printos.com/ml/. This provides access to the database for different regions, printer models, 
applications, suppliers, paper types, and so on.

When you have located the paper preset of your choice, you can download it to your computer. To install the 
preset into the printer with which you want to use it, use the printer's Embedded Web Server. Click Paper > Paper 
management > Import paper preset.
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Click the Browse  icon  and navigate to the paper preset file that you have previously downloaded to your 
computer, then click Import to install the preset in your printer.

The Embedded Web Server also allows you to export one or more paper presets from your printer for use with 
another printer of the same model. To export more than one paper preset at a time, select the paper presets and 
press the Export button. All exported presets will be saved in the same paperpresets.oms file.

When importing a previously exported paper preset, you may see a message warning you that the package is not 
signed (only packages downloaded from the HP Media Locator Internet database are digitally signed, as a form of 
authentication); you can either ignore the warning and continue with the installation, or abort the installation.

If you get an error message while exporting:

● Check that you have enough disk space available.

● Check whether importing multiple paper presets will exceed the maximum permitted for the printer (10 
presets).

To install a downloaded paper preset
If you do not find the paper preset you want on the Web, you may find that it has been added to the latest 
firmware for your printer.

1. After finding the right paper preset at https://www.printos.com/ml/, or the paper manufacturer's website, 
click the Download now button and save the paper preset (an .oms file) on your computer.

2. Before starting to install the new preset, make sure that the printer is idle and the print queue is stopped. 
Installing a new paper preset will interrupt any printing that is in progress.

3. Start the HP DesignJet Utility or the Embedded Web Server.

In the Embedded Web Server, click the Paper tab. In the Paper Management section, click the Paper preset 
tab.

4. On the Import page, select the paper preset file that you downloaded in step 1.

5. Click the Import button and wait for the update process to finish. It may take some time.

6. Check that the new paper type appears in the Additional paper or Custom paper category in your printer's 
front panel.

Now that you have imported the paper preset, you can select the paper type from the front panel and from the 
driver. The paper preset for the new paper type is ready to use by your application.

To create your own paper preset
Before using a custom paper type with your printer, you should add a paper preset for the new paper. You can 
create a new paper preset directly from the front panel.

1. The paper preset name will appear in the printer driver and on the front panel. To create a paper preset, 
follow this simple procedure:

1. Go to the installed papers inside the paper library in the front panel.

2. Tap the Add new paper icon .
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3. Enter your paper's name.

NOTE: The paper's commercial name is likely to be the most understandable for other users of the printer.

4. Select a paper category from the menu. The paper category determines the amount of ink used and other 
basic printing parameters.

5. Select the appropriate settings: thickness, drying time, horizontal cutter, vacuuum, cutter, advance factor, 
etc.

6. If paper calibration is recommended, the system will prompt you with this option. Click the Right arrow 
icon .

7.

8. You can rename, delete, clone or even reset the settings. You will find the paper name in the Custom paper 
category in the front panel.

9. Now that you have created the paper preset, you will be able to select the paper type from the front panel 
and from the driver under the Custom paper category.

You can export the new paper preset to your computer and use it on other HP DesignJet Z series printers, 
by using the Embedded Web Server:

a. From the Paper tab, click Paper management > Export paper preset.

b. Select a paper preset and click the Export button. An OMS package with the paper preset will be 
downloaded.

NOTE: This page shows only the custom paper presets that you can export.

Generic presets
Generic presets are each designed for a whole paper category, rather than for a particular paper type.
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Generic presets cannot be edited, erased, saved, color-calibrated or ICC profiled; but they can be cloned. 
Therefore, if you would like to modify a generic preset in any way, you should first clone it and then work 
on the clone, which is fully editable.

The printer provides generic presets for the supported paper categories: see Supported paper types on page 
149.

Clone a paper preset
You may wish to clone and edit a preset for various reasons.

● To assign a name of your own choice to the preset

● To adjust the preset to the precise characteristics of your paper

● To adjust the preset to your intended use of the paper, which may range from highest-quality printing to fast 
production output.

You can clone a paper preset from the front panel or Embedded Web Server (EWS). Follow these steps to clone 
from the front panel:

1. Select a preset in the Paper Library.

2. Click Clone to clone the preset, and enter a name for the new preset.
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NOTE: You can also clone a paper preset from the Embedded Web Server.

Modify a paper preset
You can modify a preset from front panel or the Embedded Web Server. To do it from the front panel: press 
Modify.

Then tap the Edit  icon  of the print mode that you want to modify; or tap Add new print mode. You can delete 
or change the name of any print mode; although you should keep at least one print mode.

NOTE: You can define up to six print modes.

NOTE: The number of passes in an existing print mode cannot be changed. If you want to change the number 
of passes, create a new print mode.

NOTE: You are not allowed to create two print modes with the same number of passes, the same efficiency 
mode, and the same color saturation.

NOTE: You can also edit paper presets from the Embedded Web Server.

To change the values, you must print a test plot. Check it and choose the number in the pull-down color-
saturation menu that matches your preferences in terms of curing and drying. If none of the options are good 
enough, try changing the temperature and reprint. You can also change the paper advance settings.
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Delete a paper preset
You can delete paper presets that you have added yourself, but not those that were supplied with the printer.

To do it from the front panel, press the Bin  icon  in the Paper Library screen, or from the Embedded Web 

Server in the Installed Papers tab.

Delete paper preset (only available for custom papers):

If you delete a preset, you will lose the reference to that paper in the usage and accounting information. Instead 
of the name of the paper, from that moment on you will see “Deleted paper” in the usage and accounting 
information.

Printing paper info
Enable the Printing paper info option to record the printer’s estimate of the remaining roll length, paper width 
and type. The information is a combination of barcode and text that is printed on the leading edge of the roll 
when the paper is unloaded from the printer.
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NOTE: The paper-length estimate is available only if the printer registered the amount of paper that was on 
the roll when you loaded it. To provide this information to the printer, specify the roll length on the front panel 
when loading the paper, or load a roll that has the paper-data barcode printed on it.

NOTE: The barcode can only be printed with generic paper. Custom (cloned) paper cannot be used with this 
functionality.

NOTE: This option can be expected to work only with papers that are completely opaque: it may fail with 
transparent or translucent papers.

To enable the Printing paper info  option, go to the front panel and tap the Settings  icon , then Paper source > 
Printing paper tracking information > Enable.

NOTE: Enabling this option slightly changes the paper loading and unloading procedures.

Move the paper
If the printer is idle (ready to print), you can move the paper forwards or backwards from the front panel. You may 
want to do this in order to have more or less white space between the last print and the next one.

Alternatively, if you have a Z9+ Pro printer, you can move the paper, tap the Move and cut  icon  on the home 
screen or in the status center.

Feed and cut the paper
The printer advances the paper and makes a straight cut across the front edge.

There are several possible reasons why you might want to do this:

● To trim the leading edge of the paper if it is damaged or not straight.

● To feed and cut the paper when the automatic cutter has been disabled.

● To cancel the waiting time and print the available pages immediately, if the printer is waiting to nest more 
pages.

NOTE: The printheads are serviced after each print, and the paper cannot be cut until the process completes, 
so you may notice a delay.

NOTE: Some papers cannot be cut by the automatic cutter. In this case, the printer advances the paper 
without trying to cut it.

CAUTION: Remove the cut piece from the output tray. If strips or short prints are left in the output tray the 
printer could jam.

NOTE: Photo and coated paper requires careful handling, see Print is scuffed or scratched on page 178.

TIP: To move the paper without cutting it, see Move the paper on page 52.
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Maintain paper
Always keep your paper well protected and well stored in order to print on it at the highest quality.

To maintain paper quality, follow the recommendations below:

● Store rolls covered by another piece of paper or cloth

● Clean input and output platens

● Always keep the window of your printer closed

NOTE: Photo and coated paper requires careful handling, see Print is scuffed or scratched on page 178.

Change the drying time
You may wish to change the drying time setting to suit special printing conditions such as multiple prints where 
time is of higher importance or when you need to be sure ink is dry before handling.

Tap the Settings  icon , then Default printing configuration > Print retrieval > Drying time. You can select:

● Extended, to set a longer than recommended time to ensure ink is completely dry

● Optimal, to set the default and recommended time for your selected paper (this is the default setting)

● Reduced, to set a shorter than recommended time when quality is of lower importance

● None, to disable the drying time and remove your print as soon as it finishes printing

CAUTION: If the ink is not dry when the print is removed it could leave ink in the output tray and marks on the 
print.

NOTE: If you cancel the drying time during a print, the printer may not feed and cut the paper right away due 
to the printhead maintenance, which runs in parallel. If the dry time is zero, the printer cuts the paper and then 
performs the printhead maintenance. However, if the dry time is greater than zero, the printer does not cut the 
paper until after the printhead maintenance has completed.

Turn the automatic cutter on and off
To turn the printer's cutter on or off, go to the front panel and tap the Settings  icon , then Default printing 
configuration > Cutter, and change the cutter option.

The default setting is On.

IMPORTANT: When printing with HP Click, enable and disable the setting on the front panel.

NOTE: If the cutter is turned off, it will not cut the paper between jobs, but it will continue to cut the paper on 
loading, unloading and switching between rolls.

TIP: To cut roll paper while the automatic cutter is disabled, see Feed and cut the paper on page 52.

Unload the take-up reel
Wait for the take-up reel to finish rewinding before you remove it.
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WARNING! Take care not to get your fingers trapped.

1. At the front panel, tap the Move and cut  icon  in the front panel’s top bar.

2. Tap the Cut  icon .

3. Remove the take-up reel (after it has finished rewinding).
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Working with two rolls (accessory)3

If you load two identical rolls into the printer, you can leave it printing unattended for a long time because it can 
switch from one roll to the other automatically.

Advantages of a multiroll printer
The Multifunction Roll Module is an accessory, and can be useful in several different ways.

NOTE: See Accessories on page 148 for more information.

Uses of a multiroll printer:

● The printer can automatically switch between different paper types according to your needs.

● The printer can automatically switch between different paper widths according to your needs. This enables 
you to save paper by printing smaller images on narrower paper.

IMPORTANT: In order to avoid media crashes, ensure there is no paper remaining on the print zone after a roll 
is finished.

The current status of both rolls is shown on the front panel if you tap the Paper  icon .

NOTE: Bear in mind that a protected roll is protected from use unless the roll number or its paper type are 
specifically requested. See Protect a paper type on page 85.

How the printer allocates jobs to paper rolls
When you submit a print job from the printer driver, you can specify (using the Paper type or Type is option) that 
you want it to be printed on a particular paper type.

You also specify (using the Paper source, Source is or Paper Feed option) that you want a print job to be printed 
on a particular roll (1 or 2). The printer will try to satisfy these requirements, and it will also look for a paper roll 
large enough to print the image without clipping.

● If both rolls are suitable for the job, the roll will be chosen according to the roll switching policy. See Roll 
policies on page 90.

● If just one of the rolls is suitable for the job, it will be printed on that roll.

● If neither roll is suitable for the job, it will be put on hold for paper, or printed on an unsuitable roll, depending 
on the paper mismatch action. See Solve paper mismatch on page 90.

The printer driver for Windows will tell you which paper types and widths are currently loaded in the printer, and 
on which rolls.

Here are some settings that may be used in typical situations.

NOTE: The Type is and Paper source settings are in the printer driver; the Roll switching policy is set in the 
front panel.
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● With different paper types loaded:

– Type is: select the paper type you require

– Paper source: Use printer settings

– Roll switching policy: doesn't matter

● With different paper widths loaded:

– Type is: Use Printer Settings

– Paper source: Use printer settings

– Roll switching policy: Minimize paper waste

TIP: You can also save paper in some cases by rotating or nesting your images. See Use paper 
economically on page 82.

● With identical rolls loaded:

– Type is: Use Printer Settings

– Paper source: Use printer settings

– Roll switching policy: Minimize roll changes
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Networking4

Introduction
The printer provides a single RJ-45 connector port for a network connection. In order to meet Class A limits, the 
use of shielded I/O cables is required.

The embedded Jetdirect print server supports connection to IEEE 802.3 10Base-T Ethernet, IEEE 802.3u 
100Base-TX Fast Ethernet and 802.3ab 1000Base-T Gigabit Ethernet compliant networks. When connected 
and powered on, the printer auto-negotiates with your network to operate with a link speed of 10, 100, or 1000 
Mbps, and to communicate using full- or half-duplex mode. However, you can manually configure the link using 
the printer's front panel, or through other configuration tools once network communication is established.

The printer can support multiple network protocols simultaneously, including TCP/IPv4 and TCP/IPv6. For security, 
it includes features to control IP traffic to and from the printer and supports configuration of IP Security (IPsec) 
protocols.

Control network protocols
The printer can simultaneously support multiple network communication protocols. This allows network 
computers that may be using different protocols to communicate with the same printer.

Each protocol may require some configuration before the printer can communicate on the network. For some 
protocols, required parameters are automatically sensed and user-specified settings are not needed. However, 
for other protocols, there may be many parameters to configure.

Enable or disable network protocols
If a network protocol is enabled, the printer may actively transmit on the network even when there are no 
computers on the network that use the protocol. This may increase network traffic. To eliminate unnecessary 
traffic, you can disable unused protocols.

Disabling unused protocols lets you:

● Reduce network traffic by eliminating broadcast messages from unused protocols

● Provide better control over who prints to the printer by eliminating users from other networks who might 
route print jobs to this printer

● Display protocol-specific error conditions for enabled protocols only

To disable unused protocols through the device’s control panel menu, see Front panel menu items on page 57. 
For other tools, such as system command access to the embedded Telnet server, see the HP Jetdirect Print Server 
Administrator’s Guide for your print server model.

Front panel menu items
To access the printer network configuration settings, go to the front panel and tap the Connectivity  icon , then 
the small Settings  , then Network > Gigabit Ethernet > Modify Configuration.
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Table 4-1 Front panel menu items

Menu item Sub-menu item Sub-menu item Values and description

Information Print Sec Report - Yes: Prints a report.

No (default): Does not print a report.
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Table 4-1 Front panel menu items (continued)

Menu item Sub-menu item Sub-menu item Values and description

TCP/IP Host Name - An alphanumeric string, up to 32 characters, used to identify the device. This name is listed on 
the HP Jetdirect configuration page. The default host name is NPIxxxxxx, where xxxxxx is the 
last six digits of the LAN hardware (MAC) address.

Idle Timeout - The time period, in seconds, after which an idle TCP print data connection is closed (default is 
270 seconds, 0 disables the timeout).

IPV4 Settings Config Method Specifies the method that TCP/IPv4 parameters will be configured on the HP Jetdirect print 
server.

Bootp: Use BootP (Bootstrap Protocol) for automatic configuration from a BootP server.

DHCP (default): Use DHCP (Dynamic Host Configuration Protocol) for automatic configuration 
from a DHCPv4 server. If selected and a DHCP lease exists, DHCP Release and DHCP Renew 
menus are available to set DHCP lease options.

Auto IP: Use automatic link-local IPv4 addressing. An address in the form 169.254.x.x is 
assigned automatically.

Manual: Use the manual settings menu to configure TCP/IPv4 parameters.

DHCP Release This menu appears if Config Method was set to DHCP and a DHCP lease for the print server 
exists.

Yes (default): The current DHCP lease is saved.

No: The current DHCP lease and the leased IP address are released.

DHCP Renew This menu appears if Config Method was set to DHCP and a DHCP lease for the print server 
exists.

No (default): The print server does not request to renew the DHCP lease.

Yes: The print server requests to renew the current DHCP lease.

Manual Settings (Available only if Config Method is set to Manual) Configure parameters directly from the 
printer control panel:

IP Address: The unique IP address of the printer (n.n.n.n).

Subnet Mask: The subnet mask for the printer (n.n.n.n).

Default Gateway: The IP address (n.n.n.n) of the gateway or router used for communications 
with other networks.

Default IP Specify the IP address to default to when the print server is unable to obtain an IP address 
from the network during a forced TCP/IP reconfiguration (for example, when manually 
configured to use BootP or DHCP).

Auto IP: A link-local IP address 169.254.x.x is set.

Legacy: The address 192.0.0.192 is set, consistent with older HP Jetdirect devices.

Primary DNS Specify the IP address (n.n.n.n) of a Primary DNS Server.

NOTE: This item appears only if Manual configuration is a higher priority than DHCP in the 
Config Precedence table, configured through the embedded Web server.

Secondary DNS Specify the IP address (n.n.n.n) of a Secondary Domain Name System (DNS) Server.

NOTE: This item appears only if Manual configuration is a higher priority than DHCP in the 
Config Precedence table, configured through the embedded Web server.

IPV6 Settings Enable Use this item to enable or disable IPv6 operation on the print server.

Off: IPv6 is disabled.

On (default): IPv6 is enabled.

Address Use this item to manually configure an IPv6 address.

Manual settings: Use the Manual settings menu to enable and manually configure a TCP/ IPv6 
address.

Enable: Select this item and choose On to enable manual configuration, or Off to disable 
manual configuration.

Address: Use this item to type a 32 hexadecimal digit IPv6 node address that uses the colon 
hexadecimal syntax.

DHCPV6 Policy Router Specified: The stateful auto-configuration method to be used by the print server is 
determined by a router. The router specifies whether the print server obtains its address, its 
configuration information, or both from a DHCPv6 server.

Router unavailable: If a router is not available, the print server should attempt to obtain its 
stateful configuration from a DHCPv6 server.

Always: Whether or not a router is available, the print server always attempts to obtain its 
stateful configuration from a DHCPv6 server.

Primary DNS Use this item to specify an IPv6 address for a primary DNS server that the print server should 
use.

NOTE: This item appears only if Manual configuration is a higher priority than DHCP in the 
Config Precedence table, configured through the embedded Web server.

Secondary DNS Use this item to specify an IPv6 address for a secondary DNS server that the print server 
should use.

NOTE: This item appears only if Manual configuration is a higher priority than DHCP in the 
Config Precedence table, configured through the embedded Web server.

Web Proxy Proxy Type TBC

Curl TBC

Proxy Server Specifies the proxy server to be used by embedded applications in the device. A proxy server 
is typically used by network clients for Internet access. It caches Web pages, and provides a 
degree of Internet security, for those clients.

To specify a proxy server, enter its IPv4 address or fully-qualified domain name. The name can 
be up to 255 octets.

For some networks, you may need to contact your Independent Service Provider (ISP) for the 
proxy server address.

Proy Port Type the port number used by the proxy server for client support. The port number identifies 
the port reserved for proxy activity on your network, and can be a value from 0 to 65535.
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Table 4-1 Front panel menu items (continued)

Menu item Sub-menu item Sub-menu item Values and description

Security Secure Web - For configuration management, specify whether the embedded Web server will accept 
communications using HTTPS (Secure HTTP) only, or both HTTP and HTTPS.

HTTPS: For secure, encrypted communications, only HTTPS access is accepted. The print 
server will appear as a secure site.

HTTP/HTTPS: Access using either HTTP or HTTPS is permitted.

NOTE: The factory default setting depends on the print server model.

IPSEC - Specify the IPsec or Firewall status on the print server.

Keep: IPsec/Firewall status remains the same as currently configured.

Disable: IPsec/Firewall operation on the print server is disabled.

802.1x - -

Reset Security - Specify whether the current security settings on the print server will be saved or reset to 
factory defaults.

No (default): The current security settings are maintained.

Yes: Security settings are reset to factory defaults.

Link Speed - - The link speed and communication mode of the print server must match the network. The 
available settings depend on the device and installed print server. Select one of the following 
link configuration settings:

CAUTION: If you change the link setting, network communications with the print server and 
network device might be lost.

Auto (default): The print server uses auto-negotiation to configure itself with the highest link 
speed and communication mode allowed. If auto-negotiation fails, either 100TX HALF or 10TX 
HALF is set depending on the detected link speed of the hub/switch port. (A 1000T half-duplex 
selection is not supported.)

10T Half: 10 Mbps, half-duplex operation.

10T Full: 10 Mbps, Full-duplex operation.

10T Auto: Limits auto-negotiation to a maximum link speed of 10 Mbps.

100tx Half: 100 Mbps, half-duplex operation.

100tx Full: 100 Mbps, full-duplex operation.

100tx Auto: Limits auto-negotiation to a maximum link speed of 100 Mbps.

1000 Full: 1000 Mbps, full-duplex operation.

Link configuration methods
The printer supports 10, 100, or 1000 Mbps network link speeds using full-duplex or half-duplex communication 
modes (a 1000T half-duplex selection is not supported). By default, it will attempt to auto-negotiate its link 
operation with the network.

When connecting to network hubs and switches that do not support auto-negotiation, the printer will configure 
itself for 10 Mbps or 100 Mbps half-duplex operation. For example, when connected to a non-negotiating 10 
Mbps hub, the print server will automatically set itself to operate at 10 Mbps half-duplex.
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If the printer is not able to connect to the network through auto-negotiation, you can set the link setting by one 
of the following methods:

● The front panel

● The Embedded Web Server

● The Telnet interface, through a system command prompt

● Network management tools such as HP Web Jetadmin

Troubleshooting

IO Configuration card
The IO Configuration card provides comprehensive print server status. The information provided is an important 
diagnostic tool, especially if network communication is not available.

For a description of messages that may appear on the card, see the HP Jetdirect Print Servers Administrator’s 
Guide for your print server model.

For detailed connectivity information, go to the Connectivity menu and click Network card or Services card to see 
all the information available.

The network card provides details about the network configuration and status. The services card provides 
information about the state of connections to HP services.

1. On the network card, look for the status message I/O Card Ready.

2. If I/O Card Ready appears, the print server is operating properly. Proceed to the next section.

If a message other than I/O Card Ready appears, try the following:

a. Turn the printer off and then on again to re-initialize the print server.

b. Check that the status indicator lights (LEDs) are providing proper status.

See the HP Jetdirect Print Servers Administrator’s Guide for your print server model to interpret and troubleshoot 
other messages.

Reset network parameters
If you accidentally misconfigured the printer’s network settings, they can be reset to factory default values by 
tapping the Connectivity  icon , then the small Settings  icon , then Network > Restore connectivity factory 
settings.

CAUTION: A factory-installed HP Jetdirect X.509 certificate will be saved during reset to factory default values. 
However, a Certificate Authority (CA) certificate that has been installed by the user to validate a network 
authentication server will not be saved.

Link troubleshooting
The printer has status lights (LEDs) beside the network connector that indicate the link status and network 
activity.
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If a link failure is indicated, try the following:

● When the green light is on, the printer has successfully linked to the network.

● When the yellow light is blinking, there is network transmission activity.

If the printer does not successfully connect to the network:

● Both LEDs will be off.

● The alert No network cable connected will appear on the front panel.

1. Check the cable connections at both ends.

2. Consider replacing the cables by known good ones.

3. Consider switching to another network connector in the network switch, hub, or device to which the printer 
is connected.

4. Manually configure the link setting to match the port configuration of the network hub or switch. For 
manual configuration methods, see Link configuration methods on page 60. Turn the printer off, then on 
again, to re-initialize the setting.

5. Print a Connectivity Configuration page and check link settings.

Table 4-2 Check link settings

Item Description

Port Config If the printer is properly linked, this item has one of the following values:

● 10BASE-T HALF: 10 Mbps, half-duplex

● 10BASE-T FULL: 10 Mbps, full-duplex

● 100TX-HALF: 100 Mbps, half-duplex

● 100TX-FULL: 100 Mbps, full-duplex

● 1000TX FULL

If the printer is not properly linked, one of the following messages will appear:

● UNKNOWN: The printer is in an initialization state.

● DISCONNECTED: A network connection has not been detected. Check network cables. Reconfigure the 
link settings, or restart the printer.

Auto Negotiation Indicates whether auto-negotiation for link configuration is on or off.

● ON (default): The printer will attempt to automatically configure itself onto the network at the proper 
speed and communication mode.

● OFF: You must manually configure the link speed and communication mode using the front panel. Your 
settings must match those of the network for proper operation.

6. In case of doubt or misconfiguration of link settings, reset the network parameters to their factory settings. 
See Reset network parameters on page 61.

Communication failures between computer and printer
There are a number of issues that can cause your printer to stop working and lose communication.
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Some symptoms are:

● The front-panel display does not show the Received jobs message when you have sent jobs to the printer.

● Your computer displays an error message when you are trying to print.

● Your computer or printer hangs (stays idle), while communication is taking place.

● Print jobs get stuck in your computer’s print spooler.

● Your printed output shows random or inexplicable errors (misplaced lines, partial graphics, and so on).

To solve a communication problem:

● Ensure that you have selected the correct printer when sending your job.

● Ensure that the printer works correctly when printing from other applications.

● If your printer is connected to your computer through any other intermediate devices, such as switch boxes, 
buffer boxes, cable adapters, or cable converters, try using it when connected directly to your computer.

● Try another network cable.

● Remember that very large prints may take some time to receive, process and print.

● If your printer displays warning or error messages that require action, take the required action before trying 
to print.

Cannot access the Embedded Web Server
If you connect directly to your printer with a USB cable, you cannot access the Embedded Web Server.

1. If you have not done so already, read Embedded Web Server on page 12.

2. Make sure that Embdedded Web Server functionality is enabled in the printer: from the front panel, tap the 
Settings  icon , then Security > Embedded Web Server (EWS) > On.

3. Check the proxy configuration in your Web browser in case it is preventing communication with the printer.

4. Ensure that the printer works correctly when printing or accessed from other applications.

5. If the printer displays warning or error messages that require further action, take the action to resolve the 
problems.

6. If all else fails, turn the printer off and on again with the power key on the front panel.

Print jobs take too much time to be received by the printer
If you send a very large print to the printer, there will normally be some delay before it starts printing.

However, if you think you are experiencing abnormally long delays, there are various things you could check:

● Make sure the network cable connected to the printer is rated at least Cat5e.

● Make sure that gigabit-speed networking equipment and cabling interconnects your computer client to the 
printer.

● Make sure that there are no network link issues. See Link troubleshooting on page 61.
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● Take into account that, in network deployments with IPSec security protocols enabled and configured in the 
printer, network performance may be reduced due to the use of cryptographic algorithms to protect network 
communications.

● Try resetting the network configuration to its factory settings in order to get default settings that are 
suitable for most standard network environments. See Reset network parameters on page 61.

● You may also find it helpful to test connecting the computer to the printer directly, using a normal 
Ethernet (Cat5e or Cat6) cable point-to-point, without passing through an Ethernet switch or router. In 
this configuration, the printer and the computer should both automatically change their IPv4 addresses 
to the form 169.254.x.x . In this point-to-point configuration you can discard any issues caused by other 
network equipment.
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Security5

HP Connection Inspector
HP Connection Inspector is a new intelligent embedded security feature. The technology is unique in that it 
can inspect outbound network connections typically abused by malware, determine what is normal and stop 
suspicious activity. If the printer is compromised, it can automatically trigger a restart to initiate self-healing 
procedures.

Enable/disable the Connection Inspector
In the Embedded Web Server, click Networking > TCP/IP settings > Network identification.

For more information see the HP Connection Inspector Technical White Paper on the HP website at the following 
link: http://h10032.www1.hp.com/ctg/Manual/c05818653.

Enable/disable auto-recovery
If the Connection Inspector detects a severe incident, the printer can respond in two different ways.

● When auto-recovery is enabled, if suspicious activity is detected by the Connection Inspector, the printer 
recovers automatically by restarting itself. In this case, all printing and scanning operations are terminated.

● When auto-recovery is disabled, if suspicious activity is detected, the printer simply displays a system error 
and recommends contacting a service representative.

You can enable or disable auto-recovery in the Embedded Web Server by clicking Security > Security settings > 
Enable auto-recovery.
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Access control

Administrator password

Default administrator password
Your printer comes with a default administrator password. To find out what it is, go to the front panel and tap the 

Settings  icon , then Security > Administrator password.

You should see something like this:

Alternatively, tap the About printer  icon , then Printer information card. You should see something like this.

How to change the administrator password
HP recommends that you change the password to one of your own choice.

NOTE: The administrator password cannot be left blank.

To change the password, go to the Embedded Web Server and click Settings  > Security  > Administrator 
password , then tap the Modify  icon .
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If you forget the password
If you forget the administrator password, contact a service representative and ask for it to be reset to the default 
password. You cannot do this yourself.

Access control permissions will also be reset to the default values.

Access control tab
In the Embedded Web server you can set sign-in requirements for specific tasks, and restrict access by users who 
have not signed in (guests) to specific features. Permissions can be applied to local user accounts stored on the 
printer.

Device user accounts
In the Embedded Web Server’s Device user accounts tab, the administrator can create new printer user accounts 
and assign them specific permissions depending on their role.

To create a new device user account, tap the Plus  icon  at the top of the page. Now fill in the fields Name, 
Email, User access code and the permission set. Tap Apply to create the new account.

Share the access code with the user. When using device user accounts, users sign in to the device using an access 
code.
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LDAP-sign-in server
Ensure that you have all the necessary information before starting the configuration.

Information needed before starting:

● Server address (hostname or IP)

● Server authentication requirements

● Path to start search (BaseDN, Search Root) (for example, o=mycompany.com)

● Attributes for matching the name entered (such as cn or samAccountName), retrieving the email address 
(such as mail), and how the name will be displayed on the control panel (such as displayName)

Setup
In the Embedded Web Server, click Settings > LDAP sign-in server.

1. Enable the LDAP server (mandatory to continue with the LDAP configuration).

2. In the network directory server section, enter the name of the LDAP server address (for example, 
ldap.mycompany.com) and Port.

● If you do not know the LDAP server, contact the server administrator.

● If you want to enable a secure (SSL) connection, enable the toggle Use a secure connection (SSL).

3. In the server authentication requirements section, you can select the appropriate authentication type in 
the server (use printer user’s credentials, use LDAP administrator’s credentials). You must fill in the domain 
name, username, and password.

4. In the LDAP database search setttings section, fill in these fields:

● In the Bind and search root enter the path to start searching the database (for example, 
o=mycompany.com).

● In the Retrieve the printer user’s name using this attribute box, enter the name of the attribute that 
contains the person's name (for example, displayName).

● In the Match the name entered with this attribute box, enter the name of the attribute whose content 
should be matched with the username type during sign-in.

● In the Retrieve the user’s email address using this attribute box, enter the name of the attribute that 
contains the person's email address (for example, mail or rfc822Mailbox).

● In the Retrieve the printer user group using this attribute box, enter the name of the attribute that 
contains the groups to which the person belongs.

5. Click the Apply button to save the settings. Setup is complete.

6. To check that the LDAP retrieval is set up correctly, enter at least three characters of a network contact 
name in the Test box, and then click the Test button. If the test is successful, a message is displayed.

Windows sign-in configuration
Ensure that you have the all the necessary information before starting the configuration.
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Information needed before starting:

● Windows domain

● Attributes for matching the name entered (such as cn or samAccountName), retrieving the email address 
(such as mail), and how the name will be displayed on the control panel (such as displayName)

Setup
In the Embedded Web Server, click Settings > Windows sign-in configuration.

1. Enable Windows sign-in status (mandatory to continue with Windows sign-in configuration).

2. Enter the name of the default Windows domain (for example, mycompany.com).

● If you do not know the Windows domain, contact the server administrator.

● If you want to enable a secure (SSL) connection, enable the toggle Use a secure connection (SSL).

3. In the Match the name entered with this attribute box, enter the name of the attribute; its content should be 
matched with the username type during sign-in.

4. In the Retrieve the user’s email address using this attribute box, enter the name of the attribute that 
contains the person's email address (for example, mail or rfc822Mailbox).

5. In the Retrieve the printer user’s name using this attribute box, enter the name of the attribute that 
contains the person's name (for example, displayName).

6. Click the Apply button to save the settings. Setup is complete.

7. To check that the LDAP retrieval is set up correctly, enter at least three characters of a network contact 
name in the Test box, and then click the Test button. If the test is successful a message is displayed.

Certificate management
You can configure the printer´s identity certificate, and the list of trusted certification authorities (CA), in EWS 
> Settings > Certificate settings. These certificates are used to establish trusted and secure connections with 
external servers.

Other Embedded Web Server security settings
In the Embedded Web Server menu Security > Security Settings, you can customize your printer by enabling or 
disabling features from the list. A feature is no longer available after it has been disabled.

● Change the firmware update settings: Enable or disable Firmware updates sent as print jobs.

● Protect stored data.

● Enable or disable other printer settings such as Show user name and job name in job accounting, 
Anonymous usage information, and Show job thumbnail and download job file remotely.

Front-panel security settings
From the front panel, you can tap the Settings  icon , then Security, to control some of the features of the 
printer.
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● User sessions: Enable or disable automatic log-out after 1, 3, or 5 minutes.

● Embedded Web Server: Enable or disable the Embedded Web Server.

● Printing & management Web services: Enable or disable Web services that are used by printing and 
management tools such as the HP Utility, HP Click, and SDK for RIPs.

The administration password is required to perform the following operations:

● Change the security settings (including the administrator password itself).

● Change the configuration of the Internet connection.

● Change the automatic firmware update configuration.

● Enable or disable automatic downloading and/or installation of automatic firmware updates.

● Restore an earlier firmware version.

● Change user, roles and permission settings.

● Reset factory defaults.

Job-storage security options
Use Required account ID and PIN printing to control who has access to your printer and confidential documents.

Required account ID
If you want to keep records of printer usage by different users, you can set your printer to require an account ID 
for each job. At the front panel, tap the Settings  icon , then Job management > Account ID required.

If this setting is turned on, the account ID field will be mandatory and jobs with no account ID will be kept on hold 
for accounting.

The account ID can be set in the printer driver when sending the job. If the job is set on hold for accounting by the 
printer, you can introduce the account ID in the driver or front panel. On the front panel, go to the job queue and 
tap the job that is on hold. A window with a text box is displayed and you can enter the account ID into it.

Encrypted PIN Printing
Protect confidential prints, and reduce the risk of leaking sensitive data with PIN printing. Send jobs to print from 
the driver, encrypted, and with a PIN. From the driver go to the Storage tab, select Retrieve from front panel 
(private job), enter a 4-digit PIN, then go to the printer, enter the PIN at the front panel, and retrieve the printed 
job.

Security event logging
The printer can report security event information to a standard syslog server for auditing.

To configure the syslog server and settings, go to the Embedded Web Server and click Network > TCP/IP settings 
> Advanced.
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Printing6

Introduction
There are various different ways in which you can choose to print, depending on your circumstances and 
preferences.

● Print a TIFF, JPEG, HP-GL/2, RTL, PDF, or PostScript file directly from RIP. See Printing from a computer with a 
RIP (optional) on page 72.

● Print a TIFF, JPEG, HP-GL/2, or PDF file directly from a computer connected to the printer, using HP Click 
Printing Software. See the HP website at the following link: http://www.hp.com/go/DesignJetclick.

● Print any kind of file from a computer connected to the printer, using a software application that can open 
the file, and a printer driver supplied with your printer. See Print from a computer using a printer driver on 
page 72.

Printing from a computer with a RIP (optional)
Each RIP has specific requirements. Check with your RIP vendor to find out the requirements for the computer 
that you'll be using for the RIP station.

For a complete list of certified RIP stations available for this printer, see the HP website at the following link: 
https://www8.hp.com/us/en/large-format-printers/designjet-printers/zseries-rips.html. Make sure that the RIP 
station is fully functional and ready for installation.

Print from a computer using a printer driver
You have two options to install the printer driver.

1. HP Printer Driver Installer

The HP Printer Driver Installer can be downloaded from the relevant product page by searching the printer 
model from the HP website at the following link: https://support.hp.com/us-en/drivers/printers. When you have 
searched the printer model then navigate to the Driver-Driver Pack tab and download the HP Printer Driver 
Installer and proceed to install on the computer.

2. Add Printer Driver Wizard

Like the HP Printer Driver Installer, the Add Printer Driver Wizard provides an easy-to-use interface for installing 
the printer driver. However, unlike the HP Printer Driver Installer, the Add Printer Driver Wizard only installs the 
printer driver, and does not allow the user to install any additional printer software.

Use the Windows Add a Printer wizard to install the built-in print driver.
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Wireless or wired network connection (Windows 10, 8)
Install the built-in print driver over a network connection with Windows 10 or Windows 8.

1. In Windows, search for and open the Control Panel.

2. Tap Devices and Printers, and then tap Add a printer.

3. On the Choose a device or printer to add to this PC window, select your printer, tap Next, and then follow the 
on-screen instructions to install the driver.

If your printer is not in the list, continue with these steps:

4. Tap The printer I want isn't listed, and then select Add a local printer or network printer with manual 
settings.

5. Tap Next.

6. Select the port to be used by your printer, such as USB001 for a USB connected printer, and then tap Next.

7. Tap Windows Update, and then wait for the print drivers to update.

8. Tap HP, Hewlett-Packard, or Hewlett Packard in the Manufacturer pane, and then tap the name of your 
printer in the Printers pane.

● If your printer is in the list, select it, tap Next, and then follow the on-screen instructions to install the 
driver.

● If your printer is not in the list, tap the back arrow in the upper left corner of the window two times to 
return to the Find a printer by other options step, and then continue with these steps:

9. Select Add a printer using TCP/IP address or hostname, and then tap Next.

10. Select Autodetect from the Device type drop-down list.

11. Type your printer IP address into the text box, and then tap Next. To find the printer IP address, print a 
Wireless Network Test report or a Network Configuration page.

12. Wait for the computer to connect to the printer, and then tap Next to install the print driver.

Driver settings
The driver has two options for printing: basic and advanced.

Basic

Contains basic operations to print a job:

● Document size

● Orientation of the plot

● Apply a margin layout:

– Standard: Image prints on the selected page size, with a narrow margin between the image and the 
paper edges. The image should be small enough to fit between the margins.
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– Clip content by margins: Image prints on the selected page size, with a narrow margin between the 
image and the paper edges. If the image is the same size as the page, the printer assumes that the 
extreme edges of the image are either white or unimportant, and do not need to be printed. This may be 
useful when your image already contains a border.

– Oversize: Image prints on a page slightly larger than the selected size. If you cut off the margins you 
have a page which is the size you selected, with no margins remaining between your image and the 
edges of the paper.

● Color mode:

– Color: Uses ink from all cartridges for full color prints.

– Grayscale: Uses ink from both the color and black cartridges to produce a wider range of black and gray 
tones for high quality black and white prints.

● Print quality of the job

Advanced

Contains advanced operations for custom printouts. The options may change between PCL and PDF drivers and 
are divided into 5 different subcategories:

Document

● Select the paper type

● Apply scaling to the job:

– Allows you to resize the print in two different ways: to a percentage of its original size, or to fit a 
particular paper size. The default is 100% (its original size).

● Alignment:

– Left

– Center

– Right

● Mirroring

● Apply rotation

Output

● Enable/disable the cutters

● Order the pages

● Printer margins

● Remove blank areas

● Job destination

● Folding style (If the printer has a folder attached)
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Color and quality

● Maximum detail

● Economode

● More passes

● Gloss enhancer

● Pantone emulation (In case of PDF driver)

● Color management

● RGB source profile:

– The color features can be managed by application or printer.

● Advanced color adjustments (In case of PCL driver)

● Allows you to create custom RGB profiles to save and apply them to the printouts

● CMYK source profile (In case of PDF driver)

Accounting

● Option to introduce an accounting ID for the job

Storage

● Option to type a user or job name

● Storage mode of the job (Print & store, Print & delete, etc.):

– Print and store: After a job has printed, it is stored in the printer; more copies can then be printed from 
the front panel.

– Print and delete: Once printed, the job is automatically removed from the printer.

– Retrieve from front panel (personal job): Use the personal job printing feature to specify that a job 
cannot be printed until you release it from the printer's front panel.

NOTE: To preview it in the Embedded Web Server, you will need to enter the PIN.

– Retrieve from front panel (private job): Use the private printing feature to specify that a job cannot be 
printed until you release it with a PIN. First click Retrieve in the front panel (private job), after which the 
PIN to Print checkbox will be available. If checked, a 4-digit personal identification number must be set. 
The PIN is sent to the printer as part of the print job. After sending the print job, use the PIN to print the 
job. Once printed, a job is automatically removed from the printer.

NOTE: To preview it in the Embedded Web Server or in the front panel, you will need to enter the PIN.

Advanced print settings
The rest of this chapter explains the various print settings that you can use when printing with a printer driver or 
the front panel. These methods offer a relatively large number of settings in order to satisfy all requirements.
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TIP: In general you are recommended to use the default settings unless you know that they do not meet your 
requirements.

TIP: If you intend to reuse a particular group of settings repeatedly, you can save those settings under a name 
of your own choice and recall them later. A saved group of settings is known as a 'quick set' in the Windows 
printer driver, and as a 'preset' in the macOS printer driver.

Select print quality
In the PCL or PDF driver dialog: Go to the Basic section and the Print quality option is visible. You can select the 
quality options from the drop-down selector.

To enable or disable other settings like Economode or Maximum details, tap Advanced and scroll down to Color 
and Quality where there is a toggle to enable or disable these options.

You can also reach any of these features from the Search option, just tap the Jobs  icon  and a text box 
appears. Type the name of the option to configure, and the driver offers different options. Tap the option you 
want to select it.

Select paper size
The paper size specified here should be the paper size in which the document was created.

NOTE: It is possible to rescale the document to a different size for printing. See Rescale a print on page 79.

● In the Windows driver dialog: Select the Paper/Quality or Paper tab (depending on the driver version), then 
select your paper size from the Document Size list.

● In the macOS Printer Setup dialog: Select your printer from the Print settings list, then select your paper size 
from the Paper Size list.

NOTE: If you are printing with the V4 driver and from Adobe Acrobat, the page size and orientation are 
determined by the application.

NOTE: Adobe Illustrator is a passthrough application, which means that it manages page size and 
orientation. In the Illustrator print dialog you have to select the page size. To print a custom size job, create 
a custom paper in print management and then select it in the Illustrator print dialog.

NOTE: If your application offers no Page Setup dialog, use the Print dialog.
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● Using the front panel: tap the Settings  icon , then Default printing configuration > Paper options > Paper 
size.

NOTE: If the paper size is set from your computer, it overrides the paper size setting in the front panel.

Custom paper sizes
If you want to choose a paper size that is not included in the list of standard paper sizes, there are various 
different ways to specify it.

Use the Windows printer driver

You can create and save custom paper sizes to suit your requirements.

1. Click the Paper/Quality tab.

2. Click Custom.

3. Enter the name and dimensions of your new paper size.

4. Click OK. The new paper size is automatically selected.

Use Windows forms

Unrestricted users can create a new Windows form.

1. From the Start menu, or from the Control Panel, select Printers and Faxes.

2. From the File menu, select Server Properties.

3. In the Forms tab, check the Create a new form box.

4. Enter the name and dimensions of your new paper size. Leave the margins as 0.00.

5. Click the Save Form button.

6. Go to the printer driver, and select the Paper/Quality or Paper tab (depending on the driver version).

7. Select More… from the drop-down list of paper sizes.

8. Select your new paper size from the group of Custom sizes.

A custom paper size created with Windows forms has specific characteristics:

● The paper size is permanent. It will not disappear if the driver is closed or the computer is turned off.

● Restricted users cannot create paper forms. The “manage documents” role in the Windows Active Directory 
is the minimum required.

● The paper size is local to the computer. It will be seen in all the printer queues that have been created on the 
computer and that support paper of that size.

● If a printer queue is shared, this paper size will appear in all the client computers.

● If a printer queue is shared from another computer, this paper size will not appear on the driver´s document 
size list. A Windows form in a shared queue needs to be created in the server.

● If the printer queue is deleted, the paper size is not deleted.
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Use the macOS printer driver

If your application offers no Page Setup dialog, use the Print dialog.

1. Go to the Page Setup dialog ( use Print if you don´t have it).

2. Select Paper Size > Manage Custom Sizes.

Select margin options
By default, the printer leaves a 5 mm (0.2 inch) margin between the edges of your image and the edges of the 
paper.

However, you can change this behavior in several ways:

● In the Windows V3 driver dialog: Select the Paper/Quality tab, and click the Cutter Settings button. In the 
Layout and Margins window, you can see the options described below.

● In the Windows V4 driver dialog: Select the Layout tab. In the Layout Mode area, you can see the options 
described below.

If you want to change the default cutter options, select the Output tab, and click Roll options.

● In the macOS Print dialog: In the Margins/Layout panel, you can see the options described below. However, 
the available options depend on the paper size selected.

● Using the front panel: Tap the Settings  icon , then Default printing configuration > Margins, to see the 
options described below.

You will see at least some of the following options.

Margin:

● 5 mm (197 mils)

Margin layout:

● Standard

● Clip contents by margins

● Oversize

Print on loaded paper
To print a job on whichever paper is loaded in the printer, choose the Paper Type option in your printer driver.

Choose the following:

● In the Windows driver dialog: Select the Paper/Quality or Paper tab (depending on the driver version), then 
select Use Printer Settings in the Paper Type drop-down list.

● In the macOS Print dialog: Select the Paper/Quality panel, then select Any in the Paper Type drop-down list.

NOTE: Use Printer Settings (Windows) or Any (macOS) is the default Paper Type selection.
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Rescale a print
You can send an image to the printer at a certain size but tell the printer to rescale it to a different size (normally 
larger).

This may be useful:

● If your software does not support large formats

● If your file is too large for the printer's memory—in this case, you can reduce the paper size in your software 
and then scale it up again using the front-panel option

You can rescale an image in the following ways:

● In the Windows driver dialog: Go to the Layout/Output or Paper tab (depending on the driver version) and 
look at the Resizing Options section.

– The Actual size option leaves the size of the image unchanged.

– The Fit to option adjusts the image size to the paper size you have selected. For example, if you have 
selected ISO A2 as the paper size and you print an A3-sized image, it is enlarged to fit the A2 paper. If 
the ISO A4 paper size is selected, the printer reduces a larger image to fit the A4 size.

– The % of actual size or Scale % option (depending on the driver version) enlarges the printable area of 
the original paper size (the page minus the margins) by the percentage indicated, then adds the margins 
to create the output paper size.

● In the macOS Print dialog: Click Paper handling, check the box Scale to fit paper size, and select the paper 
size to which you want to scale the image. For example, if you have selected ISO A2 as the paper size and 
you print an A3-sized image, it is enlarged to fit the A2 paper. If the ISO A4 paper size is selected, the printer 
reduces a larger image to fit the A4 size.

● Using the front panel: Tap the Settings  icon , then Default printing configuration > Paper options > Resize.

Change the treatment of overlapping lines
This only applies when printing an HP-GL/2 job.

The merge option controls the overlapping lines in an image. There are two settings:

● Off: Where the lines cross, only the color of the top line is printed. This is the default setting.

● On: Where the lines cross, the colors of the two lines merge.
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To turn merge on, go to the front panel and tap the Settings  icon , then Default printing configuration > 
HP-GL/2 options > Merge. You can set the merge option from your software in some applications. Settings in 
your software override the front-panel settings.

Preview a print
Previewing a print on the screen allows you to check the layout of the print before printing, which may help you 
to avoid wasting paper and ink on a bad print.

● To preview a print under Windows, you have the following options:

– Use the HP Print Preview application:

Check the Show preview before printing box, which you can find in the right bottom corner of the driver 
dialog. Click Print, then wait a few seconds for the HP Print Preview application to be launched.

Check that the preview of the job is what you wanted. If so, click Print, otherwise click Cancel; you can 
readjust the driver settings before trying again.

NOTE: The Show preview before printing box appears in the driver dialog only if HP Print Preview is 
installed in your computer. See HP Print Preview on page 12.

– Use your application's print preview option.

● To preview a print under macOS, you have the following options:

– Use your application's print preview option.

– There is no Preview button at the bottom of the Print dialog box in the latest versions of macOS. A print 
preview is always shown at the upper left of the Print dialog box for most applications.

– Choose the HP Print Preview option from the PDF menu at the bottom of the Print dialog box. The print 
preview is displayed by a separate HP Print Preview application.

Print a draft
You can specify fast draft-quality printing in several different ways.

● In the Windows driver dialog: Go to the Paper/Quality or Paper tab (depending on the driver version) and look 
at the Print Quality section. Move the print-quality slider to the extreme left ('Speed').

● In the macOS Print dialog: Go to the Paper/Quality panel, click Standard in the quality options, and move the 
print-quality slider to the extreme left ('Speed').

● Using the front panel: Tap the Settings  icon , then Default printing configuration > Print quality > Select 
quality level > Fast.

You can specify even faster draft-quality printing by using Economode, as follows. This is intended mainly for 
documents containing only text and line drawings.

● In the Windows driver dialog: Go to the Paper/Quality or Paper tab (depending on the driver version) and look 
at the Print Quality section. Select Custom Options or Advanced (depending on the driver version), then set 
the quality level to Fast and check the Economode box.

● In the macOS Print dialog: Go to the Paper/Quality panel and set the quality options to Custom, then set 
quality to Fast and check the Economode box.
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● Using the front panel: Tap the Settings  icon , then Default printing configuration > Print quality > Enable 
economode.

NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front panel.

High-quality printing
You can specify high-quality printing in several different ways.

● In the Windows driver dialog: Go to the Paper/Quality or Paper tab (depending on the driver version) and look 
at the Print Quality section. Move the print-quality slider to the extreme right ('Quality').

● In the macOS Print dialog: Go to the Paper/Quality panel, click Standard in the quality options, and move the 
print-quality slider to the extreme right ('Quality').

● Using the front panel: Tap the Settings  icon , then Default printing configuration > Quality level > Best.

NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front panel.

If you have a high-resolution image
If your image has a resolution greater than the rendering resolution (which you can see in the Custom Print 
Quality Options box under Windows), print sharpness may be improved by selecting the Maximum detail option. 
This option is available only if you are printing on glossy paper and you have selected Best print quality.

● In the driver dialog (macOS Print dialog): Select Custom instead of Standard print-quality options, then click 
Best and check the Maximum detail box.

● Using the front panel: Tap the Settings  icon , then Default printing configuration > Print quality > Enable 
maximum detail.

NOTE: The Maximum detail option results in slower printing with photo papers, but it does not increase the 
amount of ink used.

Print in gray shades
You can convert all colors in your image to shades of gray.

See Printing in grayscale on page 101.

Print with crop lines
Crop lines indicate where the paper should be cut to reduce it to your selected page size. You can print crop lines 
with individual jobs in the following ways:

● In the Windows V3 driver dialog: Select the Paper/Quality tab, then click the Margins/Cutter Settings button. 
Check the Draw cutting lines box in the Layout and Margins window.

● In the Windows V4 driver dialog: Select the Output tab, then check the Crop lines box.

● In the macOS Print dialog: Select the Finishing panel, then Crop lines.
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Alternatively, you can choose to print crop lines with all jobs by default:

● Using the front panel: Tap the Settings  icon , then Default printing configuration > Paper options > Enable 
crop lines > On.

To print crop lines with nested jobs (see Nest jobs to save roll paper on page 82), you must select a different 
option:

● Using the front panel: Tap the Settings  icon , then Job management > Nesting options > Enable crop lines 
> On.

Use paper economically
Follow the recommendations for making economical use of paper.

● If you are printing relatively small images or document pages, you can use nesting to print them side by side 
instead of one after another. See Nest jobs to save roll paper on page 82.

● You may be able to save some roll paper by using the following options:

– In the Windows driver dialog:

○ With a version 3 driver: Click the Paper/Quality tab, then the Margins/Cutter Settings button, then 
check the box Remove blank areas.

○ With a version 4 driver: Click the Output tab, then Roll options, then check the box Remove blank 
areas.

You can also select the Layout/Output or Layout tab (depending on the driver version) and then select 
one of the Rotation options.

– In the macOS Print dialog: Select the Finishing panel, then Remove Blank Areas and/or Rotate.

● If you check the print preview on your computer before printing, you can sometimes avoid wasting paper on 
prints containing obvious mistakes. See Preview a print on page 80.

● You can adjust how much paper is wasted between jobs from the front panel: Tap the Settings  icon , then 
Output options > Cutters > Perform a clean cut after end of job. The following options are available:

– Disable cut: The printer will not perform a clean cut at the end of a job

– Large cut: Default on Z6 Pro printers

● You can further adjust how much paper wasted between jobs from the front panel: Tap the 
Settings  icon , then Output options > Cutters > Reduce paper feed on clean cut.

Nest jobs to save roll paper
Nesting means automatically printing images or document pages side by side on the paper, rather than one after 
the other. This is done to avoid wasting paper.

82 Chapter 6  Printing



1. Direction of paper flow

2. Nesting off

3. Nesting on

4. Paper saved by nesting

When does the printer try to nest pages?
When both of the following are true: The printer is loaded with roll paper, not sheet paper, and the printer's Nest 
option is turned on.

See How to turn nesting on and off on page 84.

What pages can be nested?
All pages can be nested, unless they are so large that two of them cannot fit side by side on the roll, or unless 
there are too many of them to fit into the remaining length of the roll. A single group of nested pages cannot be 
split between two rolls.

Which pages qualify for nesting?
In order to be in the same nest, the individual pages must be compatible.

● All pages must have the same print quality setting (Economode, Fast, Normal or Best).

● The Maximum Detail setting must be the same on all pages.

● The Layout/Margins setting must be the same for all pages.

● The Mirror Image setting must be the same for all pages.

● The Rendering Intent must be the same for all pages.

● The Cutter setting must be the same for all pages.

● Pages must be all color, or all grayscale: not some in color and some in grayscale.

● All pages must be in one or other of the following two groups (the two groups cannot be mixed in the same 
nest):

– PCL3, RTL, TIFF, JPEG

– PostScript, PDF
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● JPEG and TIFF pages with resolutions greater than 300 dpi may not nest with other pages in some cases.

How to turn nesting on and off
To turn nesting on or off first make sure that the start of printing is set to After Processing.

See Select when to print a job on page 89.

Then go to the front panel and tap the Settings  icon , then Job management > Nest options > Nesting.

You will see the following options:

● In order: Pages are nested in the order in which they are sent to the printer (this is the default option). The 
nested pages are printed as soon as one of three conditions is met:

– The next page will not fit on the same row as the other pages already nested.

– No page has been sent to the printer during the specified wait time.

– The next page is incompatible with the pages already nested (see Nest jobs to save roll paper on page 
82).

● Optimized order: Pages are not necessarily nested in the order in which they are sent to the printer. When it 
receives an incompatible page, the printer holds it and waits for compatible pages to complete the nest. The 
nested pages are printed as soon as one of three conditions is met:

– The next page will not fit on the same row as the other pages already nested.

– No page has been sent to the printer during the specified wait time.

– The incompatible-page queue is full. The printer can queue up to six incompatible pages while nesting 
compatible pages. If it receives a seventh incompatible page, the nest is printed as it is.

● Off: nesting is disabled.

TIP: Optimized order uses the minimum amount of paper; however, it may take longer to print because the 
printer waits for compatible pages to arrive.

How long does the printer wait for another file?
So that the printer can make the best nest possible, it waits after a file has been received to check whether a 
subsequent page will nest with it or with pages already in the queue.

The waiting period is the nest wait time; the factory default nest wait time is 2 minutes. This means that the 
printer waits for up to 2 minutes after the last file is received before printing the final nest. You can change this 
waiting time from the printer's front panel: tap the Settings  icon , then Job management > Nest options, and 
select the wait time. The available range is 1 to 99 minutes.

While the printer is waiting for nesting to time out, it displays the remaining time on the front panel, and in the 
Embedded Web Server’s Job queue tab.

Manage nesting in the Embedded Web Server
You can manage the nesting of your jobs in the Embedded Web Server’s "Job queue" tab.
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The Up next box shows the jobs that are waiting in the queue; the Now printing box shows the job or jobs that are 
currently printing.

In between them is the nesting box: 

If you click the Nesting  icon  in the nesting box, the jobs in the Up next box will be nested; and the nesting 
box will display a countdown to the time when they will start printing. You can adjust this time: see How long 
does the printer wait for another file? on page 84.

When the printer is printing nested jobs, the Now printing box has a Cancel button to cancel all the nested jobs 
that are currently printing.

Use ink economically
Save on expenditure by following the recommendations for making economical use of ink.

● For draft prints, use plain paper and move the print-quality slider to the left end of the scale ('Speed'). For 
further economy, select custom print quality options, then select Fast and Economode.

● Clean the printheads only when needed, and clean only those printheads that need cleaning. Cleaning the 
printheads can be useful, but it uses a small amount of ink.

● Leave the printer permanently turned on so that it can maintain the printheads in good condition 
automatically. This regular printhead maintenance uses a small amount of ink. However, if it is not done, the 
printer may need to use much more ink later to restore the health of the printheads.

● Wide prints make more efficient use of ink than narrow prints, because printhead maintenance uses some 
ink, and its frequency is related to the number of passes made by the printheads. Therefore, nesting jobs can 
save ink as well as saving paper (see Nest jobs to save roll paper on page 82).

Protect a paper type
You can protect selected paper types to avoid printing on them unintentionally. A protected paper type will be 
printed on only when the paper type is explicitly specified in the job.

NOTE: This is for multifunction roll (accessory) only.

To protect a paper type, go to the front panel and tap the Settings  icon , then Job management > Roll policies 
> Protected paper types, then select the paper type that you want to protect.

When a paper type is protected, the Protected  icon  appears before the paper name.
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To print on a protected paper category, just select the paper type explicitly when submitting the job from a printer 
driver or other job submission software.

NOTE: If a protected paper type is not explicitly selected, and no other paper types are available, an out-of-
paper message will appear.

Unattended printing/overnight printing
The printer is well suited to long, unattended print jobs, having multiple rolls plus robust and consistent image 
quality.

NOTE: Multifunction roll (accessory) only.

Here are some recommendations to help you deal with a long queue of printing jobs.

● If feasible, use brand-new long rolls of paper.

● If you want to print on partly-used rolls, you can check the paper type and the remaining length in the 
Embedded Web Server or in the front panel, to confirm that you have enough paper to print all your jobs.

NOTE: Information on the remaining length is available only if you told the printer the length of the roll 
when you loaded it, or if the printer read the length of the roll from the barcode printed on it.

● Load two rolls of paper suitable for your jobs. If the printer finishes one roll, it will automatically switch to the 
other.

● HP recommends the use of papers approved for your printer. See How to order supplies and accessories on 
page 148

● Check that you have paper wide enough to print all of your jobs. Any jobs that are too wide may be put on 
hold for paper if the paper mismatch action is set to Pause and ask (see Solve paper mismatch on page 90).

● Check the ink levels remaining in your HP Eco-Carton ink cartridges.

● When you have submitted your print jobs, you can use the Embedded Web Server from a remote location to 
monitor their status.

● Drying time should be set to Optimal.

● Tap the Settings  icon , then Job management > Roll policies > Use most depleted roll > On.

We recommend the following settings, depending on the paper type and what kind of prints you are making.

Table 6-1 Recommended settings for unattended printing

Print type Print mode Maximum detail Drying time Paper types

Lines Normal Off Optimal Coated, Bond, Heavyweight 
Coated, Glossy

Lines and fills Normal Off Optimal Coated, Bond, Heavyweight 
Coated, Glossy

Maps Best Off Optimal Coated, Heavyweight Coated, 
Glossy

Renderings, photographs Best Off Optimal Coated, Heavyweight Coated, 
Glossy
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Print from other software solutions
Each solution has specific requirements.

● HP Click is an easy-to-use tool designed for people who want a simple way of printing on large format 
printers.

Ideal for a broad range of graphics and technical applications, including posters, roll-up banners, info-graphic 
presentations, maps, and CAD documents. For more information see the HP website at the following link: 
http://www.hp.com/go/clickDesignJet.

● RIPs: You need to identify a suitable workflow solution for the printer

For a complete list of certified solutions available for this printer, see the HP website at the 
following links: https://www8.hp.com/us/en/large-format-printers/designjet-printers/workflow-solutions.html, 
and https://www8.hp.com/us/en/large-format-printers/designjet-printers/zseries-rips.html.

Make sure that the station is fully functional and ready for installation.
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Job queue management7

Job queue in the front panel
Tap the Jobs  icon  on the home screen to view the job queue on the front panel.

The print queue includes jobs that are being received, parsed, rendered, printed, already printed, and so on.

Tap the name of the job to see all the job details, including information about status, pages, copies, total, and 
preview.

In an active queue, the job you are printing appears at the top of the queue. You can scroll up and down. Once 
scrolled, the printed job will move to always appear at the top.

Jobs are divided into 5 categories, you can see the status in the column on the right-hand side.

● History: Always appears.
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● On hold: Appears when 1 or more jobs are on hold.

● Now printing:

– When printing 1 job, nothing else appears.

– When 1 job is printing and 1 is being prepared.

● Up next: When 1 job is printing and another 1 pending.

● Nesting: When activated, a section with nested jobs and a counter appear.

Job queue actions
Some of the actions in the job queue are determined by the settings selected. Some default settings may be 
worth changing, depending on your environment. To do so, tap the Settings  icon  in the home screen, then 
Job management . Alternatively, in the job queue app, tap the Ellipsis  icon  at the top right, then Settings.

Pause the job queue
You can pause the job queue by tapping the Pause  icon  and resume by tapping the Play  icon . The pause 
takes effect at the end of the page that is currently printing.

Reprint
In the History section, tap the job you want to reprint. On the details screen, tap the Printer button. On the next 
screen, you can select the number of copies, the source, and the destination.

Print next
If you want to change the position of a job in the queue to be printed immediately after the currently printing job, 
select the desired job and tap the Print next button.

Select when to print a job

You can select at what point you want to print a job in the queue. Tap the Settings  icon , then Job 
management > When to start printing.

NOTE: The When To Start Printing options cannot be used with PostScript jobs.
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There are three options you can select:

● When After Processing is selected, the printer waits until the whole page has been processed and then it 
starts to print. This is the slowest setting but ensures the best print quality in large or complex prints.

● When Immediately is selected, the printer prints the page as it is processed. This is the quickest setting, but 
the printer may stop halfway through a print to process data. This setting is not recommended for complex 
images with dense color.

● When Optimized is selected (this is the default setting), the printer calculates the best time to begin printing 
the page. It is usually the best compromise between the After Processing and Immediately settings.

See job details
Tap the name of the job to show its details, including information about status, pages, copies, total, and preview. 
Scroll down as necessary to see all of the information.

By tapping the thumbnail, you can navigate over all pages of the job. Tap the Spanner icon  to show or hide the 
toolbar. From there you can zoom in and out and see more information about each page.

In an active queue, the job you are printing always appears at the top of the queue.

Roll policies
If two rolls are loaded, both of which are suitable for the job, the roll is chosen according to your preferences.

At the front panel, tap the Jobs  icon , the Ellipsis  icon , then the small Settings  icon .

Alternatively, tap the Settings  icon , then Job management > Roll policies.

● Increase productivity: To increase the productivity of the printer.

– Job autorotation: The printer can rotate a job automatically in order to save paper.

● Automatic roll selection: When the job arrives with the roll not defined, the printer selects the rolls according 
to the following settings.

– Roll width selection: The printer can be more or less restrictive when selecting the roll width on which to 
print. You can select to print on the same width only (each page prints on a roll with same width as the 
page) or to print on the same width or wider (each page prints on roll with same width as the page or 
wider).

– Avoid printing on a wider roll: Avoid switching to a wider roll when the defined rolls are depleted. Only 
applies when Roll width selection is Print on same width or wider.

See also Protect a paper type on page 85.

Solve paper mismatch
If the paper currently loaded in the printer is not suitable for a particular job or page, the printer can automatically 
solve the conflict or give a number of choices depending on the printer policies.

Such a conflict may be caused by a job sent to the printer with no specific roll or paper type assigned to it, or by 
a roll coming to its end during printing. The following options are available in the paper mismatch settings menu; 
you can reach this menu from the job queue by tapping the Ellipsis  icon , then the small Settings  icon , 
then Mismatch actions  > Paper mismatch ; or by tapping the Settings  icon , then Job management > 
Mismatch actions > Paper mismatch.
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● Pause and ask (the most restrictive option): Printing stops until the correct paper is loaded. This option is 
recommended when the printer is attended. A message appears, asking what you want to do: cancel the job, 
print anyway, put on hold, or load paper. These options are also available in the job queue.

● Hold job and continue with next: Put mismatched jobs on hold until the correct paper is loaded, and continue 
printing the rest of the job queue. The printer sends an alert whenever a job is put on hold. This option 
is recommended when the printer is unattended, even though the integrity of a job may be disrupted, to 
avoid stopping the queue. Once the paper required for the job is loaded, the job or pages are automatically 
resumed.

● Print anyway (the least restrictive option): Print on whatever paper is loaded. The printer will choose the 
roll to print according to the following criteria: first where the page fits and then the same paper type. This 
option will never select a paper type that has been protected.

Solve output mismatch
The selected output for a particular job is not available for some reason: output disconnected, detached, full, not 
empty for a job that requires it to be empty, or size/type/length not supported by that output.

NOTE: This is for multifunction roll (accessory) only.

The following options are available in the paper mismatch settings menu; you can reach this menu by tapping the 
Jobs  icon , then the small Settings  icon , then Mismatch actions ; or by tapping the Settings  icon , then 
Job management > Mismatch actions > Output mismatch.

● Pause and ask: Printing stops until the correct output is available. This option is recommended when the 
printer is attended. A message will appear asking what you want to do: cancel the job, print anyway, put on 
hold, or load paper.

● Hold job and continue with next: Put mismatched jobs on hold until the correct output is available, and 
continue printing the rest of the job queue. The printer sends an alert whenever a job is put on hold. This 
option is recommended when the printer is unattended, to avoid stopping the queue.

Job queue options
To change the job queue options, tap the Settings  icon , then Job management > Job queue.

You can select:

● Activate/deactivate jobs queue

● Maximum number of jobs in history

● Delete history
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● When to delete jobs on hold (hours)

● Job queue recovery mode

Default printing preferences
At the front panel, tap the Settings  icon , then Default Printing configuration to define the default properties 
of jobs sent to your printer from remote locations.

You can define settings in the following areas: Print quality, Color, Paper, Margins, HP-GL/2, PostScript, Print 
retrieval, Graphics language, Minimum line weight, Cutter.

Job deletion
If the printer runs out of storage space for new jobs, the oldest printed jobs are automatically deleted from the 
queue.

You can request that printed jobs should be automatically deleted from the queue when the total number of 
printed jobs exceeds a specified limit (the maximum number in the history setting), or when the jobs were printed 
more than a specified time ago (clear history settings).

To delete jobs on hold, the setting Delete jobs on hold allows you to define the time after which these jobs will be 
removed (2–48 h).

To delete a job manually, select the job and tap Delete  in the Ellipsis   menu. To delete all jobs, tap Delete all 
jobs  in the Ellipsis  icon  menu; the whole job queue will be deleted.

The Delete option deletes the job from the queue, while the Cancel option cancels the job but leaves it in the 
queue, marked as Canceled by the user in the history category.

To cancel a job while printing, tap X. To cancel a job from the Up Next category, tap the job name on the list and 
then tap Cancel job on the bottom right.

NOTE: If you tap X, you cancel the currently printing job only.

Job queue in the Embedded Web Server
To see the queue in the Embedded Web Server, select the Main menu, then Job queue. You can perform the 
following operations per each job in the queue:

Job queue page
By default, access to the job queue is open to all users. An administrator can set a password so that users are 
required to enter a password to access the page.

The job queue page shows all jobs that are available in the print queue. The print queue includes jobs that are 
being received, parsed, rendered, printed and already printed.

The Embedded Web Server displays the following information for each print job:

● File name: The name of the job

● Status: The current status of the job

● Pages: The number of pages in the job

● Copies: The number of copies printed
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● Total: The total number of pages (including copies)

● Sent by: The username

● Account ID: The account ID for the job

● Date: The date and time attached to the job that was received by the printer, shown in the locale of the 
Embedded Web Server

● File source: The application from which the job was sent to print

● Paper destination: The output option selected for the printed job

Jobs in the queue can be sorted by any of the information items (except Preview) by clicking on the title of the 
corresponding column. You can perform the following operations on one or all jobs in the queue:

● Cancel job: Cancels the selected jobs. You are asked to confirm before the job is canceled. The job remains 
stored in the printer, but will not be printed unless you click Reprint.

● Hold: Holds the selected jobs until you click Continue on the front panel to print.

● Reprint: Prints more copies of a job.

● Print next: Sends all selected jobs to the top of the job queue.

● Print anyway: The printer will try to print the job even if there is some problem with it.

● Delete: Deletes selected jobs from the job queue. You are asked to confirm before the job is deleted.

● Release: To release private jobs.

Pause the job queue
You can pause the job queue by tapping and resume by tapping. The pause takes effect at the end of the page 
that is currently printing.

Delete all
You can delete all jobs (and history) at the same time.

Prioritize a job in the queue
You can select any job in the queue and make it the next one to be printed. After selecting the job, tap Print next.

If nesting is turned on, the prioritized job may still be nested with others. If you want this job to be printed next, 
without waiting to finish the nesting countdown, click the Print next button in the nesting section.

In the following cases, the Print next button is not displayed:

● The job is already at the front of the queue.

● The job is on hold—in this case the Resume printing button is displayed instead.

● The job has finished—in this case the Reprint button is displayed instead.

● The job has some error condition.
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Delete a job from the queue
Under normal circumstances, there is no need to delete a job from the queue after printing it, as it will just fall off 
the end of the queue as more files are sent. However, if you have sent a file in error, and want to avoid printing it, 
you can simply select the job and then click Delete.

In the same way, you can delete a job that has not been printed yet.

If the job is currently being printed (its status is printing), you can click Cancel and then Delete.

Reprint a job in the queue
To reprint an already-printed job, select the job from the queue, then click Reprint. When reprinting a print job, 
you cannot change the print settings, because the job has already been rasterized.

Job status messages
There is a list of possible job status messages that appear.

Approximately in the order in which they may be seen:

● Downloading: The printer is receiving the job from the computer.

● Processing: The printer is parsing and rendering the job.

● Waiting to print: The job is waiting for the print engine to become free to proceed with printing.

● Nested: The printer is set up with Nesting=On and is waiting for other jobs in order to complete the nest and 
proceed with printing.

● Preparing to print: The printer is performing writing system checks before printing the job.

● On hold for preview: The job was sent with the on hold for preview option.

NOTE: If the printer hangs up while printing a job, and the queue facility is turned on, the partially printed 
job will appear in the queue as on hold when the printer is next turned on. When you resume the job, it will 
start printing at the page at which it was interrupted.

● On hold for paper: The job cannot be printed because the right paper is not loaded in the printer. Load the 
required paper, see Paper handling on page 23, and click Continue to resume the job.

● On hold for accounting: The job cannot be printed because the printer requires all jobs to have an account ID: 
enter the account ID and then click Continue to resume the job.

TIP: To set an account ID, see Required account ID on page 70.

● Printing

● Drying

● Cutting paper

● Ejecting page

● Canceling: The job is being canceled, but will remain in the printer job queue.

● Deleting: The job is being deleted from the printer.

● Printed
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● Canceled: The job has been canceled by the printer.

● Canceled by user

● Empty job: The job does not contain anything to print.

● On hold for manual release

● On hold for recovered job

● On hold for stacker open

● On hold for attended mode

Reactivate a job on hold
When the printer puts a job on hold you receive an alert.

See Alerts on page 204, which explains why the job is on hold. Follow the instructions on the screen to remove 
the hold and continue printing.
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Color management8

Introduction
Color management is performed using a set of software tools that allow you to reproduce a color as accurately 
as possible on any display or printing device.

In addition, your printer has been engineered with advanced hardware and software features to ensure 
predictable and dependable results.

● Color calibration for consistent colors

● The Photo Black ink provides pure blacks when printing on photo papers

How colors are represented
Color is usually represented as an array of numbers: three numbers in the RGB color model or four in the CMYK 
color model. These numbers are a measure of the base colors used in a mixture to create a given color.

RGB means that we are using a mixture of Red, Green, and Blue to create any specific color. In the case of CMYK, 
the mixture is of Cyan, Magenta, Yellow, and Key (where Key means black, for historical reasons).

Most monitors use the RGB color model, while most printers use the CMYK color model.

An image can be converted from one color model to another, but in general the conversion is not perfect. Your 
printer uses the RGB color model: the same color model that is used by your monitor.

This simplifies but does not completely solve the problem of matching colors. Each device represents colors 
a little differently from another device, even if they use the same color model. However, color management 
software can adjust the colors in an image according to the characteristics of the particular device, using a color 
profile of the device, in order to achieve correct colors.

A summary of the color management process
To get the accurate and consistent colors that you want, you should follow the recommended steps for each 
paper type that you use.

Follow these steps:

1. Color-calibrate the paper type, for consistent colors. Calibration should be repeated every now and then 
(see Color calibration on page 96). In addition, you may wish to calibrate immediately before a particularly 
important print job for which color consistency is vital.

2. When printing, select the correct paper preset for the paper type you are using. The paper preset contains 
the color profile as well as various other characteristics of the paper. See Paper presets on page 44.

Color calibration
Color calibration enables your printer to produce consistent colors with the particular printheads, inks and paper 
type that you are using, and under your particular environmental conditions. After color calibration, you can 
expect to get similar prints from any two different printers situated in different geographical locations.
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Some paper types cannot be calibrated. For all other paper types, calibration should be done in any of the 
following circumstances:

● Whenever a printhead is replaced

● Whenever a new paper type is introduced that has not yet been calibrated with the current set of printheads

● Whenever the environmental conditions (temperature and humidity) change significantly

You can check the color calibration status of the currently loaded paper at any time by going to the front panel 
and tapping the Optimize  quality icon , then the Ellipsis  icon , then Color calibration status. The status 
may be one of the following:

● Pending: The paper has not been calibrated.

NOTE: Whenever you update the printer's firmware, the color calibration status of all papers is reset to 
Pending.

● Obsolete: The paper has been calibrated, but the calibration is now out of date because a printhead has been 
replaced, and should be repeated.

● Done: The paper has been calibrated, and the calibration is up to date.

● Not available: This paper cannot be calibrated.

NOTE: Color calibration cannot be performed on plain paper, nor on any kind of transparent material.

You can start color calibration in the following ways:

● From the front panel: Tap the Optimize  quality icon , then Color calibration.

● From Embedded Web Server: select Color > Optimize print quality > Color calibration.

The calibration process is fully automatic and can be performed unattended after you have loaded paper of the 
type you wish to calibrate—which should be wider than:

● HP DesignJet Z6 Pro: Minimum 420mm (16,54 in).

● HP DesignJet Z9+ Pro: Minimum 508mm (20 in).

If you have more than one roll loaded, the printer will ask which roll you want to use for the calibration.

The process takes about 10 minutes and consists of the following steps.

1. A calibration chart is printed, which contains patches of each ink used in your printer.

Figure 8-1 Z6 Pro example chart
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Figure 8-2 Z9+ Pro example chart

2. The chart is allowed to dry for a period of time that depends on the paper type, so that the colors have time 
to stabilize.

3. The chart is scanned and measured.

4. From the measurements, the printer calculates the necessary correction factors to apply for consistent 
color printing on that paper type. It also calculates the maximum amount of each ink that can be applied to 
the paper.

Color profiling
Color calibration provides consistent colors, but consistent colors are not necessarily accurate. For instance, if 
your printer prints all colors as black, its colors may be consistent but they are not accurate.

In order to print accurate colors, it is necessary to convert the color values in your files to the color values that will 
produce the correct colors from your printer, your inks, and your paper. An ICC color profile is a description of a 
printer, ink, and paper combination that contains all the information needed for these color conversions.

Create your own profile (Z9+ Pro only)
You can create a color profile easily using the Embedded Web Server. The process takes about 15–20 minutes.

NOTE: This process is only available for the Z9+ Pro which has an embedded spectrophotometer.

Follow these steps:

1. Load paper into the printer: see Load a roll into the printer on page 31. You will find the paper name in the 
paper or custom paper category in the front panel and Embedded Web Server. If you cannot find the paper 
name, you can create your own paper preset: see Paper presets on page 44.

IMPORTANT: When loading the paper, make sure to select the correct paper type. Loading the paper with 
an incorrect paper type specified could cause errors in the profile.

NOTE: The paper must be calibrated before profiling.

NOTE: Not all custom paper can be profiled.

2. In the front panel, select Add new media and follow the steps to calibrate the current paper. Alternatively 
you can directly access Profiling from the Embedded Web Server, select Optimize print quality > Profiling. 
Calibration will be carried out on the loaded rolls.
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3. Select the options for the print mode to be calibrated.

4. A profiling chart is printed. Unlike a calibration chart, most of the patches contain combinations of more 
than one ink. The printer automatically chooses the profiling chart for the paper size loaded.

Figure 8-3 A roll-paper format that minimizes paper use by printing across the full width of the roll

5. The chart is allowed to dry for a period of time that depends on the paper type, so that the colors have time 
to stabilize.

6. The chart is scanned, and measured by the HP Embedded Spectrophotometer.

7. From the measurements made by the spectrophotometer, the printer calculates the ICC profile for your 
printer, inks, and paper type.

8. The profile is stored in the printer, so that other computers connected to the same printer can copy it with 
the Export and Import an ICC profile options in the Embedded Web Server. See Export a color profile on 
page 99 and Install a color profile on page 99 for more information.

NOTE: Some applications may need to be closed and restarted in order to use a profile that has just been 
created.

Install a color profile
If you have obtained an ICC profile through the Internet or from a third-party profiling software package, you can 
still install it for use with your printer and paper.

1. From the Embedded Web Server, go to Paper menu > Paper management > Import ICC profile.

2. Select the paper type, select the options that you will use with the ICC profile, and click the Import  icon  at 
the bottom of the dialog box.

3. Select the file containing the ICC profile.

NOTE: ICC profile file names have the extension ".icc" (for International Color Consortium) or ".icm" (for 
Image Color Matching).

4. Check the ICC profile name, then click Next.

5. The ICC profile is installed in your computer and will be available to use in your applications.

Export a color profile
An ICC profile associated with a paper type can be exported, enabling it to be used on a different printer or with a 
different paper preset.

1. From the Embedded Web Server, go to Paper menu > Paper management > Export ICC profile.

2. Select the paper type and the ICC profile to be exported, then click the Export  icon  at the bottom of the 
window.

3. Choose the pathname of the folder in which the ICC profile will be saved in your computer.

4. The ICC profile file is saved in the specified folder.
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Restore an original color profile
The ICC profile settings in a paper preset can be restored to their original values. This will remove any ICC profile 
that you have associated with the selected paper and restore the default ICC profile provided by HP.

1. From the Embedded Web Server, go to ICC profile management > Import/Restore ICC profile.

2. Select the paper type whose ICC profile you want to restore. Click Restore.

Color management from printer drivers

Color management options
The aim of color management is to reproduce colors as accurately as possible on all devices: so that, when you 
print an image, you see very similar colors as when you view the same image on your monitor.

There are two basic approaches to color management for your printer:

● Printer-Managed Colors: In this case your application program sends your image to the printer without any 
color conversion, and the printer converts the colors to its own color space. The details of this process 
depend on the graphics language that you are using. HP recommends this setting for the best experience 
and results.

– PostScript: The PostScript and PDF interpreter modules perform the color conversion using the profiles 
stored in the printer and any additional profiles sent with the PostScript job. This kind of color 
management is done when you are using the PostScript or PDF driver.

– Non-PostScript (PCL3): The color management is done using a set of stored color tables. ICC profiles are 
not used. This method is somewhat less versatile than the alternatives, but is a little simpler and faster, 
and can produce good results with standard HP paper types.

NOTE: In non-PostScript printing, the printer can convert to sRGB if you are using Windows, or to 
Adobe RGB if you are using macOS.

● Application-Managed Colors: In this case your application program must convert the colors of your image 
to the color space of your printer and paper type, using the ICC profile embedded in the image and the ICC 
profile of your printer and paper type. To use this option, your printer’s ICC profiles must be installed in your 
computer.

IMPORTANT: Make sure to select matching settings in the driver and in the application.

You are recommended to consult the HP Support Center (see HP Support Center on page 207) to see how to use 
the color management options of your particular application. See also Print a document with the correct colors 
on page 108.

To choose between Application-Managed Colors and Printer-Managed Colors:

● In the Windows driver dialog: Select the Color tab.

● In the macOS Print dialog: Select the Color Matching panel. Vendor Matching or In Printer corresponds to 
Printer-Managed Colors mode. ColorSync should be used only if you cannot choose Application-Managed 
Colors in your application print dialog.

● In some applications: You can make this choice in the application.
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Color options

Printing in color
The printer prints in color by default.

You can select color printing explicitly in the following ways:

● In your application program: Many programs provide this option.

● In the Windows driver dialog: Go to the Color tab and look at the Output Color or Color Options section 
(whichever is available in your driver). Select Print in color.

● In the macOS Print dialog: Go to the Color Options panel and select Color from the Mode drop-down list.

Printing in grayscale
You can easily convert all colors in your image to shades of gray.

Choose one of the following ways:

● In your application program: Many programs provide this option.

● In the Windows driver dialog: Go to the Color tab and look at the Output Color or Color Options section 
(whichever is available in your driver). Select Print in grayscale.

● In the macOS Print dialog: Go to the Color Options panel and select Grayscale from the Mode drop-down list.

HP Professional PANTONE Emulation
When you use a named PANTONE color in an image, your application will normally send to the printer a CMYK or 
RGB approximation to that color.

The application does not take the printer or the paper type into account, it merely produces a generic 
approximation of the PANTONE color, which will look different on different printers and on different papers.

HP Professional PANTONE Emulation can do a much better job by taking into account the characteristics of the 
printer and the paper type. The results look as similar to the original PANTONE colors as is possible on a given 
printer using a given paper type. This technology is designed to produce emulations similar to those set up 
manually by prepress professionals.

To use HP Professional PANTONE Emulation, all you have to do is to turn it on. In fact, it is normally on by default.

● In the Windows PostScript/PDF driver dialog: Go to the Color tab and select HP Professional PANTONE 
Emulation.

● In the macOS Print dialog: Go to the Color Options panel and select HP Professional PANTONE Emulation.

● From the front panel: Tap the Settings  icon , then Default printing configuration > Color options > 
HP Pantone Emulation.

HP Professional PANTONE Emulation not only provides the closest match that can be achieved on your printer; it 
also gives clear information on how close the emulation is to the original spot color.

PANTONE emulation in the Embedded Web Server
The HP Professional Pantone Emulation page allows the user to navigate through several PANTONE formulas 
using tabs. Inside these tabs, you can select whichever strips you want and then print them.
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The page shows all the available PANTONE formulas in named tabs. Inside each tab, a virtual repeater holds all 
the strips, represented by several elements: a checkbox to select the strip, the strip colors with the name, and the 
name of the strip at the bottom. When you select at least one strip, the Print button is enabled.

When you click the Print button, a pop-up opens that lets you select the type of paper that will be used to print 
the selected PANTONE strips, and review the selected strips.
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The paper-source drop-down list shows first the papers that are already loaded in any of the in-trays, then the 
rest of the available papers. If you select a paper that is not already loaded, the job will be held in the printer until 
the paper is loaded.

The Print button is not enabled until you select a paper from the paper-source drop-down list.
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Default color spaces
When a document or image does not specify the working color space in which the content is originally described, 
the user can choose among different standards. That is, the user can determine how data should be interpreted 
by the color management system during the rendering process.

You can set source profiles in the following ways:

● In the Windows PostScript/PDF driver dialog: Select the Color tab, and Printer Managed Colors.

● In the macOS Print dialog: Select the Color Option panel, then select Adobe RGB or SRGB as the source 
profile.

The standard way of encapsulating such information is in ICC profiles. As part of the solution, we provide the 
most common standards for the different devices.

The options are as follows.

Default RGB source profiles
Your printer is provided with a selection of color profiles to choose from.

● None (Native): For use when the color conversion is done by the application or operating system, and 
therefore the data arrive at the printer already color-managed. Available for PostScript and PDF drivers only.

● sRGB IEC61966-2.1 is the standard followed by typical PC monitors. This standard space is endorsed by 
many hardware and software manufacturers, and is becoming the default color space for many scanners, 
printers, and software applications.

● Adobe RGB (1998) provides a fairly large gamut of RGB colors. Use this space if you need to do print 
production work with a broad range of colors.

Default CMYK source profiles
You can choose from a selection of CMYK source profiles recognized by the printer. The default CMYK profile is ISO 
Coated V2 (ECI), available for PostScript and PDF drivers only.
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Color management from the front panel
You can color-calibrate the loaded paper type.

From the front panel by tapping the Optimize quality  icon , then Color calibration. See Color calibration on 
page 96.

The other color options in the front panel can all be found by tapping the Settings  icon , then Default printing 
configuration > Color options (they can also be found under Minimum line weight).

NOTE: If color options are set in the driver, they override the front-panel settings.

All jobs

● Color

● Grayscale

● Select RGB source profile: You can choose from a selection of RGB source profiles recognized by the printer. 
Default: sRGB IEC 1966-2.1.

PostScript and PDF jobs only

● Select CMYK source profile: You can choose from a selection of CMYK source profiles recognized by the 
printer. Default: Coated FOGRA39 (ISO 12647-2:2004).

● Select rendering intent: You can select the rendering intent. Default: Perceptual.

● Black point compensation: You can turn black point compensation on or off. Default: On.

● HP Professional PANTONE Emulation: You can turn HP Professional PANTONE Emulation on or off. Default: 
On.
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Practical printing examples9

Print a draft for revision with the correct scale
This section demonstrates how to print a draft for revision with the correct scale from Adobe Acrobat.

Using Adobe Acrobat
Printing at the scale and quality you choose is a quick and simple process.

1. In the Acrobat window, bring the mouse cursor to the bottom left corner of the document pane to check the 
page size.

2. Select File > Print and ensure that Page Sizing & Handling is set to Actual size.

NOTE: The page size will not be automatically selected according to the drawing size.

3. Click the Properties button and then select the Paper/Quality tab.

4. Choose whatever Document Size and Print Quality you want to use. If you want to define a new custom 
paper size, click the Custom button.

5. Select the Layout/Output or Layout tab (depending on the driver version), then Autorotate.

6. Click OK, and check that the print preview in the Print dialog box seems correct.
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Print a PDF multipage job from Adobe Acrobat Reader or Adobe 
Acrobat Pro

Using a raster driver
Open a multipage job in Adobe Acrobat Reader or Adobe Acrobat Pro (HP recommends always using the latest 
version).

1. Click File > Print.

2. Select the printer and driver.

3. Check the Choose paper source by PDF page size box.

4. Adjust other properties in the driver properties window, as required.

5. Click the Print button.

The pages will be printed on the standard page size closest to the page size in the original document.

Using a PostScript driver
Open a multipage job in Adobe Acrobat Reader or Adobe Acrobat Pro (HP recommends always using the latest 
version).

1. Click File > Print.

2. Select the printer and driver.
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3. Check the Choose paper source by PDF page size and Use custom paper size when needed boxes.

4. Adjust other properties in the driver properties window, as required.

5. Click the Print button.

If you checked the Use custom paper size when needed box, the pages will be printed on paper sizes 
corresponding to the page sizes in the original document.

Using a PDF driver
With the latest versions of Adobe Acrobat Pro or Adobe Acrobat Reader, this is managed by the application, and 
the pages will be printed on paper sizes corresponding to the page sizes in the original document.

Print a document with the correct colors
Learn how to print a document from Adobe Acrobat and Adobe Photoshop, with the emphasis on color 
management.

Using Adobe Acrobat Reader
Printing is very simple. Acrobat Reader is the most basic application for PDF files; several color management 
tools common in more sophisticated applications are not explicitly present, and work by default with presets that 
cannot be changed.

For example, there is no way to select a working color space; a default color space, most likely sRGB, is applied. 
This color space is used for screen display, for example. Also, as an alternative color profile when no other is 
specified by a file, as will be explained later.
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1. Click File > Print.

2. Select the printer and driver from the Printer drop-down menu in the Print dialog box. Driver settings can be 
adjusted by clicking the Properties button.

3. Adjust the color settings in the driver properties window. Click the Properties button in the Print dialog and 
set the Color option in the Color tab. If you have a V4 driver, check the box Printer Managed Colors, and 
select the most convenient source profile. Click OK.

4. If you have a V3 driver, click the Advanced button in the Print dialog box to set color management options. 
Check the box Let printer determine colors.

NOTE: If you are using the PDF driver, you can skip this step.

5. If the document contains several color profiles and you are not sure what the result will be, you can flatten 
the document first and print it as seen on the screen. To do this, check the box Print As Image in the 
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Advanced Print Setup dialog box. In this case, the rasterization is performed by Acrobat Reader before 
calling the driver; whereas, if you do not check this box, the rasterization is performed by the driver. So 
checking the box may have a visible effect on the look of the printed document.

Using Adobe Acrobat Pro
Acrobat Pro is a professional application that allows full color management. This section briefly describes the 
options to select a working color space, convert images to a desired color space, and print.

1. PDF files may not contain a color profile. In the absence of a color profile, Acrobat uses a working color 
space by default. To choose a working color space, first click Edit > Preferences.

2. In the Preferences dialog box, you can choose RGB, CMYK, and grayscale working color spaces.

3. PDF files can contain elements with different color profiles. Some may have color profiles, some may not. 
The working color space will affect only those without a color profile. If you want to attach a specific color 

110 Chapter 9  Practical printing examples



profile to the document, you must convert the contents of the document as follows. First, select Convert 
Colors from View > Tools > Print Production or by clicking the icon in the status bar.

4. Select the elements you want to convert by specifying matching criteria (object type and/or color type) and 
then the conversion attributes. If you want to change the embedded color profile, you can select Any Object 
and Any Colorspace in the Matching Criteria section. In the Conversion Attributes section you can choose, 
for example, to embed an Adobe RGB (1998) profile by selecting it as the Conversion Profile, checking the 
Embed box, clicking the OK button, and saving the file to keep the changes. The saved file will have an 
embedded Adobe RGB color profile.

5. To print the document, choose a printer from the Print dialog box, click the Properties button, and set the 
color options in the Color tab.

IMPORTANT: Select Print in color and Printer managed colors.

If you have the V4 driver, you can also select a default color profile, which will be used for any elements that 
lack a color profile. HP suggests:

● RGB

● CMYK: Choose Coated FOGRA39 or US Web Coated (SWOP) v2.
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6. If you have the V3 driver, click the Advanced button in the Print dialog box, set Color Handling to Printer 
Color Management, and click OK.

NOTE: If you are using the PDF driver, you can skip this step.

7. In the Print dialog box, click the Print button to print the document.

Using Adobe Photoshop
In Photoshop, click File > Print, then select your printer.

1. In the Color Management section, set the Color Handling option to Printer Manages Colors.

2. In the driver’s Color tab, ensure that the color management option is Printer managed colors. This is the 
correct option because you have already selected Printer Manages Colors in Photoshop.
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Print a project
This section demonstrates how to print a project from AutoCAD.

Using Autodesk AutoCAD
The AutoCAD window can show a model or layout.

1. Normally a layout is printed rather than the model.

2. Click the Plot icon at the top of the window.

3. The Plot window opens.

4. You can see further options by clicking the circular button in the lower right corner of the window.
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NOTE: The Quality option here does not refer to the final print quality but to the quality of AutoCAD 
viewport objects that are sent for printing.

5. Select your printer and click the Properties button.

6. Select the Device and Document Settings tab, and click the Custom Properties button.

7. In the Paper/Quality or Paper tab (depending on the driver version), select the paper type that you intend to 
use.

NOTE: If you select neither the paper source nor the paper type, the printer will not print on any protected 
roll (see Protect a paper type on page 85).

8. Select the print quality (your own choice between speed and quality of printing).

9. If you intend to print on roll paper, you must decide where the printer should cut the paper.

● With the Windows V3 driver: Select the Paper/Quality tab, then click the Margins/Cutter Settings button, 
then Clip content by margins.

● With the Windows V4 driver: Select the Layout tab, then in the Layout Mode area click With margins > 
Clip content by margins.

You can also adjust the crop lines, which indicate where to cut the paper after printing. See Print with crop 
lines on page 81.

10. Select the Layout/Output tab, then select the Autorotate option. Autorotation can help to avoid wasting 
paper.

11. Click the OK button and save your configuration changes to a PC3 file.
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12. When you have clicked the OK button in the Plot window, the printer will construct a print preview.

Using clip contents by margins
You can select this margins option from Advanced settings > Paper > Layout/Margins > Print with margins > 
Layout > Clip contents by margins.

Use this option when the contents to be printed have white borders and a size equal to that of the paper you 
have selected. The printer will use the white border for its margins and you will get a page of size equal to that 
which is selected in the driver.

Print a presentation
This section demonstrates how to print a presentation from AutoCAD and from Photoshop.

Using Autodesk AutoCAD
You can print a layout with Autodesk AutoCAD.

1. Open the AutoCAD file and select a layout.

2. Click the Plot icon at the top of the window.

3. Ensure that the correct printer is selected, then click the Properties button.
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4. Select the Device and Document Settings tab, and click the Custom Properties button.

5. In the Paper/Quality tab, select the paper type that you intend to use.

NOTE: If you select neither the paper source nor the paper type, the printer will not print on any protected 
roll (see Protect a paper type on page 85).

6. Select the print quality (your own choice between speed and quality of printing).

7. If you intend to print on roll paper, you must decide where the printer should cut the paper.

● With the Windows V3 driver: Select the Paper/Quality tab, then click the Margins/Cutter Settings button, 
then Clip content by margins.

● With the Windows V4 driver: Select the Layout tab, then in the Layout Mode area click With margins > 
Clip content by margins.

Using Adobe Photoshop
Click File > Print and then select your printer.

1. Click Print settings, then select the Paper/quality tab.

2. Choose from the available paper sizes.

If you do not find the paper size that you intend to use, click the Custom button. Enter the width, the length 
and the name of your custom paper size. Click the Save and OK buttons.
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3. Select Show preview before printing. You may also wish to change the default paper source, paper type and 
print quality.

4. In the Color tab, the default color management option is Printer managed colors, and this is the correct 
option because you have already selected Printer Manages Colors in Photoshop.

Print and scale from Microsoft Office
With the scale options you can scale documents to print at a particular size.

Using Microsoft PowerPoint
Scale a job to fit your page size and clip content by margins.

1. Click File > Print, and select the name of your printer.

2. Click Printer properties > Layout/Output > Resizing options to scale the document to a particular size.

3. Select the Paper/Quality tab, then select Paper Source and Paper Type.

4. Depending on your driver version:

● With the Windows V3 driver: Select the Paper/Quality tab, then click the Margins/Cutter Settings button, 
then Clip content by margins.

● With the Windows V4 driver: Select the Layout tab, then in the Layout Mode area click With margins > 
Clip content by margins.

Print and scale from Microsoft Office 117



Using Microsoft Project
Use the proper scale option to scale a document to a particular size.

1. Click File > Print.

2. Select your printer's name.

3. In the Settings section, you can choose the pages to print, the orientation, and the paper size.

4. Click Page Setup to choose the Paper Size you want.
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5. Select Options to go to the printer driver.

The default options in the Paper/Quality tab are probably suitable: Paper source: Use printer settings and 
Paper Type: Use Printer Settings.

6. Click Layout/Output > Resizing options to scale the document to a particular size. Alternatively, you can 
scale the document in Project.

Using Microsoft Excel
Scale a document to fit to any size with ease.

1. Click File > Print. Select your printer's name, then click the back arrow to leave the File menu.

2. Select the Page Layout tab, then Size, and choose the paper size you want.

3. Click File > Print > Printer properties to go to the printer driver. In the Paper/Quality tab, select Paper source, 
Paper Type and Print Quality.

4. Click Layout/Output > Resizing options to scale the document to a particular size. Alternatively, you can 
scale the document in Excel.
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Retrieving printer usage information10

Get printer accounting information
There are different ways to get accounting information from your printer.

● View printer usage statistics for the whole lifetime of the printer, see Check usage statistics on page 120.

● View ink and paper usage for each of your recent jobs, see Check usage statistics for a job on page 123.

● Use a third-party application to request printer status, printer usage or job accounting data from the printer 
through the Internet. The printer provides data in XML to the application whenever requested. HP provides a 
Software Development Kit to facilitate the development of such applications.

Check usage statistics

Check usage from the front panel

Tap the Usage  icon  on the front panel to display the usage information.

The following information can be retrieved:

● In the tab Print categories usage, you can see the ink, paper area, and paper length usage divided into 
categories:

– Mono lines: Between 0% and 10% of non-white pixel coverage, printed on standard paper, with less than 
1% of color pixel coverage

– Color lines: Between 0% and 10% of non-white pixel coverage, printed on standard paper, with more 
than 1% of color pixel coverage

– Low density image: Between 10% and 50% of non-white pixel coverage printed on standard paper

– High density image: Over 50% of non-white pixel coverage printed on standard paper

– Blueprint: Any content type printed on blueprint paper
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– Premium quality image: Any content type printed on premium paper

● Ink usage displays the ink consumed in milliliters, by category, and the total amount.

● Paper area usage displays the paper area usage in English or metric units of area, by category, and the total 
amount.

● Paper length usage displays the paper usage in English or metric units of length, by category, and the total 
amount.

● The Ink tab displays the ink consumed by each cartridge in milliliters, and the total amount of ink consumed.
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● The Paper tab displays the amount of paper used and the total at the top, divided into paper categories or 
families.

Usage can be seen at each level.

When you tap the Print report  icon , a message is displayed: The usage report was sent to the job queue and 
will be printed soon.

All the values can be displayed in English or metric units.

Print the usage information

There are two different ways to print the usage information from the front panel’s home screen:

● Tap the Usage  icon  to launch the usage information screen, then tap the Print usage report button.

● Tap the Settings  icon , then Internal prints > User information prints > Print usage report.

Check usage from the Embedded Web Server
The same information can be retrieved from the Embedded Web Server as from the front panel.

1. Access the Embedded Web Server, see Embedded Web Server on page 12.

2. In the menu at the side, click Usage.
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The usage page shows all the printer usage information separated into various tables:

● Summary: The total ink usage and the total paper usage (in units of area and length).

● Print categories usage: The ink and paper usage and the number or pages printed for the different print 
categories (content type, such as mono lines, color lines, premium quality image, blueprint paper). This table 
information is shown only if the Show application categories printer setting is enabled. There are further 
conditions depending on the following settings:

– The paper printed usage is shown if the Paper area used and paper area printed setting is enabled.

– The blueprint category is shown if the Enable the blueprint category setting is enabled.

– The premium quality image category is only shown if the Enable the premium quality image category 
setting is enabled.

– If the printed-paper column information is shown, the paper area used field changes the string to "Paper 
area (m² used)". Otherwise, the string shown is "Paper area (m²)".

● Ink usage: The ink usage for the whole life of the printer (with approximate values). The ink consumption 
table lists the ink consumed in each color, ignoring the product number of the cartridge.

● Paper usage: All the papers that have been used throughout the life of the printer.

Check usage statistics for a job
The accuracy of the usage statistics is not guaranteed.

1. Access the Embedded Web Server, see Embedded Web Server on page 12.

2. In the menu at the side, click Usage > Accounting.

The accounting page shows a table of the latest printed jobs, with the following information per job (not per 
page):

● Name: The name of the job

The job name is shown only if the Show user name and job name in job accounting setting is available to 
users under Security > Security settings.

● Number: The number of the job

● Time: The date and time when the job was completed
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● User: The name entered by the person who submitted the job (this item is present only if the corresponding 
security setting is enabled)

The user name is shown only if the Show user name and job name in job accounting setting is available to 
users under Security > Security settings.

● Type: The type of job

● Source: The source of the job: Network, and so on

● Print quality: The print quality used to print the job

● Copies: The number of copies requested (cumulative after reprints)

● Pages: The number of pages completed

● Status: The status of the job: printed, canceled by user, and so on

● Total cost: The total cost of the job (visible if cost assignment is enabled)

● Paper type: The paper type used for the job

● Paper area: The used paper area of the job

● Paper length: The used paper length of the job

● Ink used: The volume of ink consumed by the job

A job is considered completed when all its pages have been printed, or canceled by the user, or canceled by the 
printer itself. An ongoing job (waiting for printing, being printed, being canceled, on hold for preview, and so on) 
will not appear on this list.

You can filter the jobs shown on the accounting page by using a drop-down control available on the same page. 
This control just changes the view, the job accounting information is not deleted in the printer. Essentially, this 
page will report the last N jobs (or fewer if there are not enough completed jobs), where N is the value of this 
configuration parameter. By default, N is 10.

Two buttons appear in the accounting table:

● Help: This button opens a window displaying help information. The information depends on the printer’s 
capabilities: for example, if the printer has no scanner, scanner help is not shown.

● Export to CSV: This button opens a window with a progress bar, and generates and downloads a CSV file. The 
downloaded file contains similar information to the accounting page, in CSV format. If the cost assignment is 
enabled, the CSV displays more detailed information about the cost of the job.

Check cost assignment
The accuracy of the usage statistics is not guaranteed.

1. Access the Embedded Web Server, see Embedded Web Server on page 12.

2. Go to the Main tab.

3. Select Usage > Cost assignment configuration.
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The cost assignment page allows you to enable or disable the cost assignment setting, using the checkbox next 
to Enable accounting assignment configuration at the top of the page. If the setting is enabled, you can insert or 
modify the cost of the following sections.

NOTE: At least one of these sections must be enabled in order to save the configuration.

● Units

– Currency: Enter any three-letter currency code.

– Paper usage: Select the units, English or metric.

● Print categories cost: Can be enabled or disabled. When enabled, you can assign a cost to each category, and 
select the units of the cost (per millimeter, or the option selected in the previous Units section). The cost is a 
number with two decimal digits of precision. Disabled categories are displayed grayed out.

● Ink usage cost: Can be enabled or disabled. Allows you to apply a cost to ink usage, and displays the available 
inks with a field to indicate the cost.

● Paper usage cost: Can be enabled or disabled. Allows you to apply a cost to the papers displayed. You can 
add papers from the list of supported papers. The costs can be removed or edited; they cannot be empty, 
but may be 0 (zero). The units selection is the same as for print categories.

● Fixed cost: Can be enabled or disabled. Allows you to add a fixed cost to all jobs.

Enabling the cost assignment setting causes the total cost column to appear in the accounting information, and 
detailed information is added to the exported CSV.
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Ink system11

HP Eco-Carton ink cartridges
The printer's HP Eco-Carton ink cartridges provide cyan, chromatic blue, chromatic green, chromatic red, gray, 
magenta, matte black, photo black, and yellow ink to the printheads.

Cartridges are placed on the right-hand side of the printer, and their capacity is dependent on the printer model:

● Z6 Pro: 500 ml

● Z9+ Pro: 1 liter

See Order ink supplies on page 148 for more details.

HP Eco-Carton ink cartridges require no maintenance or cleaning, but must be shaken before installation. 
High-quality printing results continue even when the ink levels are getting low.

CAUTION: Observe precautions when handling HP Eco-Carton ink cartridges because they are ESD-sensitive 
devices. Avoid touching pins, leads, and circuitry.

NOTE: This printer uses dynamic security which may be updated periodically by firmware updates. The printer 
is intended to be used solely with cartridges using an original HP chip. Cartridges using a non‐HP chip may not 
function or may cease to function. More information is available on the HP website at the following link: 
http://www.hp.com/learn/ds.

NOTE: This printer is not designed to use continuous ink systems. To resume printing, remove any continuous 
ink system and install genuine (or compatible) HP Eco-Carton ink cartridges.

NOTE: This printer is designed for ink cartridges to be used until they are empty. Refilling cartridges prior to 
depletion could cause your printer to fail. If this happens, insert a new cartridge (either genuine HP or 
compatible) to continue printing.

Printheads
The printheads deposit ink on the substrate.
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The printheads are universal, and when brand new they can be inserted into any slot, becoming committed to 
that color once purged and ready to print.

TIP: When you insert a printhead into a slot for the first time, HP recommends marking that printhead visibly 
to identify its position, as the printhead can be removed at any moment for various reasons, but it will only 
work again if inserted into the same slot as before.

The printheads are extremely durable and do not need to be replaced every time an ink cartridge is replaced. 
They provide excellent results even when the ink cartridges contain a low level of ink.

To maintain optimum print quality, the printheads are automatically tested at regular intervals, and automatically 
serviced when necessary. This takes a little time and can occasionally delay printing.

When a printhead eventually needs to be replaced, the front panel will display a message.

CAUTION: Avoid touching pins, leads, and circuitry when handling printheads because these elements are 
sensitive to electrostatic discharge. Such devices are called ESD-sensitive devices. Electrostatic discharges are 
one of the main hazards to electronics products. This type of damage can reduce the life expectancy of the 
device.

CAUTION: If you want to remove a printhead from the printer and preserve it for later use, reinstall the cap and 
plug. Installing the wrong cap and plug can cause irrecoverable printhead damage.

Gloss Enhancer
Used amongst other things, to reduce bronzing and improve gloss uniformity on glossy and semi-gloss papers.

How to turn the gloss enhancer on and off

● From the printer front panel: Tap settings > default printing > print quality > gloss enhancer.

● From HP Click: Tap the Gloss enhancer checkbox.

When and why do you use the gloss enhancer

● Use it to reduce bronzing (metallic look that is common in the gloss of pigment inks which takes on a bronze 
color in gray tones) and improve gloss uniformity on glossy and semi-gloss papers.

● Beneficial for black and white, and also color prints.

● Helps to equalize glossiness of the media and inks, and helps you achieve the desired look for your photo 
prints, minimizing the effects of light on them.
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● Areas with white-grey-black transitions are usually the ones where gloss enhancer effect is more visible. 
Glossy/semi-gloss media will perform differently across brands with respect to gloss uniformity and 
bronzing, although, the gloss enhancer brings benefits to all media brands.

● It is not applied on matte finish papers, as this paper type is not prone to gloss uniformity or bronzing issues.

Maintenance cartridge
The maintenance cartridge cleans and maintains the printheads, and seals the printheads when they are not in 
use to prevent them from drying out. It is also used to store waste ink.

IMPORTANT: The maintenance cartridge contains liquid ink. Keep it horizontal when removing it and storing it, 
to avoid spilling ink.

The maintenance cartridge has a waste capacity of 1.2 liters and automatically tracks the level of waste. You are 
notified when 80% of the capacity has been used.

WARNING! You will be notified at 100% to replace the maintenance cartridge.

NOTE: These figures can vary considerably depending on the image density, the print mode, and the ambient 
temperature.

The printer will refuse to start a print job if it detects that the maintenance cartridge is full. You should then 
replace the maintenance cartridge with a new one.

Safe mode
Under certain conditions, including printer operation outside of environmental specifications, and when a used, 
refilled, or counterfeit ink cartridge has been detected, the printer will operate in ‘safe’ mode.

HP is unable to warrant the performance of the printing system when operated outside of environmental 
specifications or when a used, refilled, or counterfeit ink cartridge is installed. Safe mode is designed to protect 
the printer and the printheads from damage due to unexpected conditions, and is in operation when the warning 
icon  is displayed on the front panel. For optimal performance, use Original HP Eco-Carton ink cartridges. 
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Original HP inks and printheads, are designed and engineered together to provide uncompromising print quality, 
consistency, performance, durability, and value—with every print.

NOTE: This printer is not designed to use continuous ink systems. To resume printing, remove the continuous 
ink system and install genuine HP (or compatible) HP Eco-Carton ink cartridges.

NOTE: The printer’s HP Eco-Carton ink cartridges are designed to be used until they are empty. Refilling 
cartridges before they are empty could cause the printer to fail. If this happens, insert a new cartridge (genuine 
HP or compatible) to continue printing.

Ink system tips
For best results, always follow the guidelines.

● Follow the instructions on the front panel during installation.

● Allow the printer and the maintenance cartridge to clean the printheads automatically.

● Avoid unnecessary removal of the ink cartridges and printheads.

● Make sure that you comply with all applicable laws and regulations when disposing of ink system 
consumables.

NOTE: Shake the ink cartridges and printheads vigorously before installing them.

Maintain the HP Eco-Carton ink cartridges
During the normal lifetime of a cartridge, no specific maintenance is required. You should replace a cartridge 
when it has reached its expiration date. See the ink cartridge information on the front panel for the expiration 
date.

Replace an HP Eco-Carton ink cartridge
HP Eco-Carton ink cartridges should be replaced in certain circumstances.

● The ink cartridge is very low and you want to replace it with a full cartridge for unattended printing. You can 
use the remaining ink in the first cartridge at a more convenient time.

● The ink cartridge is empty or faulty, and you must replace it to continue printing.

NOTE: If an ink cartridge runs out of ink while printing, the front panel prompts you to replace the ink 
cartridge, the job is paused and will resume afterwards. This pause may affect the print quality of the job.

WARNING! Make sure that the printer wheels are locked (the lever is pressed down) to prevent the printer 
from moving.

CAUTION: The procedure to remove an ink cartridge must be initiated from the front panel. Do not remove an 
ink cartridge until the front panel prompts you. If you remove an ink cartridge incorrectly, the printer may 
subsequently reject that cartridge.

CAUTION: Remove an ink cartridge only if you are ready to insert another one.

CAUTION: Observe precautions when handling ink cartridges because they are ESD-sensitive devices. Avoid 
touching pins, leads, or circuitry.
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Remove an HP Eco-Carton ink cartridge
Take care to avoid touching the end of a used cartridge because the connection might be coated with ink.

1. On the printer's front panel, tap the Inks  icon , then Replace ink cartridges.

Alternatively, tap the Settings  icon , then Ink > Replace ink cartridges.

2. Push the cartridge that you want to remove.

3. The cartridge comes out.

4. Remove the cartridge from the printer.

TIP: Don't touch the inserted end of the cartridge (it may be coated in ink).

NOTE: If necessary, store a partially-used ink cartridge in the same position as if it were inserted in the 
printer. Avoid using a partially-used cartridge that has been stored on its end.
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5. The front panel identifies the missing ink cartridge.

Insert an HP Eco-Carton ink cartridge
Pick up the new HP Eco-Carton ink cartridge and find the label that identifies the ink color.

1. Hold the ink cartridge so that you can see the label at the left and front.

2. Check that the colored label above the empty slot in the printer matches the color of the label on the 
cartridge.

3. Shake a color cartridge in all directions for 2 minutes.

4. Insert the ink cartridge into the correct slot and push it until it locks into position.
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5. The front-panel display confirms that all cartridges have been correctly inserted.

Refilled and non-HP ink cartridges
HP recommends that you replace an empty cartridge with a new HP cartridge.

The use of refilled or non-HP ink cartridges has several disadvantages:

● If printer failure or damage is attributable to the use of a non-HP or refilled ink cartridge, HP will charge its 
standard time and materials charges to service the printer for the particular failure or damage, even if the 
printer is within its warranty period.

● If failure or damage to printheads, ink cartridges, or other ink supplies is attributable to the use of non-HP, 
expired or refilled ink cartridge, HP is not responsible for the cost of replacement.

● Print quality may be impaired.

● The printer will be unable to estimate the ink level in the cartridge, and will report it as empty.

If you decide to use refilled or non-HP ink cartridges, you will need to follow these instructions to make the 
printer use a cartridge that it believes to be empty.

CAUTION: Running completely out of ink can damage the printheads. Damage attributable to printing with 
empty ink cartridges is not covered under the warranty. Forcing the printer to accept empty cartridges will 
empty the ink delivery system as well. Once emptied, ink must be used to refill the system and reprime the 
printhead when a new ink cartridge is installed.

1. Install the cartridge in the printer (see Replace an HP Eco-Carton ink cartridge on page 129).

2. The front panel will complain that the cartridge is empty, and the cartridge removal process will start. Tap 
the Red cross  icon  to stop this automatic process.

3. You can see the ink levels in your ink cartridges by tapping the Inks  icon  on the front panel's home 
screen.
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4. Tap any cartridge to see more detailed information.

5. On the right-hand side of the front panel, tap the following sequence for empty override: Help icon , Help 
icon , Help icon , Go back  icon .

6. When you have tapped OK in response to all warning messages, the front panel gives the usual ink 
cartridge status display, but the cartridge is shown as empty with a warning sign.
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Maintaining the printer12

Introduction
Perform maintenance procedures to maintain image quality and ensure mechanical parts are performing as 
expected.

IMPORTANT: It is strongly recommend that you complete the following maintenance procedures periodically, 
not doing so may cause the need for future service repairs.

Check and clean the printhead
If the diagnostic plot shows one or more nozzles out, and print quality suffers as a result, then you need to 
recover the printhead.

1. Launch the print test plot and check which printhead has one or more nozzles out.

2. Tap the optimize print quality icon , then Printhead cleaning, then scroll down and tap Advance 
calibrations > Printhead hard cleaning.

3. Select the printheads and tap Continue to check which ones need the cleaning procedure.

NOTE: When a printhead is not recoverable by this process, it needs to be replaced.
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Replace a printhead
When the printhead is out of ink or has an issue that cannot be fixed, you must replace it. After replacement, the 
printer will automatically perform a printhead alignment on the loaded paper.

1. On the printer's front panel, tap the Inks  icon , then the Printheads  icon , then Replace printheads. The 
carriage moves to the removal position.

2. Open front cover and the latch on top of the carriage.

3. Lift up the cover to provide access to the printheads.
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4. To remove a printhead, lift up the blue handle.

5. Using the blue handle, gently disengage the printhead, then gently pull it upwards until the printhead is 
released from the carriage.

CAUTION: Do not pull abruptly. That action can damage the printhead.
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6. Remove the orange protective caps by pulling them down.

7. Perform steps 1 to 5 in reverse order.

Clean the printhead connections
A carriage interconnect wiper is included with your printer in the User Maintenance Kit.

1. Remove a new pre-moistened replacement sponge from its pouch. Open the carriage interconnect wiper.

2. Load the sponge by positioning the sponge on the face of the carriage interconnect wiper with the shorter 
tab in the locating slot. Close the carriage interconnect wiper, trapping the sponge in place.
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3. Open the printhead carriage latch and extract the printhead that is causing the problem, as indicated on the 
front panel.

4. Insert the carriage interconnect wiper into the printhead slot at the back. Wipe the electrical contacts by 
inserting the tool between the electrical connections at the back of the slot and the steel spring, with the 
sponge facing away from you and towards the electrical contacts.
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5. Rub the sponge against the contacts with a light force along the entire depth of the flex connector, inserting 
the wiper as far as allowed by the mechanical stop on the tool.

6. Take special care to clean all contacts thoroughly, including the ones at the lowest point of the connector.

7. Use the same sponge to clean the lower strip of electrical contacts on the printhead (unless the printhead is 
new). Avoid touching the upper set of electrical contacts.
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8. After waiting a few moments to allow both connectors to dry, replace the printhead into the printhead 
carriage.

Replace the maintenance cartridge
The maintenance cartridge is located at the front of the printer, in a slot underneath the front panel.

1. On the printer's front panel, tap the Inks  icon , then at the left-hand side of the screen, select the Other 
supplies tab, then select Maintenance cartridge > Replace > Start.

2. Open the maintenance cartridge door.

3. The maintenance cartridge has a handle on the front. To remove the cartridge, slide it out part of the way 
only, then hold it on each side and use both hands to remove it all the way.

CAUTION: Take care, and keep horizontal while extracting.

140 Chapter 12  Maintaining the printer



4. Slide it out horizontally to avoid spills, as it is full of ink.

5. Remove the plastic cover from the new maintenance cartridge.

6. Insert the maintenance cartridge into the slot, in the direction indicated by the arrow. When you have 
inserted it into the printer, close the door.

7. The front panel confirms that the maintenance cartridge has been successfully installed.
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Periodic user maintenance
When printer usage warrants it, the front panel will occasionally request to run periodic user maintenance.

The following message appears:

There are three periodic user maintenance procedures: 1. Clean and lubricate the carriage rod, 2. Clean 
the encoder, and 3. Clean the platen. Once maintenance is complete, you must press the reset counter to 
communicate to the printer that maintenance is complete, and to initiate a new maintenance period counter.

NOTE: The front panel may request these procedures individually.

At the front panel, tap the Settings  icon , then Preventive maint. tasks > Clean and lubricate.

The front panel guides you through the steps, follow the instructions, and when completed tap Next.

1. Clean and lubricate the carriage rod
Always use a clean cloth and dampen it with a general-purpose industrial cleaner. Lubrication oil is included in the 
maintenance kit.

1. Open the front cover.
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2. Clean the carriage rod using a clean cloth dampened with a general-purpose industrial cleaner (such as 
Simple Green). Remember to also clean the part under the left cover.

CAUTION: While cleaning, be careful not to damage the plastic encoder strip located on top of the rod.

3. Wait until the rod is dry, then close then front cover.
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4. Open the front cover again.

5. Now clean the carriage rod in the other area, including the part of the rod under the right cover.

6. Take the bottle of oil from the printer’s maintenance kit, and deposit a very thin zig-zag trickle of oil along 
the rod. Take care not use too much oil on the rod as it could spill into other parts of the printer.
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7. Tap OK in the front panel, and close front cover.

8. The carriage moves from one side to the other of the printer to distribute the oil along the whole rod.

2. Clean the encoder
The encoder strip should be cleaned when requested by the printer. The front panel displays a message when 
cleaning is required or when running periodic user maintenance.

1. Open the front cover.

2. Clean the encoder strip on both sides with a cloth dampened with water, as instructed in the front panel, 
and tap Continue when finished.

NOTE: Be sure that all encoder strip surface is cleaned, especially behind the maintenance cartridge.
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3. Close the front cover.

The carriage moves to the left-hand side of the printer.

4. The front panel prompts you to open the cover again, and clean the right-hand side of the encoder strip 
(inside the service station). Tap Continue when finished.

5. Close the front cover again. The carriage returns to its ready position in the service station.

3. Clean the platen
You should clean the platen when requested by periodic maintenance.

Also clean the platen if you notice any of the following:

● Ink smearing when printing with presets that used to work well.

● Frequent paper jams.

● Ink stains and marks on the back of your prints.

● Banding or graininess appears in the first 10 cm of the print cut, when you use a paper and preset that used 
to work well.

See Troubleshooting print-quality issues on page 175 for more information.

Clean the platen with a soft cloth to remove ink and media dust.

1. If loaded, unload the media, then turn off the printer. See Unload a roll on page 33.
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2. Open the front cover.

3. Clean the print platen with a cloth in order to remove ink and media dust.

4. Use a 1 mm (0.04 in) pin to unclog every hole in the print platen. Make sure to push the pin all the way 
through, clogged vacuum holes can create image quality issues and paper crashes.

5. When finished, close the front cover.
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Accessories13

How to order supplies and accessories
There are two ways you can order supplies or accessories for your printer.

● Visit the HP website at the following link: https://www.hp.com/go/supplies.

● Contact HP Support (see Contact HP Support on page 208).

The rest of this chapter lists the available supplies and accessories, and their part numbers.

Order ink supplies
Order supplies from the HP website or by contacting HP Support.

Table 13-1 Ink supplies

Ink cartridge Product number Printer Regions

HP 775B 500-ml Photo 
Black DesignJet Eco-Carton Ink 
Cartridge

1XA99A Z6 Pro APJ

HP 775B 500-ml Cyan DesignJet 
Eco-Carton Ink Cartridge

1XB00A Z6 Pro APJ

HP 775B 500-ml Magenta 
DesignJet Eco-Carton Ink 
Cartridge

1XB01A Z6 Pro APJ

HP 775B 500-ml Yellow 
DesignJet Eco-Carton Ink 
Cartridge

1XB02A Z6 Pro APJ

HP 775 500-ml Cyan DesignJet 
Eco-Carton Ink Cartridge

1XB17A Z6 Pro EMEA, AMS

HP 775 500-ml Magenta 
DesignJet Eco-Carton Ink 
Cartridge

1XB18A Z6 Pro EMEA, AMS

HP 775 500-ml Yellow 
DesignJet Eco-Carton Ink 
Cartridge

1XB19A Z6 Pro EMEA, AMS

HP 775 500-ml Chromatic 
Red DesignJet Eco-Carton Ink 
Cartridge

1XB20A Z6 Pro EMEA, AMS

HP 775 500-ml Photo Black 
DesignJet Eco-Carton Ink 
Cartridge

1XB21A Z6 Pro EMEA, AMS

HP 775 500-ml Matte Black 
DesignJet Eco-Carton Ink 
Cartridge

1XB22A Z6 Pro EMEA, AMS

HP 776 1-liter Chromatic 
Green DesignJet Eco-Carton Ink 
Cartridge

1XB03A Z9+ Pro EMEA, AMS
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Table 13-1 Ink supplies (continued)

Ink cartridge Product number Printer Regions

HP 776 1-liter Chromatic 
Blue DesignJet Eco-Carton Ink 
Cartridge

1XB04A Z9+ Pro EMEA, AMS

HP 776 1-liter Gray DesignJet 
Eco-Carton Ink Cartridge

1XB05A Z9+ Pro EMEA, AMS

HP 776 1-liter Magenta 
DesignJet Eco-Carton Ink 
Cartridge

1XB07A Z9+ Pro EMEA, AMS

HP 776 1-liter Yellow DesignJet 
Eco-Carton Ink Cartridge

1XB08A Z9+ Pro EMEA, AMS

HP 776 1-liter Cyan DesignJet 
Eco-Carton Ink Cartridge

1XB09A Z9+ Pro EMEA, AMS

HP 776 1-liter Chromatic 
Red DesignJet Eco-Carton Ink 
Cartridge

1XB10A Z9+ Pro EMEA, AMS

HP 776 1-liter Photo Black 
DesignJet Eco-Carton Ink 
Cartridge

1XB11A Z9+ Pro EMEA, AMS

HP 776 1-liter Matte Black 
DesignJet Eco-Carton Ink 
Cartridge

1XB12A Z9+ Pro EMEA, AMS

HP 776B 1-liter Magenta 
DesignJet Eco-Carton Ink 
Cartridge

1XB13A Z9+ Pro APJ

HP 776B 1-liter Yellow 
DesignJet Eco-Carton Ink 
Cartridge

1XB14A Z9+ Pro APJ

HP 776B 1-liter Cyan DesignJet 
Eco-Carton Ink Cartridge

1XB15A Z9+ Pro APJ

HP 776B 1-liter Photo Black 
DesignJet Eco-Carton Ink 
Cartridge

1XB16A Z9+ Pro APJ

HP 776 500-ml Gloss Enhancer 
DesignJet Eco-Carton Ink 
Cartridge

1XB06A Z9+ Pro EMEA, AMS

Table 13-2 Printheads

Printhead Product number

HP 777 DesignJet Maintenance Cartridge 3ED19A

HP 777 DesignJet Printhead 3EE09A

Supported paper types
Your printer can use a wide range of paper types, including bond papers, coated papers, films, self-adhesive 
materials, banner and sign materials, and photo papers like satin or glossy.
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Supported HP papers
Papers are sold by HP for use with your printer. See the latest information on HP-branded papers supported for 
your printer and download paper presets for any of these papers from the printer’s front panel.

The latest information is also available on the HP website at the following link:http://www.hplfmedia.com/.

NOTE: On the webpage, go to the right pane and select the category Graphics & Technical, then filter by your 
printer.

Third-party-supported paper types
There is an Online search option you can use to find third party supported papers for your printer; from the 
printer's front panel, go to the Paper library to use it.

Plain papers

These generic paper types can also be used with your printer:

Plain papers

● Plain paper < 90 g/m²

● Plain paper 90–110 g/m²

● Plain paper > 110 g/m²

● Recycled

● Colored paper

Technical papers

● Natural tracing paper

● Vellum

● Translucent bond paper

Coated papers

● Coated paper 90–100 g/m²

● Heavyweight coated paper
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Poster papers

● Poster matte paper

● Poster satin paper

● Poster gloss paper

● Photo semi-gloss paper

● Blue-back paper

Banner and sign

● Polypropylene

● Tyvek 135 g/m²

Order other accessories
Order accessories from the HP website or by contacting HP Support.

Table 13-3 Other accessories

Name Product number

HP DesignJet Z9+ Pro Gloss Enhancer Upgrade Kit 7HC75A

HP DesignJet PostScript®/PDF Upgrade Kit 7HC76A

HP DesignJet Z Pro Series 64-in Take-Up Reel 7HC73A

HP DesignJet Z Pro Series 64-in Multifunction Roll 7HC74A

HP HD Pro 2 42-in Scanner 5EK00A

HP SD Pro 44-in Scanner G6H50B

HP DesignJet Z Pro Series 2/3-in Core Adapter 1A4T0A

Introduction to the accessories

HP DesignJet Z Pro Series 2/3-in Core Adapter
With this adapter you can use paper rolls with 2/3-inch cores, provided that the diameter of the roll is within 
printer specifications.

How to change to the 2/3 inch adaptor:
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1. Remove the screw from the 2/3 inch right-hand adaptor.

2. Remove the 2/3 inch right-hand adaptor. Be sure to leave the right-hand hub structure in place.

3. Slide the 3-inch right-hand adaptor onto the left-hand hub structure.

4. Fix the left-hand adaptor onto the hub structure with the screw provided.

HP DesignJet Gloss Enhancer Upgrade Kit (Z9+ Pro only)
With this kit you can produce images with uniform gloss from highlights to shadows, and minimize bronzing on 
most photo papers (except matte-finish papers).

The Gloss Enhancer Upgrade Kit has been designed to be used with an HP DesignJet Z9+ Pro printer only.
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For more information, visit the HP website at the following link: 
https://www.hp.com/go/DesignJetZ9Pro64in/gloss-enhancer.

HP DesignJet Z Pro Series 64-in Take-Up Reel
The HP DesignJet take-up reel enables busy design professionals and print service providers to be more 
productive by maximizing unattended printing—even overnight—and delivering neatly collected prints.

For busy CAD, GIS, and PSP professionals, it allows you to wind printed paper onto a reel in two positions: face-in 
and face-out.

For more information, visit the HP website at the following link: 
www.hp.com/go/DesignJetZPro64in/Take-up-Reel.

HP DesignJet Z Pro Series 64-in Multifunction Roll
The HP DesignJet multifunction roll enables print service providers and geographical information systems 
professionals to choose between two production-boosting options that make your day-to-day easier: a take-up 
reel or a 2nd roll.

The take-up reel allows you to wind printed paper onto a reel in two positions: face-in and face-out. The 2nd roll 
saves 40% of the time it takes to change media, and allows you to have two media types/sizes loaded at the 
same time, making media changes painless and smooth.

For more information, visit the HP website at the following link: 
http://www.hp.com/go/DesignJetZPro64in/Multifunction-Roll.
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Recycling and disposal instructions
HP provides many free and convenient ways to recycle your used original HP ink supplies.

Additionally, HP provides a free program for business customers to return signage printed using selected 
recyclable HP large-format papers. For more information about these HP programs, see the HP website at the 
following link: http://www.hp.com/recycle.

See the list of supplies in Order ink supplies on page 148.

HP recommends that you wear gloves when handling ink-system components.

Recycle an HP Eco-Carton ink cartridge

1. Open the cardboard box.

2. Remove the ink bag.

3. Recycle the cardboard as you normally would, then place the remaining ink bag in your HP Planet Partners 
bin to be submitted to HP Planet Partners.

https://www.hp.com/recycle
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Troubleshooting paper issues14

Paper cannot be loaded successfully
There are various reasons why you may have issues loading the paper.

● Ensure that no paper is already loaded.

● Ensure that the paper is far enough inside the printer: you should feel the printer grab the paper.

● Do not attempt to straighten the paper during the aligning process, unless instructed to do so by the 
front-panel display. The printer automatically attempts to straighten the paper.

● The paper may be crumpled, or warped, or may have irregular edges.

● It can be difficult to load a particularly stiff paper from the lower roll (2): HP recommends moving it to upper 
roll (1).

General unsuccessful roll load issues
There are checks to make and steps to take to correct any problems.

● If the paper does not load, the leading edge of the paper may not be straight or clean and needs to be 
trimmed. Remove the initial 2 cm (1 in) from the roll and try again. This may be necessary even with a new 
roll of paper.

● Ensure the roll ends are tight against the hubs' disks.

● Check that the hubs are correctly inserted.

● Check that the paper is correctly loaded on the loading station's hubs.

● Check that all roll end plugs have been removed.

● Check that the paper is wound tightly on the roll.

● Do not touch the roll or paper at during the alignment process.

Unsuccessful roll load
If the paper has not been inserted straight, the printer attempts to straighten the roll.

If you would like to start the load process again, cancel the process on the front panel and rewind the roll from 
the end of the spindle until the edge is removed from the printer.

NOTE: If the roll has become loose around the core, the printer may not be able to load the paper.

Paper is unloaded or not loaded correctly on roll 2
It is not recommended to load certain media types onto the lower roll (2), because they could unload randomly.

The printer's front panel recommends to load the following (or similar) media onto the upper roll (1) only:

● HP Premium Instant-dry Photo Gloss
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● HP Universal Instant-dry Photo Gloss

● HP Everyday Instant-dry Gloss photo

● HP Premium Instant-dry Photo Satin

● HP Professional Instant-dry Satin Photo Paper

● HP Universal Instant-dry Satin Photo Paper

● HP Everyday Instant-dry Satin Photo

● [Generic] Photo Gloss/Semi-gloss/Satin Paper

● [Generic] Photo Gloss/Semi-gloss/Satin Paper (less ink)

● Adhesive Polypropylene Matte

● HP Everyday Adhesive Matte Polypropylene

● Adhesive Polypropylene Gloss

Paper loading error messages
Check the list of front panel error messages related to paper loading, with the suggested corrective action.

Table 14-1 Paper loading error messages

Front panel message Suggested action

Paper incorrectly loaded The paper has not been loaded correctly. Remove the paper.

Paper loaded with too much skew During the paper load process the printer detected that the paper had too much skew. 
Follow the instructions on the front-panel display.

Paper loose around core The end of the roll has become loose around the core. Tighten the paper to the core or 
insert a new roll.

Paper not detected During the paper load process the printer did not detect any paper. Ensure the paper is 
inserted fully and is not transparent.

Roll cover closed during paper load process Do not close the roll cover until you are prompted to do so by the front panel.

Paper type is not in the driver or front panel
If your paper type does not appear in the list (in the driver or front panel), you can select one of the paper types 
that does appear in the list, by referring to the paper selection table.

To use the Paper selection table, you should first identity the following attributes of your paper type:

● Whether your paper requires a high or low carriage position. Most papers require a high carriage position. 
Only thin, cockle-free papers such as films or photo paper should use a low position. For those papers, a low 
carriage position may help to eliminate print defects such as grain or banding.

● The ink quantity supported by your paper. This depends mostly on the grammage, but also on the type of 
the coating. HP recommends choosing a starting point in the table, then adjusting it according to the results.
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● Whether your paper is glossy, matte, or transparent.

NOTE: If your paper type is glossy, it is important to choose a glossy paper from the list, as matte black 
ink does not usually print well on glossy paper. If you are unsure whether your paper supports matte black 
ink, try selecting Super Heavyweight Coated Paper and Fine Art Pearl (more ink), and choose the one that 
gives the best result. If your paper is incompatible with matte black ink, you will find that the ink easily 
comes off the paper when touched.

Further notes

● For thin papers (< 90 g/m2) uncoated papers (for example, plain paper or bright white paper) select paper 
type Bond and Coated Paper > Plain Paper.

● For light coated papers (< 110 g/m2), select paper type Bond and Coated Paper > HP Coated Paper.

● For heavyweight coated papers (< 200 g/m2), select paper type Bond and Coated Paper > Heavyweight 
Coated Paper.

● For cockle-free very thick coated papers (> 200 g/m 2), select paper type Bond and Coated Paper > Super 
Heavyweight Coated Paper.

Table 14-2 Paper selection table

Carriage position Ink quantity Paper finish

Matte finish (uses matte black) Glossy/satin/pearl finish (uses photo 
black)

High (specialty papers 
above 260 g/m², or 
fiber-based paper of any 
grammage)

High Photo Matte Paper

Super Heavyweight Coated Paper

Fine Art Paper

Canvas

Fine Art Pearl (more ink) (Z9+ Pro 
only)

Scrim Banner

Medium Heavyweight Coated Paper

Canvas (less ink)

Clear Film (transparent)

Fine Art Pearl (less ink) (Z9+ Pro only)

Photo Baryte generic (Z9+ Pro only)

Polypropylene

Adhesive Polypropylene Matte

Low Coated Paper

Plain Paper

Matte Film (transparent)

Low (thin, cockle-free 
papers below 260 g/m²)

High Backlit material Photo Gloss/Semi-Gloss/Satin Paper

Medium Photo Gloss/Semi-Gloss/Satin Paper 
(less ink)

NOTE: Some photo black ink may be used intentionally even on matte papers.
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After printing, the paper has wrinkles or there is too much ink
This happens when too much ink is used. To use less ink, select a category with less ink from the table. Ensure 
that carriage position and paper finish remain the same.

After printing, there is banding or coalescence grain in dark, saturated colors such as 
yellowish or reddish browns

This happens when too much ink is used. To use less ink, select a category with less ink from the table. Ensure 
that carriage position and paper finish remain the same.

After printing, the paper shows carriage scratches
If the problem is caused by excessive wrinkles in the paper.

See After printing, the paper has wrinkles or there is too much ink on page 158.

Otherwise, select a category with high carriage position. Ensure that ink quantity and paper finish remain the 
same.

After printing, colors are not saturated enough
This may happens when too little ink is used. To use more ink, select a category with more ink from the table. 
Ensure that carriage position and paper finish remain the same.

Squeaking noise while moving paper
Before applying oil, if loaded, unload the paper and have the maintenance oil bottle ready.

IMPORTANT: Power off the printer and disconnect in from the power source.

Oil the grid roller holders
The grid roller holders are located in three postions at the left-hand, center, and right-hand areas of the grid 
roller.

1. Open the front window to access the parts that need to be oiled.

2. Go to the left-hand end of the grid roller and apply oil to the white bearing holding the grid roller to the gear 
system.
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3. At the left-hand side, at the end of the print zone, apply oil to the holder supporting the grid roller.

4. At the right-hand end of the grid roller, next to the carriage, apply oil to the other holder supporting the grid 
roller.

5. Close the front window.

6. Connect the printer to the power source.

7. Power on the printer.

8. Load paper to make the grid roller spin and evenly distribute the oil. It is recommended to use a basic paper, 
as it may be stained with excess oil.
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9. Use the paper rewind arrow  to make the grid roller spin and the paper to absorb any possible excess 

oil.

Oil the grid roller supports in the print zone
The grid roller supports and located along the width of the grid roller in the printzone.

WARNING! When you oil these parts you will need to load paper afterwards. The paper may become stained if 
excess oil is applied.

1. Open the front window to access the parts that need to be oiled.

2. Apply oil to the support at the left-hand side of the grid roller.

3. Apply oil to the supports along the central part of the grid roller.
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4. Apply oil to the support at the right-hand side of the grid roller.

5. Close the front window.

6. Connect the printer to the power source.

7. Power on the printer.

8. Load paper to make the grid roller spin and evenly distribute the oil. It is recommended to use a basic paper, 
as it may be stained with excess oil.

9. Use the paper rewind arrow  to make the grid roller spin and the paper to absorb any possible excess 

oil.
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Printer printed on the wrong paper type
If the printer prints your job before you were able to load your desired paper, you may have Use Printer Settings 
or Any selected for the Paper Type in the printer driver. When either of these is selected, the printer will print 
immediately on whichever paper is loaded.

Load your desired paper, see Paper handling on page 23, and select your paper type specifically in the driver.

● In the Windows driver dialog: select the Paper/Quality or Paper tab (depending on the driver version), then 
select your paper type from the Paper Type list.

● In the macOS Print dialog: select the Paper/Quality panel, then select your paper type from the Paper Type 
list.

NOTE: Use Printer Settings (Windows) or Any (macOS) is the driver default.

Automatic cut not available
Some paper types cannot be cut by the automatic cutter. When such a paper type is loaded and active, the 
printer cannot switch automatically to the other roll: the active roll must first be unloaded manually.

On hold for paper
Based on a set of conditions that you can set when sending a job.

See Solve paper mismatch on page 90), the printer will decide which of the loaded rolls of paper is more suitable 
to print the job. If there is no roll of paper available that meets all the conditions, the printer will put the job 
on hold for paper. You can manually resume the job, forcing it to print on a paper other than the one originally 
specified, otherwise it will stay on hold.

NOTE: When an uncuttable roll is active, every job sent to any other paper source is put on hold until you 
manually unload the uncuttable roll.

Which criteria are used to decide on which roll a job will be printed?
When a user sends a job, the desired paper type can be set in the driver.

The printer will print the job on a roll of paper of the chosen paper type that is large enough to print the drawing 
without clipping. If there is more than one roll on which the job could be printed meeting all the criteria, the roll 
will be chosen according to your preferences. These can be set from the front panel: see Roll policies on page 90.

When is a job put on hold for paper?
If the paper mismatch action is set to Put job on hold

See Solve paper mismatch on page 90), a job is put on hold for paper in the following cases:

● The paper type that has been selected by the user is not currently loaded on the specified roll—or on either 
of the rolls, if no roll has been specified.

● The paper type that has been selected by the user is loaded on the specified roll, but the drawing is too large 
to fit on the roll—or on either of the rolls, if no roll has been specified.
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If I load a new roll of paper, will jobs that were on hold for paper be automatically 
printed?

Yes. Every time a new roll of paper is loaded, the printer will check if there are any jobs on hold for paper that 
could be printed on the loaded roll.

I don’t like jobs being put on hold for paper. Can I prevent it?
Yes, this can be done from the front panel.

See Solve paper mismatch on page 90.

My job is exactly as wide as the roll of paper that is loaded on the printer, but is put on 
hold for paper

Margins are managed in different ways depending on the file type.

● For HP-GL/2 and HP RTL files, by default, margins are included inside the drawing, so a 914 mm (36 in) 
HP-GL/2 and HP RTL file can be printed on a 914 mm (36 in) roll of paper and will not be put on hold for 
paper.

● For other file formats, such as PostScript, PDF, TIFF, or JPEG, the printer assumes that margins need to be 
added outside the drawing (as, in many cases, these formats are used for photographs and other images 
that do not include margins). This means that, to print a 914 mm (36 in) TIFF, the printer needs to add 
margins, and the drawing needs 925 mm (36.4 in) of paper to be printed; this would cause the job to be put 
on hold if the paper that is loaded on the printer is only 914 mm (36 in) wide.

If you wish to print these file formats without adding extra margins outside of the drawing, the Clip contents 
by margins option can be used. This option will force the margins to be set inside of the drawing, so a 914 
mm (36 in) TIFF can be printed on a 914 mm (36 in) roll of paper without being put on hold. However, if there 
is no white space already included in the drawing’s borders, some contents could be clipped because of the 
margins.

Roll paper will not advance
If you have pushed the printer up against a wall, the roll may be touching the wall at the rear of the printer. 
Increase the space between the printer and the wall, or use the wall spacers to ensure a minimum distance 
between printer and wall.

Paper has jammed
When a paper jam occurs, you normally see the Possible paper jam message in the front panel display.

Paper has jammed in the media input
When a paper jam occurs, be sure to carefully remove all pieces of paper.
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1. Turn off the printer.

2. Remove the screws from the media input module rear plate.

3. Remove the rear plate.

4. Carefully pull the jammed paper out. Cut the paper if it is damaged.

5. Remove all pieces of paper from the rear of the printer.

6. Rewind the roll.

7. Put the rear plate back and fix with the screws.

8. Turn on the printer.

9. Reload the roll, see Paper handling on page 23.

NOTE: If you find that there is still some paper causing an obstruction within the printer, restart the procedure 
and carefully remove all pieces of paper.

Paper has jammed in the print zone
Take care to remove all of the jammed paper, if not you may have to repeat the procedure.

NOTE: If the frequency of paper jams in the print zone increases, clean the platen and platen holes. See 
Periodic User Maintenance: 3. Clean the platen on page 146.
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1. Turn off the printer at the front panel.

2. Open the front cover.

3. Try to move the printhead carriage out of the way.
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4. Carefully remove any of the jammed paper that you can lift up and out from the top of the printer.

CAUTION: Do not move the paper sideways, as it could damage the printer.

5. Close the front cover.
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6. Turn on the printer.

7. Reload the roll, see Paper handling on page 23.

NOTE: If you find that there is still some paper causing an obstruction within the printer, restart the procedure 
and carefully remove all pieces of paper.

Paper gets into the lower module
The lower module has two paper diverters that can be used to block paper access when it is not used as a 
take-up reel.

To prevent paper getting into the lower module:

1. Unclip the diverters.

2. Move the diverters to the upper position.

Printer displays out of paper when paper is available
If the roll has become loose from its core, it will not feed correctly and the printer will not load the paper. If 
possible, tighten the paper to its core or load a new roll.

Prints do not fall neatly into the basket
Ensure that the basket is correctly installed before proceeding with other checks. See the assembly instructions 
that came with the printer for information.

If the basket is correctly installed and you continue to have an issue, check the following:

● Ensure that the basket is open.

● Ensure that the basket is not full.

● Paper often tends to curl near the end of a roll, which can cause output problems. Load a new roll, or remove 
prints manually as they are completed.
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Vertical marks on plots when collecting backlit paper with the take-
up reel (multifunction roll accessory only)

When using a multifunction roll accessory as a take-up reel to collect backlit printing materials, it is 
recommended to wind the paper inwards (printed side facing the core). This prevents the arms in the auto-feed 
mechanism from damaging the printed plots.

Paper is cut when the print has been completed
By default the printer cuts the paper after the drying time has been completed.

See Change the drying time on page 53. You can disable the cutter, see Turn the automatic cutter on and off on 
page 53.

Loading station cannot be closed
The loading station cannot be closed when the left-hand hub is at its leftmost position because it clashes with 
the media input module's side plate. HP recommends moving the left-hand hub to the right to avoid issues.

Cutter does not cut well
By default, the printer is set to cut the paper automatically after the drying time has been completed. If the cutter 
is turned on but not cutting correctly, check that the cutter rail is clean and clear of any obstacles.

If the cutter is turned off, Form feed and cut only advances the paper. Use it to move the print far enough out of 
the front of the printer, until it is convenient to cut manually with a straight edge or scissors.

NOTE: The cutter is a Customer Self-Repair part. If the blade has had too much use, you can order a 
replacement. Contact HP Support for more information: see Contact HP Support on page 208.
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Replace the cutter
Cutter life depends on the type of paper being used and it can become worn over time. A blunt cutter can cause 
quality issues, or even stop while cutting and generate a system error.

To order a replacement cutter, contact your reseller, or visit the HP website at the following link: 
https://parts.hp.com/, then search for: Y0U21-67066 Cutter Module.

You can replace the cutter yourself, by following these instructions or the assembly instructions that are included 
in the cutter box.

1. Turn off the printer at the front panel.

2. Open the front cover.
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3. Locate the cutter inside the cover on the left-hand side.

4. Slide the cutter to the right-hand side.

5. Rotate the cutter out and remove it from the rail.

6. Take the new cutter from its box.
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7. Rotate the new cutter into place in the rail.

8. Move the cutter to the left-hand side.

9. Turn on the printer at the front panel.

Cutter derailed
If the cutter becomes detached from the rail, it may need to be replaced.

To replace the cutter:

1. Access the cutter from the left side of the print zone.

2. Move it to the other end of the printer, and twist it to remove it from the rail.

3. Place the new cutter at the right hand-side of the rail.

● Press the cutter towards the rail.

● Lift the small wheel.

4. Confirm it is correctly installed by sliding it along the rail, and verify it is placed vertically (with no angle).

NOTE: The cutter is a Customer Self-Repair part. If the blade has had too much use, you can order a 
replacement. Contact HP Support for more information: see Contact HP Support on page 208.

IMPORTANT: Paper types supported by cutter: this is a high performance cutter, all paper types can be cut, 
except textiles and high tough papers.
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WARNING! Cutter life is the same as printer life when using standard paper. Life is drastically reduced if tough 
papers are used intensively.

Roll is loose
The roll may need to be replaced or reloaded.

Ensure that you are using the right core, and use the HP DesignJet 3-in Core Adapter when needed.

Autothread arm is uninstalled
A paper jam can cause an inner arm or a pinch arm of the autothread to uninstall.

Follow the instructions below to reinstall it:

Inner arm installation

1. Turn off the printer.

2. Rotate the inner arms of the module to be reinstalled and hold them for better access.

3. Unclip the inner arms.
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4. Remove the inner arms.

5. Now reverse the steps to install it.

Pinch arm installation

1. Turn off the printer.
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2. Unclip the pinch arm.

3. Hold the clip and remove the pinch arm.

4. Now reverse the steps to install it.
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Troubleshooting print-quality issues15

General advice
To achieve the best performance from your printer, use only genuine manufacturer's supplies and accessories, 
whose reliability and performance have been thoroughly tested to give trouble-free performance and best-
quality prints.

When you have a print-quality problem:

● Use genuine manufacturer's supplies. For details of recommended papers, see Supported paper types on 
page 149.

● Make sure that the paper type selected in the front panel is the same as the paper type loaded into the 
printer (see View information about the paper on page 44). At the same time, check that the paper type has 
been calibrated. Also make sure that the paper type selected in your software is the same as the paper type 
loaded into the printer.

CAUTION: If you have the wrong paper type selected, you could experience poor print quality and 
incorrect colors, and perhaps even damage to the printheads.

● Check that you are using the most appropriate print-quality settings for your purposes (see Printing on page 
72). You are likely to see lower print quality if you have moved the print-quality slider to the 'Speed' end of 
the scale, or set the custom quality level to Fast.

● Check that your environmental conditions (temperature, humidity) are in the recommended range. See 
Environmental specifications on page 213.

● Check that your HP Eco-Carton ink cartridges and printheads have not passed their expiration dates.

● Use the diagnostic plot (see HP Control Print on page 187), which includes a troubleshooting guide to 
identify what actions you should take.

Horizontal lines across the image (banding)
If your printed image suffers from added horizontal lines, the color may vary across the image.
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1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in 
your software. See View information about the paper on page 44.

2. Check that you are using appropriate print-quality settings for your purposes (see Printing on page 72). 
In some cases, you can overcome a print-quality problem merely by selecting a higher print-quality level. 
For instance, if you have set the Print Quality slider to Speed, try setting it to Quality. If you change the 
print-quality settings, you may wish to reprint your job at this point in case the problem has been solved.

3. Print the Image Diagnostics Print and follow the instructions in Image Diagnostics Print on page 190, 
including printhead cleaning if recommended.

4. If the printheads are working correctly, go to the front panel and tap the Optimize quality  icon , then 
Paper advance calibration. Choose the paper source and then Paper advance calibration.

5. Use the diagnostic plot (see HP Control Print on page 187), which includes a troubleshooting guide to 
identify what actions you should take.

If the problem persists despite all the above actions, contact HP Support: see HP Control Print on page 187.

Banding appears as irregular watermarks
If banding appears as irregular watermarks, change to a higher-quality print mode or try reseating the 
printheads.

See Front panel recommends reseating or replacing a printhead on page 195.

If banding only appears in a 10 cm area of a print, clean the platen. See periodic user maintenance 3. Clean the 
platen on page 146.

Whole image is blurry or grainy
There are a series of steps and checks you can make to deal with this issue. Check the paper, settings, print 
quality, and printhead alignment.
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1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in 
your software. See View information about the paper on page 44.

2. Check that you are printing on the correct side of the paper.

3. Check that you are using appropriate print-quality settings (see Printing on page 72). In some cases, you 
can overcome a print-quality problem merely by selecting a higher print-quality level. For instance, if you 
have set the Print Quality slider to Speed, try setting it to Quality. If you change the print-quality settings, 
you may wish to reprint your job at this point in case the problem has been solved.

4. Realign the printheads. See Align the printheads on page 199. After alignment, you may wish to reprint your 
job in case the problem has been solved.

5. Clean the printhead drop detector. See Clean the printhead drop detector on page 196.

6. Go to the front panel and tap the Optimize quality  icon , then Paper advance calibration. Choose the 
paper source and then Paper advance calibration.

If the problem persists despite all the above actions, contact HP Support: see Contact HP Support on page 208.

Paper is not flat
If the paper does not lie flat when it comes out of the printer, but has shallow waves in it, you are likely to see 
defects in the printed image, such as vertical stripes. This can happen when you use thin paper that becomes 
saturated with ink.

Paper is not flat 177



1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in 
your software. See View information about the paper on page 44.

2. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper or HP Super Heavyweight Plus 
Matte Paper.

3. Select a paper type that is slightly thinner than the paper you have loaded; this will cause the printer to 
use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper, 
Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

Print is scuffed or scratched
The black ink pigment can be scuffed or scratched when touched by a finger, a pen or some other object. This is 
particularly noticeable on coated paper.

Glossy paper may be extremely sensitive to the basket or to anything else that it contacts soon after printing, 
depending on the amount of ink used and the environmental conditions at the time of printing.

To reduce the risk of scuffs and scratches:

● Handle prints carefully.

● Avoid stacking prints on top of each other.

● Catch your prints as they are cut from the roll and do not let them fall into the basket. Alternatively, leave a 
sheet of paper in the basket so that freshly printed sheets do not make direct contact with the basket.

Ink marks on the paper
This problem can occur for several different reasons.

Horizontal smears on the front of coated paper
If a lot of ink is used on plain or coated paper, the paper absorbs the ink quickly and expands. As the printheads 
move over the paper, the printheads may come into contact with the paper and smear the printed image.
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Whenever you notice this problem, cancel the printing job immediately. Soaked paper can damage the 
printheads.

Try the following suggestions to avoid this problem:

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in 
your software. See View information about the paper on page 44.

2. Use a recommended paper type (see Supported paper types on page 149) and the correct print settings.

3. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper and HP Super Heavyweight 
Plus Matte Paper.

4. Select a paper type that is slightly thinner than the paper you have loaded; this will cause the printer to 
use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper, 
Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

5. Try to increase the margins by relocating the image to the center of the page using your software 
application.

6. If you have a Z9+ Pro and you are printing on any kind of photographic paper, try loading the paper as Photo 
Baryte, which increases the distance between the printhead and the paper.

Ink marks on the back of the paper
Clean the platen with a soft cloth. Clean each rib separately without touching the foam between the ribs.

Black ink comes off when you touch the print
This problem may be caused by printing with matte black ink on glossy paper. The printer will not use matte 
black ink if it knows that the paper will not retain it. To be sure of avoiding matte black ink, you can select any 
paper type from the Photo Paper category.

Edges of objects are stepped or not sharp
The issue may be related to orientation. Try rotating the image: you may find that the result looks better.
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If rotating the image doesn't help:

1. If edges of objects or lines appear to be poorly defined or lighter in density, and you have already set the 
print-quality slider to Quality in the driver dialog, select the custom print-quality options, and try setting the 
quality level to Normal. See Printing on page 72.

2. Alternatively, set print quality to Custom options, then Settings: Best and check the More passes box. This 
will cause unidirectional printing, which reduces the severity of the problem.

Edges of objects are darker than expected
The issue may be related to orientation. Try rotating the image: you may find that the result looks better.

If rotating the image doesn't help:

1. If edges of objects seem darker than expected, and you have already set the print-quality slider to Quality 
in the driver dialog, select the custom print-quality options, and try setting the quality level to Normal. See 
Printing on page 72.

2. Alternatively, set print quality to Custom options, then Settings: Best and check the More passes box. This 
will cause unidirectional printing, which reduces the severity of the problem.

Vertical lines of different colors
Your print has vertical bands of different colors along it.

To avoid this problem:

1. Try using thicker paper, choosing from the recommended paper types such as HP Heavyweight Coated 
Paper and HP Super Heavyweight Paper. See Supported paper types on page 149.

2. Try using higher print-quality settings (see Printing on page 72). For instance, if you have set the Print 
Quality slider to Speed, try setting it to Quality.

3. Alternatively, set print quality to Custom options, then Settings: Best and check the More passes box. This 
will cause unidirectional printing, which reduces the severity of the problem.

White spots on the print
You may notice white spots on the print. This is probably due to paper fibers, dust or loose coating material.

To avoid this problem:

1. Try cleaning the paper manually with a brush before printing, to remove any loose fibers or particles.
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2. Always keep the cover of your printer closed.

3. Avoid actions that may introduce dust into the printer, such as handling or cutting paper on the printer 
cover.

4. Protect your paper rolls by storing them in bags or boxes.

Colors are inaccurate
The colors of your print do not match your expectations.

Try the following:

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in 
your software. See View information about the paper on page 44.

2. Tap the Optimize quality  icon , then the small Settings  icon , then Calibration Status to check the 
color calibration status. If the status is PENDING or OBSOLETE, you should perform color calibration: see 
Color calibration on page 96. If you have made any changes, you may wish to reprint your job in case the 
problem has been solved.

3. Check that the source color space of the source is correctly tagged. The most common color spaces are 
sRGB and AdobeRGB. If no color space is defined, then the one specified under the Settings  icon  > 
Default printing configuration > Color options will be applied.

NOTE: The AdobeRGB space covers more colors than sRGB. For that reason, some bright colors may be 
achievable only if the image is tagged as AdobeRGB.

4. Check that the settings under the Settings  icon  > Default printing configuration > Color options are 
correct. In particular, test the default configuration, which is: Rendering intent = Perceptual, Black point 
compensation = On, and HP Pantone emulation = On (unless other settings are desired).

5. Check that you are printing on the correct side of the paper.

6. Check that you are using appropriate print-quality settings (see Printing on page 72). If you have selected 
the Speed or Fast options, you may not get the most accurate colors. If you change the print-quality 
settings, you may wish to reprint your job at this point in case the problem has been solved.

7. If you are using Application Color Management, check that the color profile you are using corresponds to 
the selected paper type and print-quality settings. If you have doubts about which color settings to use, see 
Color management on page 96.

8. If a grayscale image shows a color cast in some of the gray shadows, select Color > Grayscale in the driver.
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9. If the problem consists of color differences between your print and your monitor, try calibrating your 
monitor. At this point, you may wish to reprint your job in case the problem has been solved.

10. Print the Image Diagnostics Print. See Image Diagnostics Print on page 190.

If the problem persists despite all the above actions, contact HP Support: see Contact HP Support on page 208.

My print does not have gloss uniformity (Z9+ Pro only)
Check that you have installed the HP Gloss Enhancer Upgrade Kit

1. If you don't have the HP Gloss Enhancer Upgrade Kit installed, see Order other accessories on page 151.

2. Check that you are using a paper that permits gloss enhancer.

3. At the front panel, tap the Settings  icon , then Default printing configuration > Gloss enhancer, and 
check that the setting is On.

NOTE: This setting is available only if you have installed the HP Gloss Enhancer Upgrade Kit.

4. If you are using the printer driver, check that you enabled the setting in the driver before printing.

Image is incomplete (clipped at the bottom)
If the image is incomplete you may have cut the data being received, or there could be a communication issue.

● Did you tap the Cancel  icon  before all the data were received by the printer? If so, you have ended the 
data transmission and will have to print the page again.

● If a large image is clipped (A1 or larger), go to the Advanced properties in the driver, then set Max application 
resolution to 300.

● The I/O timeout  setting may be too short. This setting determines how long the printer waits for the 
computer to send more data, before deciding that the job is finished. From the front panel, increase the 
I/O timeout  setting to a longer period and then send the print again. Tap the Settings  icon , then 
Connectivity > Network > I/O timeout.

● There may be a communications problem between your computer and the printer. Check your network 
cable.

● Check to make sure that your software settings are correct for your current page size (for example, long-axis 
prints).

● If you are using network software, make sure it has not timed out.

Image is clipped
Clipping normally indicates a discrepancy between the actual printable area on the loaded paper and the 
printable area as understood by your software.

You can often identify this kind of problem before printing by previewing your print (see Preview a print on page 
80).

● Check the actual printable area for the paper size you have loaded.
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printable area = paper size - margins

● Check what your software understands to be the printable area (which it may call "printing area" or 
"imageable area"). For example, some software applications assume standard printable areas that are larger 
than those used in this printer.

● If you have defined a custom page size with very narrow margins, the printer may impose its own minimal 
margins, clipping your image slightly. You may want to consider using a larger paper size.

● If your image contains its own margins, you may be able to print it successfully by using the Clip Contents by 
Margins option (see Select margin options on page 78).

● If you are trying to print a very long image on a roll, check that your software is capable of printing an image 
of that size.

● If you try to print an image larger than your software can handle, the bottom of the image may be clipped. To 
print the whole image, try these suggestions:

– Save the file in another format, such as TIFF or EPS, and open it with another application.

– Use a RIP to print the file.

● You may have asked to rotate the page from portrait to landscape on a paper size that is not wide enough.

● If necessary, reduce the size of the image or document in your software application, so it fits between the 
margins.

Some objects are missing from the printed image
Large quantities of data may be necessary to print a high-quality large-format print job, and in some specific 
workflows there may be issues that can lead to some objects missing from the output.

Here are some suggestions to help you to avoid this problem:

● Select a smaller page size and scale to the desired final page size in the driver or in the front panel.

● Save the file in another format, such as TIFF or EPS, and open it with another application.

● Use HP Click software to print the file.

● Use a RIP to print the file.

● Reduce the resolution of bitmap images in your application software.

● Select a lower print quality in order to reduce the resolution of the printed image.

NOTE: If you are working under macOS, not all of these options are available.

These options are suggested for troubleshooting purposes and may adversely affect the final output quality or 
the time necessary to generate the print job. Therefore, they should be canceled if they do not help to solve the 
problem.

Lines are too thick, too thin or missing
Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in your 
software.
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1. See View information about the paper on page 44 to check the paper type corresponds.

2. If the resolution of your image is greater than the printing resolution, you may notice a loss of line quality. 
If you are using the PCL3GUI driver for Windows, you can find the Max. application resolution option in the 
driver dialog's Advanced tab, under Document options > Printer features. If you change this option, you may 
wish to reprint your job at this point in case the problem has been solved.

3. If lines are too thin or missing, print the Image Diagnostics Print. See Image Diagnostics Print on page 190.

4. If the problem remains, go to the front panel and tap the Optimize quality  icon , then the small 
Settings  icon , then Printhead alignment to align the printheads. See Align the printheads on page 199. 
After alignment, you may wish to reprint your job in case the problem has been solved.

5. Go to the front panel and tap the Optimize quality  icon , then the small Settings  icon , then perform 
paper advance calibration.

6. Check that you are using appropriate print-quality settings for your purposes (see Printing on page 72). 
Select the custom print-quality options in the driver dialog, and try turning on the Maximum detail option (if 
available). You may wish to reprint your job at this point in case the problem has been solved.

If the problem persists despite all the above actions, contact HP Support: see Contact HP Support on page 208.

Lines appear stepped or jagged
Check your original image, and print-quality settings.

Try the following:

1. The problem may be inherent in the image. Try to improve the image with the application you are using to 
edit it.

2. Check that you are using appropriate print-quality settings. See Printing on page 72.

3. Select the custom print-quality options in the driver dialog, and turn on the Maximum detail option (if 
available).
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Lines print double or in the wrong colors
You may observe that lines have been printed twice or that they have been printed in the wrong color.

This problem can have various visible symptoms:

● Colored lines are printed double, in different colors.

● The borders of colored blocks are wrongly colored.

To correct this kind of problem:

1. Reseat the printheads by removing them and then reinserting them.

2. Align the printheads. See Align the printheads on page 199.

Lines are discontinuous
Check your print-quality settings and that the printheads are well seated and aligned.

If your lines are broken in the following way:

1. Check that you are using appropriate print-quality settings. See Printing on page 72.

2. Reseat the printheads by removing them and then reinserting them.
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3. Align the printheads. See Align the printheads on page 199.

Lines are blurred
Humidity can cause ink to soak into the paper, making the lines blurred and fuzzy.

Try the following:

1. Check that your environmental conditions (temperature, humidity) are suitable for high-quality printing. See 
Environmental specifications on page 213.

2. Check that the paper type selected in the front panel is the same as the paper type you are using. See View 
information about the paper on page 44.

3. Select the custom print-quality options, then select Best and More passes (if available). See High-quality 
printing on page 81.

4. Try changing to a heavier paper type, such as HP Heavyweight Coated Paper or HP Super Heavyweight Plus 
Matte Paper.

5. Select a paper type that is slightly thinner than the paper you have loaded; this will cause the printer to 
use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper, 
Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

6. If you are using glossy paper, try changing to a different type of glossy paper.

7. Align the printheads. See Align the printheads on page 199.

Line lengths are inaccurate
If you have measured your printed lines and find that the lengths are not sufficiently accurate for your purposes, 
you can try to improve line length accuracy in the following ways:

1. Print on HP Matte Film, for which your printer's line length accuracy is specified. See Functional 
specifications on page 211.

Polyester film is about ten times more dimensionally stable than paper. However, using film that is thinner 
or thicker than HP Matte Film will reduce line length accuracy.

2. Set the Print Quality slider to Quality.

3. Maintain the room at a steady temperature between 10 and 30℃ (50 and 86℉).

4. Load the roll of film and let it rest for five minutes before printing.
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5. If you are still not satisfied, try recalibrating the paper advance.

HP Control Print
Generates a diagnostic plot (HP Control Print) to review printer and system image quality issues that helps to: 
detect most IQ issues in one single plot and offer an interactive guide to fix issues.

HP Control Print checks each pattern and compares print versus thresholds, then applies corrective actions 
mapped in the plot. It starts with primary patterns (1,2,3,4,5,6), then completes the evaluation with the rest of 
patterns and compares them with a reference image.

Patterns risk covered:

1. Printhead alignments color to color

2. Printhead alignments bidirectional or media height

3. Media advance

4. Grain and coalescence

5. Printhead health

6. Banding by printhead color

7. Text quality

8. Media bleed and drying

9. Uniform IQ along media
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How to diagnostic and fix issues?

1. Print: The diagnostic plot with customer settings and media.

2. Identify Defects: Follow the user guide on your PC/mobile phone. Compare printed patterns versus 
thresholds.

3. Fix: Start fixing primary patterns first, then advanced patterns. Follow the instructions in the plot or user 
guide.

For more information, please see the HP Control Print Guide on the HP website at the following link: 
http://www.hp.com/go/DesignJetZ9Pro64in/controlprint.

Escalation steps and support

In the case of complex IQ Issues not fixed with the proposed solutions, contact support teams, and send the 
problem description and pictures in high resolution and quality: Pictures of scan patterns with defects.

You must complete the escalation form to provide feedback about using HP Control Print every time you escalate 
a case to HP.

To complete an escalation, please follow these steps:

1. Fill the escalation form on the HP website at the following link: https://latexregistration.heleni.me/
control_print.

2. Select a language:
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The form is available in the following languages:

● English

● Catalan

● Chinese Simplified

● Chinese Traditional

● Dutch

● French

● German

● Italian

● Japanese

● Korean

● Polish

● Portuguese

● Russian

● Spanish

3. Please provide all the details requested on the form, it includes information about:

● Printer (Serial number, print mode and printhead status)

● Environmental conditions (temperature and relative humidity)

● When the issue was detected?

● Substrate details; brand and type

● Actions taken

● Satisfaction with the tool

● Final comments

● Remember to attach a picture of the plot printed on your HP product, with any issues clearly visible.
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Image Diagnostics Print
The Image Diagnostics Print consists of patterns designed to highlight printhead reliability problems. It helps you 
to check the performance of the printheads that are currently installed in your printer, and whether any printhead 
suffers from clogging or other problems.

How to print
It takes about two minutes to print the Image Diagnostics Print.

1. Use the same paper type that you were using when you detected a problem.

2. Check that the selected paper type is the same as the paper type loaded into the printer. See View 
information about the paper on page 44.

3. At the printer's front panel, tap the Optimize quality  icon , then the small Settings  icon , then Print 
diagnostic image.

The print is divided into two parts, both of which test printhead performance:

● Part 1 (top) consists of rectangles of pure colors, one for each printhead. This part represents the print 
quality that you will get from each color.

● Part 2 (bottom) consists of small dashes, one for each nozzle on each printhead. This part complements the 
first, and aims more specifically to detect how many faulty nozzles each printhead has.
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Look carefully at the print. The names of the colors are shown above the rectangles and in the center of the 
patterns of dashes.

Figure 15-1 Z6 Pro Image Diagnostics Print

Figure 15-2 Z9+ Pro Image Diagnostics Print

NOTE: If you use photographic paper, the matte black ink may come off when you touch the print.

First look at the upper part of the print (part 1). Each colored rectangle should be a uniform color without any 
horizontal lines across it.

Then look at the bottom part of the print (part 2). For each individual colored pattern, check that most of the 
dashes are present.

If you see horizontal lines in part 1 and also missing dashes in part 2 for the same color, the printhead 
responsible needs cleaning. However, if the rectangles look solid, do not worry about just a few missing dashes in 
part 2; these are acceptable because the printer can compensate for a few clogged nozzles.

Here is an example of a photo black printhead in a good state:
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And here is an example of the same printhead in a bad state:

Corrective action
If you have an issue with the diagnostic page, there are steps you can take, depending on the problem.

1. Clean any faulty printheads (see Clean the printheads on page 196). If you are unsure of which printhead 
to clean, select Clean all. Then reprint the Image Diagnostics Print to see whether the problem has been 
solved.

2. If the problem remains, clean the printheads again, and reprint the Image Diagnostics Print to see whether 
the problem has been solved.

3. If the problem remains, consider cleaning your printheads manually (see Clean the printheads on page 196). 
You could also try reprinting your current print job, in case it now prints satisfactorily.

4. If the problem remains, try cleaning the printhead drop detector. The printer normally notifies you when this 
is necessary, but it may be worth trying even if the printer has not suggested it. See Clean the printhead 
drop detector on page 196.

5. If the problem still remains, replace any persistently faulty printheads (see Ink system on page 126), or 
contact HP Support (see Contact HP Support on page 208).

If you still have a problem
If you still experience print-quality problems after applying the advice to fix them, there are some further things 
that you can do.

If you still experience print-quality problems after applying the advice in this chapter, here are some further 
things that you can do:

● Try using a higher print-quality option. See Printing on page 72.

● Check the driver you are using to print with. If it is a non-HP driver, consult the driver vendor about the 
problem. You could also try using the correct HP driver, if feasible. The latest HP drivers can be downloaded 
from the HP website at the following link: http://www.hp.com/go/Z6/drivers (if you have a Z6 Pro) or 
http://www.hp.com/go/Z9/drivers (if you have a Z9+ Pro).

● If you are not sure which printhead to clean, select Clean all.

● If you are using a non-HP RIP, its settings may be incorrect. See the documentation that came with the RIP.

● Check that your printer's firmware is up to date.
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● Check that you have the right settings in your software application.
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Troubleshooting HP Eco-Carton ink cartridge 
and printhead issues

16

Cannot insert an HP Eco-Carton ink cartridge
This normally occurs when you try to insert the wrong cartridge into the slot or you insert the correct cartridge in 
the wrong orientation.

1. Check that you have the correct type of cartridge (model number).

2. Check that the colored label on the cartridge is the same color as the label on the slot.

3. Check that the cartridge is correctly oriented, with the letter or letters marking the cartridge label right-side 
up and readable.

CAUTION: Never clean inside the HP Eco-Carton ink cartridge slots.

Ink cartridge status messages
A message appears in the front panel to alert you to an issue.

These are the possible ink cartridge status messages:

● Ready: The cartridge is working normally, with no known problems.

● Missing: There is no cartridge present, or it is not correctly connected to the printer.

● Low: The ink level is low.

● Very low: The ink level is very low.

● Depleted: The cartridge is empty.

● Reseat: You are recommended to remove the cartridge and then reinsert it.

● Replace: You are recommended to replace the cartridge with a new cartridge.

● Expired: It is past the cartridge's expiration date.

● Altered or cloned: The cartridge contains ink not made by HP.

● Wrong: The cartridge family or model is wrong, or it has been inserted wrongly.

● Counterfeit or used: The cartridge has been altered (refilled).

Printer does not detect the gloss enhancer cartridge (Z9+ Pro only)
Check that you have installed the HP Gloss Enhancer Upgrade Kit.

See: HP DesignJet Gloss Enhancer Upgrade Kit (Z9+ Pro only) on page 152.
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If you the printer does have the HP Gloss Enhancer Upgrade Kit installed, then proceed with My print does not 
have gloss uniformity (Z9+ Pro only) on page 182

Cannot insert a printhead
It is important that you are using the correct type of printhead, and that it is well placed in its slot.

1. Check that you have the correct type of printhead (model number).

2. Check that you have removed the two orange protective caps from the printhead.

3. Check that the printhead is correctly oriented (compare with the others).

4. Check that you have correctly closed and latched the printhead cover.

Front panel recommends reseating or replacing a printhead
When the printhead has been replaced, the printer will automatically perform a printhead alignment on the 
loaded paper.

1. From the front panel, turn the power off then on.

2. Check the front-panel display message, if it shows the ready message, the printer is ready to print. If the 
problem remains continue with the next step.

3. Remove the printhead.

4. Clean the electrical connections on the backside of the printhead with a lint free cloth. You can carefully use 
a mild rubbing alcohol if moisture is needed to remove residue. Do not use water.

CAUTION: This is a delicate process and may damage the printhead. Do not touch the nozzles on the 
bottom side of the printhead, especially not with any alcohol.

CAUTION: Do not leave the printhead outside the printer for a long time. If this is absolutely necessary, 
cover the printhead with the original orange caps, then store it in a horizontal position.

5. Reinsert the printhead into the same slot from which you removed it.

CAUTION: Do not move it to a different position in the carriage. Once a printhead is inserted into a specific 
slot, it is set up to work only with a specific combination of colors and cannot be moved to other slots.

6. Check the front-panel display message. If the problem remains, try a new printhead.
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Clean the printheads
As long as the printer is kept turned on, automatic cleaning is performed periodically.

This ensures there is fresh ink in the nozzles and prevents nozzle clogs, which ensures color accuracy. If you have 
not already done so, see Image Diagnostics Print on page 190 before proceeding

To clean the printheads, go to the front panel and tap the Optimize quality  icon , then Clean printheads. You 
can also clean the printheads from the Embedded Web Server, go to Color > Optimize print quality. If you have 
gone through the Image Quality Diagnostic print process, you know which colors are failing. Select the pair of 
printheads which contain the failing colors. If you are not sure which colors to clean, you can also select to clean 
all printheads. Cleaning all printheads takes about 6 minutes. Cleaning a single pair of printheads takes about 4 
minutes.

NOTE: Cleaning all printheads uses more ink than cleaning a single pair.

If you have cleaned the printheads using the Clean printheads procedure from the front panel and are still 
experiencing print-quality problems, you can try cleaning the printhead nozzles manually using the following 
procedure.

CAUTION: This is a delicate process, which may damage the printhead. Do not touch the electrical connections 
on the rear of the printhead.

First remove the printhead, then use a lint-free cloth to clean the bottom of the printhead until the residue is 
removed.

Clean the printhead drop detector
The printhead drop detector is a sensor that detects which nozzles on the printheads are not printing in order 
to substitute them for good printing nozzles. If particles, such as fibers, hair or paper pieces, block the sensor 
print-quality is affected.

When the front panel displays a warning message that the clean process is needed, you are recommended 
to clean the printhead drop detector. If you do not clean the printhead drop detector immediately, the printer 
continues working normally, however, the front panel display continues to show the warning.

CAUTION: Wear gloves to avoid getting ink on your hands.
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1. Turn off the printer at the front panel.

2. To avoid an electric shock, turn off the printer and unplug it.

3. Open the front cover.
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4. Find the printhead drop detector beside the stored printhead carriage.

5. Remove any debris blocking the printhead drop detector.

6. With a dry, lint-free cloth, wipe the surface of the drop detector to remove any non-visible debris.

7. Close the front cover.

8. Plug in and turn on the printer.

9. Power the printer on at the front panel.
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Align the printheads
Precise alignment between printheads is essential for accurate colors, smooth color transitions and sharp edges 
in graphical elements. Your printer has an automatic printhead alignment process which runs whenever a 
printhead has been accessed or replaced.

In cases where the paper has jammed or you are experiencing problems with color accuracy, see Color 
management on page 96; you may need to align the printheads.

NOTE: If the paper has jammed, it is recommended that you reinsert the printheads and initiate the 
realignment procedure by tapping the Optimize quality  icon , then Printhead alignment.

NOTE: Best results are obtained when printhead alignment is done on high-quality glossy paper.

CAUTION: Do not use transparent or semi-transparent paper to align the printheads.

Reinsert printheads procedure
The process takes about six minutes. Wait until the process is complete before using the printer.

1. If the realignment process is running and the wrong paper is loaded, tap the Cancel  icon  on the front 
panel.

CAUTION: Do not print if the realignment process has been canceled. You can restart the alignment by 
tapping the Optimize quality  icon , then Printhead alignment.

2. Load the paper you wish to use, see Paper handling on page 23. You can use a roll that is at least 610 mm 
(24 in) wide.

CAUTION: Do not use transparent or semi-transparent paper to align the printheads.

3. Remove and re-insert all the printheads. This starts the printhead alignment procedure.

4. Ensure the window is closed, as a strong light source near the printer during printhead realignment can 
affect alignment.
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5. Wait until the front-panel display shows the process complete before using the printer.

NOTE: The printer prints a calibration image. Do not worry about the image. The front-panel display 
shows any errors in the process.

Image-quality maintenance menu procedure
The process takes about 10 minutes. Wait until the process is complete before using the printer.

1. Load the paper you wish to use, see Paper handling on page 23. You can use a roll that must be A3 
landscape or larger–420 mm (16.54 in) wide.

CAUTION: Do not use transparent or semi-transparent paper to align the printheads.

2. From the front panel, tap the Optimize quality  icon , then Printhead alignment. The printer checks to 
see if it has enough paper to run the realignment.

3. If the loaded paper is satisfactory, the printer runs the realignment and prints a realignment pattern. Ensure 
the window is closed, as a strong light source near the printer during printhead realignment can affect 
alignment.

4. Wait until the front-panel display shows the process complete before using the printer.

Scanning errors during alignment
If the alignment process fails, a Scanning problems message appears on the front panel. This means that the 
alignment has not completed successfully. Therefore the printer is not aligned and the alignment should be 
repeated in order to print with good print quality.

The problem may have various causes:

● The paper used was not valid, repeat the alignment with valid paper.

● Printhead health problems, clean printheads, see Clean the printheads on page 196.

● The alignment was done with the window open, repeat the alignment with the window closed.

If the problem persists after using valid paper, cleaning the printheads and keeping the window closed, there may 
be a failure in the scanning system needing repair; or the printheads, although clean, may not work and need to 
be replaced.
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Printhead status messages
These are different messages that can appear in the front panel.

These are the possible printhead status messages:

● Ready: the printhead is working normally, with no known problems

● Missing: there is no printhead present, or it is not correctly installed in the printer.

● Test printhead separately: you are recommended to test the printheads individually to find the failing 
printhead. Remove all the printheads and insert them alone one by one, closing the latch and the carriage 
cover after every insertion. The front-panel display indicates the failing one showing the reseat or replace 
message.

● Reseat: you are recommended to remove the printhead and then reinsert it. If that fails, clean the electrical 
connections, see Front panel recommends reseating or replacing a printhead on page 195. If that fails, 
replace the printhead with a new printhead.

● Replace: the printhead is failing. Replace the printhead with a working printhead.

● Replacement incomplete: a printhead replacement process has not completed successfully, re-launch the 
replacement process and let it finish completely (it is not needed to change the printheads).

● Remove: the printhead is not a suitable type for use in printing.

How to ensure printer stops if there is an image quality risk printing 
in unattended mode

The advice and default value is set to maximize productivity and reduce nozzle checks.

When the printer needs to work in an unattended environment, or overnight, in order to reduce the risk of poor 
image quality it is recommended to change this setting so as to stop the printer when there is a small sign of 
image quality deterioration.
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Troubleshooting general printer issues17

Printer does not print
If all is in order (paper loaded, all ink components installed and no file errors), there are still reasons why a file you 
have sent from your computer may not start printing when expected.

● You may have an electrical power problem. If there is no activity at all from the printer, and the front panel 
does not respond, check that the power cable is connected correctly and that there is power available at the 
socket. Press the power key for 5 seconds to reset the printer.

● You may be experiencing unusual electromagnetic phenomena, such as strong electromagnetic fields or 
severe electrical disturbances, which can cause the printer to behave strangely or even stop working. In this 
case, turn off the printer using the power key on the front panel and unplug the power cord, wait until the 
electromagnetic environment has returned to normal, then turn it on again. If you still experience problems, 
contact HP Support: see Contact HP Support on page 208.

● Nesting may be on, and the printer is waiting for the specified nest wait time before calculating the 
appropriate nests. In this case, the front panel shows the remaining time needed for nesting.

● You may have the wrong graphic language setting, see Change the graphic language setting on page 19.

● You may not have installed in your computer the correct driver for your printer, see the Assembly instructions.

● The printer may be holding the job for paper or accounting information, see Job status messages on page 
94.

● You may have requested a print preview from your printer driver. This is a function you can use to check that 
the image is the one you want. In this case, the preview is displayed on your screen, and you must click the 
Print button to start printing.

Front panel fails to initialize
If the printer will not start (the front panel is blank or the diagnostic LEDs are all off), you are recommended to 
replace the firmware.

Replace the firmware in the following way:

1. Go to the HP Support Center (see HP Support Center on page 207) and download the firmware.

2. Save the firmware on a USB flash drive. Ideally, the USB flash drive should be empty and formatted with the 
FAT filesystem.

3. Ensure that the printer is turned off. Connect the USB flash drive to the Hi-Speed USB host port at the back 
of the printer, then turn the printer on.

4. The printer takes about a minute to read the firmware file, then asks you to remove the USB flash drive.

5. The printer automatically installs the new firmware and restarts.
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Printer seems slow
Check that you have set the correct print quality, and that you have specified the correct paper type.

Here are some possible explanations:

● Did you set the print quality to Best or Maximum detail? Best-quality and maximum detail prints take longer.

● Did you specify the correct paper type when loading the paper? Some paper types require more time for 
printing; for example, photo and coated papers require more drying time between passes. To find out the 
printer's current paper type setting, see View information about the paper on page 44.

● If your printer is connected by network, check that all components used in the network (network interface 
cards, hubs, routers, switches, cables) are capable of high-speed operation. Is there a lot of traffic from other 
devices on the network?

● Did you specify Extended drying time in the front panel? Try changing the drying time to Optimal.

Communication failures between computer and printer
This can be due to a software, hardware or even a network issue.

Some symptoms are:

● The front-panel display does not show the Downloading or Processing message when you have sent an 
image to the printer.

● Your computer displays an error message when you are trying to print.

● Your computer or printer hangs (stays idle), while communication is taking place.

● Your printed output shows random or inexplicable errors (misplaced lines, partial graphics etc.)

To solve a communication problem:

● Ensure that you have selected the correct printer in your application, see Printing on page 72.

● Ensure that the printer works correctly when printing from other applications.

● Remember that very large prints may take some time to receive, process and print.

● If your printer is connected to your computer through any other intermediate devices, such as switch boxes, 
buffer boxes, cable adapters, cable converters, and so on, try using it when connected directly to your 
computer.

● Try another interface cable.

● Ensure that the graphic language setting is correct, see Change the graphic language setting on page 19.

● If the printer is connected by network, check that your printer has a static IP address. If it is using DHCP, the IP 
address may change every time it is turned on, in which case the driver may not be able to find it.

Cannot access the Embedded Web Server
From the front panel, tap the Settings  icon , then Security > Embedded Web Server.

NOTE: If you have not done so already, read Embedded Web Server on page 12.
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If you are using a proxy server, try bypassing the server and accessing the Web server directly:

● In Internet Explorer for Windows, go to Tools > Internet Options > Connections > LAN Settings, and check 
the Bypass proxy server for local addresses box. Alternatively, for more precise control, click the Advanced 
button and add the printer's IP address to the list of exceptions, for which the proxy server is not used.

● In Google Chrome for Windows, go to System > Open your computer Proxy Settings. A new window opens. 
Select Don't use the proxy server for local (intranet) addresses.

● In Safari for macOS, go to Safari > Preferences > Advanced and click the Proxies: Change Settings button. 
Add the printer's IP address or its domain name to the list of exceptions, for which the proxy server is not 
used, in the Bypass proxy settings for these Hosts & Domains field.

If you still cannot connect, turn the printer off and back on with the power key on the front panel.

Cannot connect to the Internet
If your printer has difficulty in connecting to the Internet, a warning message appears: No internet connection.

You can modify settings in the front panel—tap Networking–unless the settings are protected.

Automatic file system check
When you turn on the printer, a file system check takes place; it takes a few minutes. Please wait until it finishes.

CAUTION: If you turn the printer off before the file system check has finished, the file system could be 
seriously damaged, making the printer's hard disk unusable. In any case, the file system check will restart from 
the beginning whenever you turn the printer on again.

A file system check is scheduled every 90 days, in order to maintain the hard disk's file system integrity.

NOTE: When the printer is powered back on, it takes about three minutes to initialize and check and prepare 
the printheads. However, it can take up to 40 under some conditions, for example, when the printer has not 
been used for a long period of time and requires more time to prepare the printheads.

Alerts
Your printer can communicate two types of alerts: Errors and Warnings.

● Errors: Mainly alerting you to the fact that the printer is unable to work normally. However, in the printer 
driver, errors can also alert you to conditions that could ruin the print, such as clipping, even if the printer is 
able to print.

● Warnings: Alert you when the printer needs attention either for an adjustment, such as a calibration or for a 
possible unprintable situation, such as a preventive maintenance or low ink.
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There are four different alerts communicators within your printer's system:

● Front-panel display: The front panel shows only the most relevant alert at a time. In the case of a warning, 
it disappears after a timeout. There are permanent alerts, such as "ink cartridge low on ink", that reappear 
when the printer becomes idle and there is not another more severe alert.

TIP: From the front panel display you can configure paper mismatch alerts, see Solve paper mismatch on 
page 90.

● Embedded Web Server: The upper-right corner of the Embedded Web Server window shows the printer 
status. If there is an alert in the printer, the status shows the alert text.

● Driver: The driver warns about job configuration settings that may produce a problem in the final output. If 
the printer is not ready to print, it displays a warning.

● HP DesignJet Utility: To see alerts, go to the Overview tab and review the Items needing attention list on the 
right-hand side.

By default, alerts are displayed only when you are printing. If alerts are enabled and there is a problem 
that prevents a job from completing, you see a pop-up window, which explains the reason for the problem. 
Follow the instructions to achieve your required result.
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Front-panel error messages18

The printer may occasionally display a system error, consisting of a numerical code of 12 digits followed by the 
recommended action that you should take.

In most cases you will be asked to restart the printer, because when the printer starts it can diagnose the 
issue better and may be able to fix it automatically. If the problem persists after restarting, you should contact 
HP Support and be ready to give the numerical code from the error message. See Contact HP Support on page 
208.

If the error message contains some other recommended action, follow the printer’s instructions.

System error log
The printer saves a log of system errors that you can access in two ways.

Using a USB flash drive:

1. Take a standard USB flash drive, formatted as FAT32.

2. Create an empty file in the USB flash drive (right-click, New > Text Document), and name it 
pdipu_enable.log

3. When an error message is displayed on the front panel, insert the USB flash drive into the Hi-Speed USB 
host port at the back of the printer. The log is automatically copied into the drive. You can remove the USB 
flash drive when prompted by the front panel.

4. Contact your support representative (see Contact HP Support on page 208) to share the file created in the 
USB flash drive.

Using the Embedded Web Server

1. In your Web browser, go to the HP website and insert your IP address into the following link: https://[printer 
ip address]/hp/device/support/serviceSupport.

2. Click the Download button to get the Diagnostic package.

3. Save the package in your computer and contact your support representative (see Contact HP Support on 
page 208).
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HP Customer Care19

Introduction
HP Customer Care offers award-winning support to ensure you get the most from your HP DesignJet, providing 
comprehensive, proven support expertise and new technologies to give you unique end-to-end support.

Services include setup and installation, troubleshooting tools, warranty upgrades, repair and exchange services, 
phone and Web support, software updates and self-maintenance services. To find out more about HP Customer 
Care, see Contact HP Support on page 208.

Register your warranty on the HP website at the following link: http://register.hp.com/.

HP Professional Services

HP Support Center
Enjoy a world of dedicated services and resources to ensure you always get the best performance from your 
HP DesignJet printers and solutions.

Join the HP community at the HP Support Center, your large-format printing community, for 24×7 access to:

● Multimedia tutorials

● Step-by-step how-to guides

● Downloads: the latest printer firmware, drivers, software, paper presets, etc.

● Technical support: online troubleshooting, customer care contacts and more

● Workflows and detailed advice for completing various printing tasks from particular software applications

● Forums for direct contact with the experts, both HP and your colleagues

● Warranty tracking online, for your peace of mind

● Latest product information: printers, supplies, accessories, software, etc.

● Supplies Center for all you need to know about ink and paper

The HP Support Center can be found on the HP website at the following link: 
http://www.hp.com/go/Z6pro64/support for Z6 Pro printers, or http://www.hp.com/go/Z9pro64/support for Z9+ 

Pro printers.

By customizing your registration for the products you have purchased and your type of business, and by setting 
your communication preferences, you decide the information you need.

Download printer software
Be sure to follow the software installation instructions.

Install the printer software from the HP website at the following link: http://www.hp.com/go/Z6pro64/software 
(if you have a Z6 Pro) or http://www.hp.com/go/Z9pro64/software (if you have a Z9+ Pro).
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HP Care Packs and Warranty Extensions
HP Care Packs and Warranty Extensions allow you to extend your printer's warranty beyond the standard period.

They include remote support. On-site service is also provided if necessary, with two alternative response-time 
options:

● Next business day

● Same business day, within four hours (may not be available in all countries)

There is an HP Installation service that unpacks, sets up, and connects the printer for you.

For more information on HP Care Packs, see the HP website at the following link: 
http://cpc.ext.hp.com/portal/site/cpc.

Customer Self Repair
HP's Customer Self Repair program offers our customers the fastest service under either warranty or contract. 
It enables HP to ship replacement parts directly to you (the end user) so that you can replace them. Using this 
program, you can replace parts at your own convenience.

Convenient, easy to use

● An HP Support Specialist will diagnose and assess whether a replacement part is required to address a 
defective hardware component.

● Replacement parts are express-shipped; most in-stock parts are shipped the very same day you contact HP.

● Available for most HP products currently under warranty or contract.

● Available in most countries.

For more information about Customer Self Repair, see the HP website at the following link: 
http://www.hp.com/go/selfrepair.

Contact HP Support
HP's Virtual Agent is there to provide you with support at any time day or night.

You can access the HP Virtual Agent for your printer from:

● HP DesignJet Z6 Pro on the HP website at the following link: http://www.hp.com/go/DesignJetZ6Pro64in/VA.
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● HP DesignJet Z9+ Pro on the HP website at the following link: 
http://www.hp.com/go/DesignJetZ9Pro64in/VA.

HP Support is also available to you by telephone. What to do before you call:

● Review the troubleshooting suggestions in this document.

● Review the relevant driver documentation.

● If you have installed third-party software drivers and RIPs, see their documentation.

● If you call your support representative, please have the following information available to help us answer 
your questions more quickly:

– The product you are using (the product number and the serial number, found on the label at the back of 
the product)

– If there is an error code on the front panel, note it down; see Front-panel error messages on page 206

– The computer you are using

– Any special equipment or software you are using (for example, spoolers, networks, switch-boxes, 
modems or special software drivers)

– The software and driver name and version number that you are currently using

– The Printer Service information, which you can get from the Embedded Web Server. In a Web browser, 
enter the IP address of your printer to access the Embedded Web Server. Then click Support > Service 
support > Service information > Display. If you need to send the information by email, you can download 
it as a file from your browser, and later send the file.

NOTE: After you click Display, your browser may prevent the pop-up window from opening. In this 
case, you have to find the browser option that allows the window to open.
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Alternatively, from your browser you can send the page directly: click File > Send > Page by email.

Telephone number
Your HP Support telephone number is available on the HP website.

Visit the HP website at the following link: http://welcome.hp.com/country/us/en/wwcontact_us.html.
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Printer specifications20

Functional specifications
Your printer uses universal printheads, and ink cartridges containing 300 ml of ink.

Table 20-1 HP ink supplies

Supply Description

Printheads Universal printheads, which can be inserted into any of the available slots. Once initialized in 
a particular slot, they cannot be moved to another.

Ink cartridges Cartridges containing 300 ml of ink: matte black, photo black, cyan, magenta, yellow, 
chromatic red, chromatic green (Z9+ Pro only), chromatic blue (Z9+ Pro only), gray (Z9+ Pro 
only), gloss enhancer (Z9+ Pro only)

Table 20-2 Paper sizes

Minimum Maximum

Roll width 420 mm (16.5 in) 1626 mm (64 in)

Roll diameter 170 mm (6.7 in)

Roll weight 25 kg (55.1 lb)

Paper thickness 0.8 mm (31.5 mil)

Paper weight 80 g/m2 500 g/m2

Paper types with a thickness of 0.26 mm (0.01 in) or more, and with curling* greater than 55 mm (2.17 in) are 
not recommended for use with the cutter enabled because they can cause smearing or a crash.

When the cutter is disabled, the first plot after loading or after a manual cut will advance 23 cm (7 in) and result 
in a clear area on the leading edge of the print. This is deliberate, and done to avoid a crash or smearing on the 
leading edge.

Rigid materials like photo papers may experience issues when loaded on the second roll, such as being 
automatically unloaded between prints. The front panel recommends to load these material types on the upper 
roll (1).

*To measure curling cut 20 cm (7.9 in) of paper from the roll and measure the curl.

Table 20-3 Printing resolutions

All papers Photo papers (gloss, 
satin)

Bond, technical. coated 
CAD, backlit, canvas

Plain, coated, heavy 
coated, polypropylene, 
banner

Print quality Rendering resolution (ppi) Printing resolution (dpi) Printing resolution (dpi) Printing resolution (dpi)

Best – Maximum Detail 600 × 600 2400 × 1200 – –

Best – Extra Passes 600 × 600 1200 × 1200 1200 × 1200 1200 × 1200
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Table 20-3 Printing resolutions (continued)

All papers Photo papers (gloss, 
satin)

Bond, technical. coated 
CAD, backlit, canvas

Plain, coated, heavy 
coated, polypropylene, 
banner

Print quality Rendering resolution (ppi) Printing resolution (dpi) Printing resolution (dpi) Printing resolution (dpi)

Best 600 × 600 600 × 600 1200 × 1200 600 × 600

Normal 600 × 600 600 × 600 1200 × 1200 600 × 600

Fast 600 × 600 600 × 600 1200 × 1200 600 × 600

Economode 600 × 600 – 600 × 600 600 × 600

● To enable printing at 2400dpi resolution, select Photo Paper in Best – Maximum quality.

● To ensure printing at 1200dpi resolution in any paper, select Best – Extra Passes.

● Only plain, coated, and heavy coated papers enable Economode.

Table 20-4 Margins

Margins Distance

Top, bottom (trailing edge), right and left 5 mm (0.2 in)

Table 20-5 Mechanical accuracy

Measures

Approximately equal to 0.1% of the specified vector length or approximately equal to 0.2 mm (whichever is greater) at 23 degree Celsius 
(73 degree Fahrenheit), 50-60% relative humidity, on E/A0 printing material in Best or Normal mode with HP Matte Film roll feed.

Table 20-6 Graphic languages supported

HP DesignJet Languages

Z6 Pro and Z9+ Pro HP-PCL3GUI, HP-GL/2, CALS G4, TIFF, JPEG, Adobe PDF 1.7 ext. 3 and Adobe PostScript 3

Physical specifications
Measurements are the same but weight differs based on printer model. Specifications are listed with and without 
packaging.

Table 20-7 Physical specifications with packaging

Length Width Height Weight

2800 mm (110.2 in) 750 mm (29.5 in) 1302 mm (51.3 in) HP DesignJet Z6 Pro 64-in 
Printer: 262 Kg (578 lb)

HP DesignJet Z9+ Pro 64-in 
Printer: 264 Kg (582 lb)
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Table 20-8 Physical specifications without packaging

Length Width Height Weight

2605 mm (102.6 in) 790 mm (31.1 in) 1402 mm (55.2 in) HP DesignJet Z6 Pro 64-in 
Printer: 169 Kg (373 lb)

HP DesignJet Z9+ Pro 64-in 
Printer: 170 Kg (375 lb)

Doorways without packaging: minimum width 800 mm (31.5 in) × minimum height 1700 mm (70 in) required.

Memory specifications
Your printer has 128 GB of virtual memory and a 500 GB hard disk.

Table 20-9 Memory specifications

Type Capacity

Virtual memory 128 GB

Hard disk 500 GB

Power specifications
Use the electrical cord supplied with the printer and the power supply voltage specified on the label. Avoid 
overloading the printer's electrical outlet with multiple devices.

Table 20-10 Power specifications

Type Specifications

Input voltage 100–240 V ac approximately equal to10%, auto-ranging

Frequency 50/60 Hz

Maximum current 3 A

Power 150 W

Ecological specifications
This product complies with the WEEE Directive 2012/19/EU and RoHS Directive 2011/65/EU.

To determine the ENERGY STAR and EPEAT registration status of your product model, see 
http://www.hp.com/go/ecolabels.

Environmental specifications
The printer is best placed in a dry, clean, well-ventilated, and temperature-controlled environment.
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Table 20-11 Environmental specifications

- Temperature Humidity

Best print quality 15 to 30 degree Celsius (59 to 86 degree 
Fahrenheit)

20%-80%, depending on paper type

Operating 5 to 40 degree Celsius (41 to 104 degree 
Fahrenheit), depending on paper type

20%-80%, depending on paper type

Storage new printer without ink –40 to 55 degree Celsius (–40 to 131 
degree Fahrenheit)

0% to 95%

Storage used printer with ink inside the 
tubes

–5 to 55 degree Celsius (23 to 131 degree 
Fahrenheit)

0% to 95%

Printer already installed / Printer with ink 
inside the tubes

Up to -5 degree Celsius (23 degree 
Fahrenheit)

Printer already installed / Printer without ink 
inside the tubes (removed manually)

Up to -25 degree Celsius (–13 degree 
Fahrenheit)

Maximum altitude when printing 3000 m (9843 ft)

Acoustic specifications
Declared noise emission levels for the HP DesignJet Z6 Pro / Z9+ Pro 64in printer series. Sound Pressure Levels 
at bystander positions and Sound Power Levels measured per ISO 7779.

Table 20-12 Acoustic specifications

Type Specifications

Operating sound pressure 52 dB(A) (Glossy paper, normal mode)

Operating sound power Less-than Or equal to 6.9 B(A) (Glossy paper, normal mode)

Idle sound pressure 25 dB(A)

<20 dB(A) (Sleep)

Idle sound power Less-than Or equal to 4.3 B(A) (Ready)

<4.0 B(A) (Sleep)
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Glossary

 AppleTalk  
A suite of protocols that Apple Computer developed in 1984 for computer networking. Apple now recommends TCP/IP and 
Bonjour networking instead. HP DesignJet products no longer support AppleTalk.

Bonjour  
Apple Computer's trade name for its implementation of the IETF Zeroconf specification framework, a computer network 
technology used in Apple's Mac OS X from version 10.2 onwards. It is used to discover services available on a local area 
network. It was originally known as Rendezvous.

Color accuracy  
The ability to print colors that match the original image as closely as possible, bearing in mind that all devices have a limited 
color gamut and may not be physically capable of matching certain colors precisely.

Color consistency  
The ability to print the same colors from a particular print job from print to print and from printer to printer.

Color model  
A system of representing colors by numbers, such as RGB or CMYK.

Color space  
A color model in which each color is represented by a specific set of numbers. Many different color spaces can use the 
same color model: for instance, monitors generally use the RGB color model, but they have different color spaces, because a 
particular set of RGB numbers results in different colors on different monitors.

Cutter  
A printer component that slides back and forth across the platen to cut the paper.

ESD  
ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the car door, or the cling of 
clothing. Although controlled static electricity has some useful applications, uncontrolled electrostatic discharges are one 
of the main hazards to electronic products. Therefore, to prevent damage some precautions are needed when setting up 
the printer, or handling ESD sensitive devices. This type of damage may reduce the life expectancy of the device. One 
way to minimize uncontrolled ESDs, and therefore reduce this type of damage is by touching any exposed grounded part 
of the printer (mainly metal parts) before handling ESD sensitive devices (such as the printheads or HP Eco-Carton ink 
cartridges). Additionally, to reduce the generation of electrostatic charge in your body try to avoid working in a carpeted area, 
and keep your body movements to a minimum when handling ESD sensitive devices. Also, avoid working in low humidity 
environments.

Ethernet  
A popular computer networking technology for local area networks.

Firmware  
Software that controls your printer's functionality and is stored semi-permanently in the printer (it can be updated).

Gamut  
The range of colors and density values reproducible on an output device, such as a printer or monitor.
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Gigabit Ethernet  
An Ethernet network capable of transferring data at up to 1,000,000,000 bits/second. Gigabit Ethernet interfaces are 
capable of negotiating slower speeds when required for compatibility with older Ethernet devices.

HP RTL  
HP Raster Transfer Language: a language defined by HP to describe raster (bitmap) graphics.

HP-GL/2  
HP Graphics Language 2: a language defined by HP to describe vector graphics.

I/O  
Input/Output: this term describes the passing of data between one device and another.

ICC  
The International Color Consortium, a group of companies that have agreed on a common standard for color profiles.

Ink cartridge  
A removable printer component that stores ink of a particular color and provides it to the printhead.

IP address  
May mean an IPv4 address (most likely) or an IPv6 address.

IPSec  
A sophisticated mechanism for providing network security by authenticating and encrypting IP packets sent between nodes 
on a network. Each network node (computer or device) has an IPSec configuration. Applications are usually unaware whether 
IPSec is being used or not.

IPv4 address  
A unique identifier that identifies a particular node on an IPv4 network. An IPv4 address consists of four integers separated 
by full stops. Most networks in the world use IPv4 addresses.

IPv6 address  
A unique identifier that identifies a particular node on an IPv6 network. An IPv6 address consists of up to 8 groups of 
hexadecimal digits separated by colons. Each groups contains up to 4 hexadecimal digits. Only a few new networks in the 
world use IPv6 addresses.

Jetdirect  
HP's brand name for its series of print servers that allow a printer to be connected directly to a local area network.

LED  
Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.

MAC address  
Media Access Control address: a unique identifier used to identify a particular device on a network. It is a lower-level identifier 
than the IP address. Thus, a device may have both a MAC address and an IP address.

Network  
A network is a set of connections that pass data between computers and devices. Every device is able to communicate with 
every other device in the same network. This allows data to be moved between computers and devices, and allows devices 
such as printers to be shared between many computers.
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Nozzle  
One of many tiny holes in a printhead through which ink is deposited onto the paper.

Paper  
A thin, flat material made to be written or printed on; most commonly made from fibers of some kind which are pulped, 
dried and pressed.

Platen  
The flat surface within the printer over which the paper passes while it is being printed on.

Printer driver  
Software that converts a print job in a generalized format into data suitable for a particular printer.

Printhead  
A removable printer component that takes ink of one or more colors from the corresponding HP Eco-Carton ink cartridge(s) 
and deposits it on the paper, through a cluster of nozzles. In your printer, each printhead prints two different different colors.

Spindle  
A rod that supports a roll of paper while it is being used for printing.

TCP/IP  
Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is based.

USB  
Universal Serial Bus: a standard serial bus designed to connect devices to computers.

USB host port  
A rectangular USB socket such as those on found on computers. A printer can control USB devices that are connected to such 
a port. Your printer has two USB host ports, which it uses to control accessories and USB flash drives.
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